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1. Menyertakan pernyataan hak cipta dan persyaratan yang terdapat dalam lisensi ini.

2. Tidak diperkenankan menambah, mengurangi dan menghapus lisensi.

3. Tidak diperkenankan untuk menambahkan restriksi baik secara teknis maupun legal sehingga Doku-
mentasi tidak dapat disalin dan diperbanyak secara bebas.

Diperkenankan untuk melakukan modifikasi atau perubahan terhadap Dokumentasi dengan ketentuan
sebagai berikut :

1. Mempertahankan pernyataan hak cipta yang terdapat dalam Dokumentasi

2. Membuat pernyataan hak cipta mengenai perubahan-perubahan yang telah dilakukan.

Buku ini ditulis dan diolah dengan menggunakan berbagai program Open Source. Penulisan dokumen dilakukan
dalam format standard terbuka yaitu DocBook. Penulisan dilakukan dengan memanfaatkan beragam editor teks,
GNU-Emacs, vi, pico, KDE Advanced Editor. Kemudian dokumen diproses dengan menggunakan meinproc
dengan db2latex dan akhirnya dengan LATEXyang akhirnya disajikan format PostScript dengan menggukan dvips.
Dalam pengolahan dokumen ini digunakan LYX sebagai front-end. Juga digunakan program GIMP, xfig, serta
paket graphviz dari AT&T
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Proyek Pengembangan Perangkat Lunak Berbahasa Indonesia (P2LBI)

Komputer sebagai sarana yang tak dapat dipisahkan dari ICT menjadi suatu hal yang mendasar un-
tuk dikuasai secara luas penggunaanya.Tingkat penguasaan bahasa Inggris yang rendah di kalangan
masyarakat Indonesia, menyebabkan kegamangan dan keraguan untuk mulai memakai komputer. Mem-
biarkan masyarakat luas yang tidak menguasai bahasa Inggris terjebak dalam situasi yang menyulitkan
pengadopsian komputer bukanlah langkah yang tepat untuk memanfaatkan TI secara luas. Menunggu
hingga tercapainya titik penguasaan bahasa Inggris di masyarakat luas sehingga baru dapat meman-
faatkan komputer akanlah menyebabkan ketertinggalan pengadopsian teknologi komputer secara luas di
masyarakat.

Salah satu sasaran dari Proyek P2LBI adalah tersedianya perangkat lunak dengan tatap-muka beserta
beberapa aplikasi umum yang menggunakan bahasa Indonesia. Perangkat lunak ini akan disebarkan
sebagai sarana pelatihan dan sarana bekerja menggunakan komputer yang murah dan handal. ”Handal”
yang dimaksudkan adalah kemampuan untuk mencegah perusakan perangkat lunak ini akibat kesalahan
pengguna. Dengan demikian diharapkan, makin banyak masyarakat dapat memanfaatkan komputer
dengan murah dan tanpa rasa takut terhadap bahasa yang digunakan maupun terhadap kesalahan yang
mungkin dilakukannya.
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Kata Pengantar

Pekerjaan penerjemahan program yang meliputi penerjemahan GUI dan dokumentasinya tidaklah
sama dengan pekerjaan penerjemahan buku. Karena ada beberapa keterbatasan misal ukuran teks yang
diperbolehkan, konsistensi antar bagian program, istilah yang sebaiknya tidak asing bagi orang banyak.
Seringkali pemilihan istilah terpaksa harus bersebrangan dengan istilah resmi bahasa Indonesia. Pertim-
bangan utama dalam pemilihan istilah adalah tingkat kegunaan dari hasil penerjemahan tersebut.

Program Open Source memiliki metoda pemisahan bagian menu, dialog serta dokumentasi dan
program yang memungkinkan proses penerjemahan dilakukan secara lebih mudah. Proses penerjemahan
GUI dan dokumentasi melibatkan beberapa teknologi misal groff, gettext, SGML, HTML dan penggunaan
beberapa perangkat bantu yang memudahkan proses penerjemahan.

Buku ini menjelaskan tentang cara penerjemahan GUI dan dokumentasi. Diharapkan dengan adanya
buku ini diharapkan dapat mempermudah proses penerjemahan di masa mendatang. Sehingga diharapkan
akan semakin banyaknya program yang memiliki GUI dan dokumentasi berbahasa Indonesia di masa
mendatang.

Akhir kata penulis ucapkan banyak terima kasih pada pihak yang telah membantu dalam pekerjaan
ini, komunitas Open Source, BPPT, Universitas Gadjah Mada, Trustix dan juga Universitas Gunadarma.

Tim P2LBI
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Pengantar

Buku ini menjelaskan tentang tata cara penerjemahan GUI dan penerjemahan dokumentasi KDE. Se-
belum masuk ke aspek teknis dari pekerjaan penerjemahan tersebut, akan dibahas terlebih dahulu tentang
beberapa hal dasar sebagai latar belakang. Proses editorial dari penerjemahan KDE dilakukan sebagai
berikut :

• Program KDE memiliki dokumentasi yang biasanya dimulai dalam bahasa ibu pembuat program.
Kemudian oleh tim KDE akan dibantu untuk diterjemahkan ke dalam bahasa Inggris. Versi bahasa
Inggris ini lalu akan direvisi dan diperiksa oleh tim Inggris.

• Dokumentasi berbahasa Inggris asli juga ditulis langsung oleh angota tim Inggris dengan kerja sama
dengan penulis aplikasi tersebut.

• Dokumentasi ditulis dalam suatu bahasa-penanda (markup) yang disebut DocBook. Berbagai
program bantu tersedia untuk menghasilkan file HTML, Postscript dan sebagainya dari berkas
DocBook dengan tetap menjaga struktur dokumen (indeks, judul dan sebagainya)

Sedangkan untuk melakukan penerjemahan KDE maka dilakukan tahapan sebagai berikut :

• Dokumentasi diterjemahkan setelah aplikasi yang bersangkutan telah diterjemahkan. Ini untuk
menjamin bahwa layar dan pesan yang ditampilkan oleh aplikasi tersebut sama dengan dokumentasi.
Untuk itu diharapkan mengacu ke http://www.kde.org/i18n.html

• Penerjemah selalu menerjemahkan dari versi Inggris. Untuk itu dapat dilihat pada daftar di KDE.

• Setiap pengawas penerjemahan akan mendata dokumentasi yan telah diterjemahkan dan orang
yang terlibat tag <date> dan <releaseinfo> memungkinkan untuk menghasilkan tabel ini secara
otomatis

Dalam melakukan pekerjaan penerjemahan beberapa perangkat bantu sangat dibutuhkan antara lain :

• kdoctools
Patch KDE dan penyesuaian Docbook. Ini merupakan bagian dari paket kdelibs yang dapat diper-
oleh pad direktori ftp://ftp.kde.org/pub/kde/unstable/CVS/snapshots/current. Biasanya
perangkat bantu ini telah diinstal pada sistem KDE. Terdiri dari :

– checkXML
Aplikasi konsol. Memeriksa dokumen DocBook dari kesalahan sintaks. Jika dokumen benar
maka akan kembali ke prompt.

– meinproc
Aplikasi konsole. Menghasilkan keluaran format lain dari dokumen DoxBook XML. Ini sering
digunakan ketika mengkompilasi KDE atau menghasilkan halaman HTML. Dapat digunakan
untuk melihat dokumen dalam format HTML.
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• xmlizer
Aplikasi konsol. Akan mengkonversi suatu berkas DocBook SGML yang valid ke bentuk DocBook
XML. Terkadang timbul kesalahan dan perlu dilakukan perubahan secara manual. Hal ini dise-
babkan program bantu ini tidak dibuat untuk dokumentasi KDE pada awalnya.

• template.docbook
Template untuk dokumentasi baru. Berkas ini dapat digunakan untuk panduan membuat doku-
mentasi baru, didistribusikan pad direktori kdoctools.

• sgmldiff.pl
Skrip yang digunakan untuk mendeteksi perbedaan markup. Perangkat bantu ini memungkinkan
membandingkan tag DocBook pada berkas Inggris, dan versi bahasa lainnya. Kesalahan harus
diperbaiki hingga sgmldiff tak memberikan keluaran apapun kecuali nama dan email penerjemah.

Perangkat bantu di atas akan dibahas lebih ditail penggunaannya dalam bab-bab mendatang. Beberapa
tip dan rekomendasi berikut ini perlu diingat dalam melakukan penerjemahan :

• Jangan pernah menerjemahkan langsung dari halaman HTML !

• Selalu mulai dari berkas DocBook. Berkas ini merupakan sumber dari segala sumber.

• Sebaiknya patuhi struktur dari dokumentasi tesrebut. Jangan menambahi apapun ataupun enghi-
langkannya. Kecuali nama dan email penerjemah yang ada di dalam <bookinfo> meta-information,
dan pada bagian ”Epilog” dan ”Credits”.
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Tujuan Dokumentasi

Tujuan dari penulisan dokumentasi adalah menyediakan untuk pengguna suatu dokumentasi yang lengkap
terorganisasi dengan baik untuk tiap komponen program. Untuk mencapai hal itu disusun panduan
sebagai berikut :

2.1 Konsistensi

Konsistensi perlu dijaga terutama untuk beberapa hal yang saling terkait. Dengan memperhatikan kon-
sistensi dari awal, maka akan menghemat waktu ketika dilakukan perubahan dokumentasi natninya.

2.1.1 Tanggal dan nomor revisi

Walau sepertinya hal ini merupakan masalah yang kecil, atau bagian kecil tetapi perlu diperhatikan
beberapa hal :

• Tanggal yang ditulis antar <date> dan </date> harus tertulis dalam format DD/MM/YYYY. Tanggal
yang digunakan haruslah tanggal terakhr dari pembaharuan dokumentasi tersebut (biasanya tanggal
saat itu). Hal ini penting karena memudahkan proses mengawasi perubahan dokumentasi.

• Seluruh data yang ditulis dalam dokumetnasi harus ditulis dalam kata-kata, misal Maret 2, 2000.
Ini dibutuhkan agar 03/02/2000 diterjemahkan dengan benar dalam semua bahasa, oleh setiap
orang. Perhatian dalam tag <date> data harus ditulis dalam format YYYY-MM-DD.

• Seluruh informasi termasuk yang diantara <releaseinfo> dan </releaseinfo> harus cocok de-
ngan nomor rilis dari aplikasi yang bersangkutan

2.1.2 Masalah konsistensi lainnya

• Harap dokumentasi yang diserahkan dalam format ASCII teks, atau DocBook. Format lainnya tak
dapat digunakan.

• Pastikan bahwa anda membaca, dan mengikuti template dokumentasi yang disediakan. Hal ini
dapat diperoleh di direktori KDE yaitu kdelibs/doc/ksgmltools/template.docbook
CATATAN : jika ada dokumentasi (dari pengembang atau dari KDE 1.x) maka gunakan doku-
mentasi itu sebagai titik awal pekerjaan, tetapi harus disesuaikan dengan layout dari template
dokumentasi.

• Perhatikan ejaan yang digunakan, terutama untuk nama tempat dan lain-lain. Sebaiknya ada orang
lain yang membaca dokumen tersebut terlebih dahulu.
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• Jika ada kata-kata asing maka perhatikan ejaannya, atau penggunaan karakter khususnya. Gunakan
K Character Selector bila karakter tersebut tidak ada pada keyboard anda.

• Singkatan harap ditulis dengan huruf besar, kecuali memang sifatnya khusus dan tidak perlu dihuruf
besarkan (misal dll).

• Angka sebaiknya ditulis dalam format yang benar

• Untuk angka yang tak memiliki nilai teknis sebaiknya ditulis dalam bentuk kata-kata. Misal “Ada
tiga tombol dialog”. Pada kalimat ini angka “3” tidak penting secara teknis. Angka yang
memiliki nilai teknis yang pentign, maka harus ditulis dalam bentuk angka, misal 10 MB, daripada
sepuluh MB.

2.2 Menulis dokumen

Menulis dokumentasi berbeda dengan menulis surat ataupun artikel. Bagian ini akan menerangkan
beberapa hal yang perlu diperhatikan ketika menulis dokumentasi KDE Seringkali pengguna mencoba
membaca manual dan merasa frustasi karena manual tersebut ditulis dengan kering dan sangat teknis. Hal
ini haruslah dihindari dalam penulisan dokumentasi. Memang sulit sekali untuk mengatasi hal ini tetapi
usahakan menulis secara mengalir dan tetap user-friendly. Usahakan menempatkan diri sebagai sesama
pengguna dan tidak menggurui dalam gaya penulisannya. Tentu saja tanpa meninggalkan kejelasan atau
detail dari tulisan.

Beberapa hal yang perlu diperhatikan :

• Pastikan bahwa seluruh bagian dari antar muka (interface) telah dijelaskan, jangan tertinggal opsi
pada perintah baris (command line) yang tersedia.

• Menjaga alur logika tingkat kesulitan sangatlah penting. Pastikan halaman awal dari dokumentasi
sederhana, dan bisa dibaca oleh pengguna baru yang belum pernah melihat aplikasi itu sebelumnya.
Kemudian informasi yang lebih teknis sebaiknya dimunculkan pada bagian akhir dokumen.

• Pastikan untuk menulis dengan gaya bahasa dan kosa kata sesuai dengan pembaca. Misal pengguna
yang memanfaatkan Samba control module jelas sangat berbeda dengan pembaca yang menggu-
nakan game. Dokumentasi manual haruslah mencerminkan hal ini.

• Sangat disarankan untuk menggunakan screenshot, gambar , tombol aksi dan lain sebagainya. Hal
ini disebabkan KDE adalah aplikasi dengan GUI, sehingga gambar akan memberikan arti dari
kata-kata.

• Harap definisikan singkatan yang digunakan, kecuali singkatan tersebut memang telah lazim digu-
nakan, misal RAM, PC dan lain sebagainya. Tetapi bila seperti PPP (Point to Point Protocol)
maka sebaliknya definisikan sekali terlebih dahulu, dan pada bagian lain dokumentasi singkatan
tersebut dapat digunakan. Ketika pertama kali memperkenalkan kata-kata tersebut gunakanlah
tag <firstitem> atau sebaiknya menggunakan glossary, dan menggunakan tag <glossentry>

• Perhatikan hal-hal kecil pada aplikasi itu. Misal jika aplikasi itu bisa di-dock, maka jelaskan pula
bagaimana cara melakukannya. Juga jangan lupa di bagian manakah dari K menu program itu
akan diinstal. Jika ada hal-hal tertentu yang harus disesuaikan sebelum aplikasi tersebut bisa
dijalankan, maka jelaskan pula cara-caranya, dan jika ada hal-hal yang harus ditentukan secara
manual, jelaskan bagaiman cara melakukannya. Bila hal tersebut terjadi secara otomatis, tetap
juga perlu dilakukan dokumentasi tentang hal ini.

• Tulislah sesuatu yang membuat pembaca sebagai pengguna yang belum dapat menggunakan aplikasi
akan merasa senang membacanya. Untuk itu dapat dicobakan pada orang lain yang menggunakan
program tersebut, dan membaca dokumentasi tersebut sebagai panduannya.
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2.3 Saran umum untuk penulisan

Berikut ini adalah beberapa tip atau saran yang membantu proses penulisan

• Untuk mengetahui kesalahan dalam penulisan dokumentasi dapat dilakukan dengan membacanya
keras-keras, atau orang lain membacanya. Kalimat yang tak mengalir, atau memiliki bentuk yang
kaku akan terasa. Hal ini biasanya terjadi pada kalimat yang panjang.

• Dalam menulis usahakan, jelas, spesifik dan langsung. Pilihlah kata-kata dengan seksama, dan pasti
akan artinya dari tiap kata yang digunakan. Gunakan kamus untuk mengetahui arti yang tepat.

• Gunakan kalimat yang lengkap. Jangan hanya potongan kalimat. Untuk kalimat lengkap perlu
diperhatikan :

– Hindari kalimat yang memiliki bahasan lebih dari satu. Pisahkan menjadi beberapa kalimat.
Hindari paragraf yang terdiri dari hanya 1 kalimat yang panjang sekali.

– Gunakan koma sebelum “dan” pada kalimat majemuk. Sebagai contoh : “Gunakan tombol
kiri untuk memilih teks, dan tombol tengah untuk menempelkannya”.

– Jagalah urutan kalimat secara logis.

• Hindarilah penggunaan kata yang sama pada kalimat yang sama. Tentu saja untuk perintah dan
terminologi teknis hal tersebut tidak menjadi masalah.

• Tidak perlu dikhawatirkan masalah tata letak tulisan, misal apakah setelah titik harus ada dua
spasi, atau paragraf harus menggantung dan lain sebagainya. Hal ini akan ditangani oleh Docbook.

• Tulis dan nikmati pekerjaan menulis itu.



3
Daftar pemeriksaan dokumentasi

Berikut ini adalah daftar perihal yang sebaiknya dibahas dalam suatu manual aplikasi. Bila telah selesai
menulis dokumen sebaiknya memeriksa lagi dengan daftar berikut ini, dan pastikan anda dapat men-
jawab pertanyaan tersebut dengan menggunaka manual yang ditulis. Beberapa pertanyaan di bawah ini
diberi tanda Developer, yang berarti pertanyaan tersebut diharapkan dapat dijawab oleh para develop-
er. Dengan kata lain pertanyaan tersebut membutuhkan jawaban dengan masukan dari para developer.
Beberapa pertanyaan juga ditandai dengan nama seksi dari tulisan (misal [Pengantar]) untuk menandai
pada bagian manakah seharusnya dituliskan pada dokumentasi tersebut. Daftar ini hanyalah panduan
untuk membantu penulisan agar lebih efektif dan lengkap.

3.1 Identifikasi

• Apakah tujuan dari aplikasi tersebut ? [Pengantar]

• Dapatkah anda menerangkan secara singkat aplikasi tersebut ?

• Apakah kemampuan utama dari aplikasi tersebut ? [Pengantar]

• Hal apakah yang dapat dibanggakan pada aplikasi tersebut ? (Developer) [Pengantar]

• Apakah perbedaan utama antara aplikasi tersebut dengan aplikasi lainnya yang sejenis ? [Pengantar]

• Pengguna jenis manakah yang menjadi sasaran aplikasi ini ? [Pengantar]

• Siapa yang menulis aplikasi tersebut, nama dan URL ? [Credit]

• Apakah pengelola saat ini berbeda dengan pengelola/penulis aslinya ? [Credit]

• Menggunakan lisensi apakah aplikasi tersebut ? [Credit]

• Apakah aplikasi ini memiliki homepage ? [Pengantar dan Instalasi]

• Apakah ada milis untuk aplikasi ini ? Bila ada pembicaraan apakah yang sesuai pada milis ini ?
[Pengantar]

3.2 Instalasi

Sudah barang tentu pertanyaan-pertanyaan ini sebaiknya dapat dijawab pada bagian Installation

• Bagaimana perintah untuk mendownload aplikasi, situs FTP, CVS atau di tempat lainnya ?

• Apakah ada rilis versi stabil dan versi pengembangan ?
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• Apakah ada perintah kompilasi atau instalasi khusus selain, ./configure, make , dan make install
?

• Apakah menginstall library untuk aplikasi ini memiliki resiko mengganggu aplikasi lainnya. Apakah
aplikasi ini menggunakan library terbaru yang mungkin tidak bekerja dengan semestinya ?

• Apakah paket ini merupakan bagian dari salah satu paket KDE (kdenetwork, kdebase, atau lain-
nya) ?

• Apakah membutuhkan suatu konfigurasi sebelum program tersebut dapat dijalankan ?

• Jika ya, apakah telah diberikan keterangan mengenai instruksi tersebut ?

3.3 Fungsi

• Apakah aplikasi ini bisa diubah theme-nya, atau menggunakan skin ?

• Apakah aplikas ini juga bekerja sama dengan aplikasi terpisah lainnya ? Jika ya bagaimana caranya
?

• Pengaturan sistem manakah yang mempengaruhi program ini (Address book, dan sebagainya) ?

• Apakah memberikan akses pada fungsi sistem yang telah ada, misal seperti PPP ?

• Jika ya, apakah ada informasi singkat mengenai itu, atau petunjuk penting ?

• Apakah ada suatu konsep khusus atau terminologi yang digunakan pada aplikasi tersebut ?

• Jika ya apakah dapat dijelaskan secara sederhana ?

• Apakah ada petunjuk atau trik khusus yang perlu diketahui penguna berkaitan dengan aplikasi ini
?

• Dialog atau menu manakah yang tersembunyi, sehingga penulis mungkin tidak menemukan ketika
menjalankan aplikasi ini ? (Developer)

• Apakah ada suatu berkas penguji atau berkas contoh yang dapat digunakan untuk menjalankan
aplikasi ini ? (Developer)

• Apakah ada suatu fitur yang membutuhkan hak atau izin khusus atau langkah sebelumnya yang
khusus ?

• Apakah ada opsi untuk perintah baris (command line), jika ada, bisakan diberikan keterangan
secara singkat ?

• Bagaimana format file konfigurasi serta sintaksnya ? [Fitur lanjutan atau Appendix]

• Apakah aplikasi ini memiliki dukungan skrip ?

• Apakah aplikasi ini dapat didock ?

• Bagiamana perilaku aplikasi terhadap komponen tertentu ? (Developer)

• Apakah ada API tertentu yang berkaitan dengan aplikasi ini, jika ya apa saja ? (Developer)

• Di manakah aplikasi ini diinstal ? Sebutkan direktori dan lokasi menunya

• Apakah ada dokumen lainnya seperti HOWTO atau tutorial yang dapat digunakan membantu
mengatur aplikasi ini ? Bila ada di manakah dokumen tersebut dapat diperoleh ?

• Apakah aplikasi ini mendukung tambahan komponen plug-in, atau tambahan lainnya (file template,
dictionary dan lain-lain). Jika ya bagaimana pengguna dapat memperoleh tambahan tersebut ?
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3.4 Kualitas

• Apakah permasalahan yang biasanya timbul, dan solusinya atau kesalaan yang telah diketahui ?
(Developer)

• Apakah ada beberapa pertanyaan yang biasanya ditanyakan oleh pengguna, dan apakah jawabannya
? (Developer)

• Fitur apakah yang belum ada ? (Developer)

• Perbaikan apakah yang ada sejak versi terakhir ? (Developer) pada [Revision History]

• Apakah rencana pengembangan di masa mendatang ? (Developer)[Pengantar]



4
Menambah dukungan bahasa KDE

4.1 Pertama kali yang dilakukan

Sebelum melakukan penerjemahan koordinator bergabung dengan mailing list penerjemah dan doku-
mentasi KDE. Hal ini dapat dilakukan dengan mengirimkan email dengan “subscribe” pada subyek
dan body, kepada kde-i18n-request@kde.org. Mailing list ini juga diarsip pada lists.kde.org. Ten-
tunya sebelumnya harus dilihat daftar bahasa dan koordinator KDE. Perlu diketahui saat ini KDE 2
mendukung Unicode dan penerjemahan GUI sekarang beralih ke format UTF-8 (8 bit Unicode Transfer
Format).

Untuk menerjemahkan sebaiknya KDE versi tersebut diinstal. Perlu juga diperhatikan paket GNU
gettext terbaru telah diinstal. Halaman info dari paket ini sebaiknya dilpelajari. Perlu juga dibiasakan
penggunaan perangkat bantu seperti KBabel, CVS, dan CVSUP. CVS adalah merupakan suatu sistem
pengendali kontrol (Version Control System). Yang memungkinkan berbagai orang bekerja sama untuk
mengedit file. Untuk KDE CVS server yang digunakan adalah cvs.kde.org. Program ini berisi kode pro-
gram untuk KDE, dokumentasi, translasi dan segala sesuatunya yang berkaitand engan KDE. Pengguna
yang memiliki account CVS dapat menset sehingga komputernya dapat melakukan sinkronisasi dengan
file pada server tersebut. Untuk mendapatkan account di CVS KDE maka perlu dikirim email permo-
honan ke Stephan Kulow atau David Faure dan sebutkan nama serta password dalam bentuk terenkrispi.
Untuk mengetahui bentuk password yang terenkripsi itu lakukan :.

perl -e "print crypt(’<your password>’,’<xy>’),\"\n\";"

<password anda> adalah password dan <xy> adalah sebarang karakter. Perlu diketahui hanya ada 1
account untuk tiap tim translasi.

Sebagai ringkasan perlu diketahui bebebrapa perintah dasar CVS yang sering digunakan :

• checkout (untuk mendapatkan dari server CVS dan disalin ke mesin lokal) dengan parameter -l
(untuk non recursive)

• update (untuk memperbaharui apa yang telah ada pada sistme lokal) dengan parameter -dP (untuk
penanganan direktori secara cerdik),

• add atau import (untuk memgberi tahu server CVS bahwa ada sesuatu yang baru),

• commit (untuk meletakkan hal yang baru dari sistem lokal ke server CVS),

• remove (untuk menghapus sesuatu pada server CVS).

Keterangan tentang perintah dasar CVS dapat dibaca di KDE Developer’s HOWTO. Satu hal kecil yang
perlu diperhatikan ketika membuat direktori di “pohon” CVS adalah sebagai berikut : harap pastikan
bahwa paling tidak direktori tersebut berisi Makefile.am dan .cvsingnore. Berkas ini dibutuhkan untuk



Menambah dukungan bahasa KDE 10

administrasi internal dari tim KDE untuk kompilasi yang benar. Dapat dilakukan dengan menyalin dari
direktori bahasa lainnya misal kde-i18n/de/. Tetapi jangan lupa mengganti singkatan bahasa yang
digunakan sesuai dengan singatan resmi (mengikuti standard ISO). Ketika membuat direktori di CVS
disarankan menggunkan perintah import ketimbang add.

Ada beberapa program GUI untuk CVS ini yang mempermudah penggunaannya, misal LinCVS,atau
Cervisia. Kalau ingin lebih mendalami masalah CVS ini disarankan mebaca The CVS Book – Open Source
Development with CVS.

4.2 Memulai penerjemahan

Untuk memulai penerjemahan GUI, sebaiknya KBabel diatur agar menggunkan “UTF-8” (8 bit Unicode
Transfer Format).

• Pertama terjemahkan file kdelibs.po(t) sebab file ini akan digunakan pada berbagai aplikasi KDE,
file ini akan menyediakan teks pada menu standard.

• Kemudian terjemahkan desktop.po yang akan menangani berbagai hal di menu K.

• Lalu aplikasi pada kdebase.

Untuk detaillnya berikut ini adalah langkah-langkahnya :

• Download fiile kdelibs.pot berkas template untuk semua penerjemahan kdelib (download dapat
dilakukan menggunakan WebCVS)

• Simpan berkas sebagai kdelibs.po pada direktori lokal di komputer Anda. (Semua berkas GUI
yang diterjemahkan akan diakhiri dengan “.po”, sedangkan berkas aslinya diakhiri dengan “.pot”

• Mulai terjemahkan (baca bagian GUI), baik menggunakan perangkat bantu atau editor biasa

• Ketika selesai dengan kdelibs.po, periksalah dengan perintah :
msgfmt --statistics yourkdelibs.po .

Sebagian besar langkah di atas (dari transformasi dari pot ke po dan pemeriksaan sintaks) dilakukan
secara otomatis oleh KBabel. Karena juga menangani Unicode maka sangat disarankan menggunakan
KBabel untuk menerjemahkan GUI dari KDE. Setelah berkas diterjemahkan maka kirimkan ke koordina-
tor. Koordinator nantinya akan membuat suatu subdirektori pada kde-i18n/$LANG/ yang diberi nama
sesuai dengan kode bahasa tersebut. Juga akan dibuat direktori untuk berkas PO. Setelah ini maka
koordinator tim dapat memberikan hasil penerjemahan langsung ke server KDE.

Bila penerjemahakan GUI telah mulai menampkan hasil, dan tim telah terorganisasi dengan baik,
maka barulah dimulai penerjemahan dokuumentasi. Pada server i18n.kde.org tersedia beberapa in-
formasi mengenai penejemahan dokumentasi ini. Perkembangan pekerjaan penerjemahan KDE dapat
dilihat pada situsi KDE. Agar suatu bahasa dapat masuk dalam rilis resmi KDE maka minimal kdelibs
dan desktop.po sudah diterjemahkan semuanya, dan kdebase sekitar 80-90%.

4.3 Masalah Unicode

KDE2 menggunakan Unicode yang akan memudahkan penanganan font dan bahasa yang beragam secara
lebih mudah. KDE hanya akan mendukung UTF-8 (8bit Unicode Tranfser Format), sebab berbagai
perangkat bantu GNU yang digunakan oleh KDE belum mendukung UTF16. Sehingga beberapa bahasa
Asia mengalami kesulitan dalam hal ini.

Berkas desktop.po harus dalam format UTF-8. File lainnya masih bisa disimpan dalam format lama.
Tetapi sangat disarankan utnuk menggunakan UTF-8. Sekali menggunakan format UTF-8, maka seluruh
file harus diformat dalam format baru ini. Cara termudah adalah menggunakan recode. Dukungan huruf
dari kanan-ke-kiri saat ini belum diimplementasikan, mungkin pada versi 3.0. Perlu diperhatikan bahwa
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Emacs standard tak dapat memanfaatkan UTF-8 tetapi ada paket tambahan yang dapat diperoleh di
http://www.cs.ust.hk/~otfried/Mule/. Memang paket ini belum sempurna.

Untuk melakukan konversi paling mudah adalah dengan menggunakan “recode”. Paket ini dapat
diperoleh di http://www.iro.umontreal.ca/contrib/recode/HTML/

KBabel merupakan perangkat bantu penerjemahan yang telah mendukung UTF-8. Sehingga dapat
lebih mudah digunakan dalam hal ini. Untuk melakukan konversi ke UTF-8 dapat dilakukan secara
mudah yaitu :

1. Ubah berkas charset yang berisi utf-8

2. cd fi/messages;find . -name ’*.po’ | xargs recode iso-8859-1..utf-8

3. Edit pada semua berkas .po .. charset=iso-8859-1 menjadi charset=utf-8

Cara lain daripada langkah ke 3 adalah dengan menggunakan skrip pendek (tentunya sesuaikan dengan
charset yang digunakan). Skrip ini dibuat oleh Juraj Bednar dari tim Slowakia :

for i in ‘find . -name ’*.po’‘;do (echo -n "$i..."; sed -e \
’s/charset=iso-8859-1/charset=utf-8/’ $i | sed -e \
’s/charset=iso-8859-2/charset=utf-8/’ > $i.utf-8;mv -f $i.utf-8 $i;echo \
"done");done

4.4 Masalah localization

Ada beberapa hal yang tak terkait langsung dengan penerjemahan tetapi biasanya dilakukan oleh ko-
ordinator penerjemahan. Hal yang paling penting adalah masalah localization. Jika suatu bahasa baru
untuk suatu negara baru, maka dapat diberikan informasi pada KDE dengan informasi tentang hal lokal
pada negara tersebut, misal mata uang, format tanggal, waktu dan angka, bendera dan hal-hal lainnya.
Informasi ini disimpan dalam direktori “l10n” pada pkaet kdebase dan digunakan pada semua aplikasi
KDE khususnya pada bagian “desktop” di Control Center.

Perlu diperhatikan, hal ini sangat berkaitan dengan “country” tidak hanya bahasa. Sehingga bila
bahasa yang digunakan adalah resmi di suatu negara, maka hal ini tak perlu menjadikan permasalahan.
Untuk informasi lengkapnya bisa dibaca berkas README pada direktori kdebase/l10n. Misal untuk mele-
takkan benderan maka diletakkan berkas “png” lambang bendera tersebut di direktori l10n dari source
code KDE. (kdebase). Dan juga harus diedit isian pada entry.desktop juga. Bila tidak maka gambar
bendera tidak digunakan

4.5 Beberapa saran praktis

Bagian ini menerangkan beberapa tip dan saran praktis. Beberapa hal erat kaitannya dengan konsistensi.
Konsistensi adalah pertimbanganutama pada sistem desktop. Hal ini dengan tujuan untuk menjaga agar
“look and feel” terlihat selalu sama. Begitu juga dengan program sebaiknya memiliki penerjemahan
terminologi GUI yang sama dan dokumentasi juga menggunakan terminologi yang sama. Untuk mencapai
hal tersbeut merupakan tantangan terbesar bagi penerjemah dan penulis dokumen

Sebaiknya setiap anggota tim jangan bekerja secara terisolir. Sebauiknya mendiskusikan dengan
anggota kelompok penerjemah lainnya. Baik melalui mailing list atau sarana lainnya. Sebaiknya berbagi
tugas dengan personal lain yang juga bertugas sebagai koordinator untuk bagian lainnya (PO, doc, web
site dan sebagainya). Dengan cara ini bagaimana istilah dan bentuk penerjemahan dapat dijaga secara
konsisten. Suatu penerjemahan untuk pengguna bisnis jelas berbeda dengan pengguna yang seorang
spesialis komputer. Sebaiknya definisikan panduan gaya penerjemahan untuk tim suatu bahasa

Sebaiknya tentukan suatu element standard penerjemahan, dan konsisten menggunakan itu. Se-
baiknya dilakukan pengarsipan penerjemahan PO pada i18n.kde.org/po overview . Karena hal terse-
but akan dapat dimanfaatkan oleh program seperti KBabel untuk melakukan pemeriksaan konsistensi.
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Disarankan juga penggunaan daftar kata atau kamus, serta forum diskusi. Perangkat bantu seperti
kdedict yang dibuat Matthias Kiefer merupakan suatu perangkat bantu yang menolong.

Sebaiknya dikembangkan sistem pekerjaan yang bersifat saling memeriksa (mutual proofreading)
untuk membuat semua orang mengacu pada aturan. Memang akan mempermudah bila orang ynag
melakukan penerjaman GUI dan Help merupakan orang yang sama, tetapi bila tidak memungkinkan
maka orang yang melakukan pemeriksaan dokumentasi, screenshot sebaiknya dapat mengedit berkas
PO juga, sehingga memungkinkan antara GUI, dan dokumentasi memiliki konsistensi dan gaya yang
sama. Akan membingungkan pengguna bila antara GUI, dokumentasi dan Help memiliki terminologi
yang berbeda.

Sebelum mengumpulkan ke CVS KDE sebaiknya dilakukan pemeriksaan sintaks berkas PO dan
Help.

4.6 Pernyataan credit bagi yang bekerja

Untuk menyatakan kerangan penulis dan orang yang terlibat pada pekerjaan translasi maka harus diubah
file tertentu. Perubahan ini akan menyebabkan :

• Pada halaman “credit” pada www.kde.org/credits.html

• Pada menu Help -> About dari program yang diterjemahkan

• Pada bagian “credits” dari dokumentasi yang diterjemahkan

Pada halaman KDE pengambilan nama ini dilakukan secara otomatis dari file pada CVS. Sehingga jangan
mengubah halaman HTML tetapi file contributor. Untuk jelasnya baca file README pada module tersebut.
Memasukkan nama yang terlibat merupakan tugas dari koordinator bahasa.

Untuk keterangan pada kotak “About” dari menu Help, maka nama dan email penerjemah dima-
sukkan dengan mengedit bagian tertentu dari berkas PO :

#: translatorinfo.cpp:1
msgid ""
" : NAME OF TRANSLATORS\n"
"Your names"
msgstr ""

#: translatorinfo.cpp:3
msgid ""
" : EMAIL OF TRANSLATORS\n"
"Your emails"
msgstr ""

Jika ada lebih dari 1 penerjemah, maka dapat ditulis dengan menggunakan tanda pemisah koma tetapi
tanpa spasi (translator1,translator2,translator3). Hal yang sama dilakukan pula untuk alamat
email. Jika tidak semua alamat email diketahui kosongkan saja (address1,,address3). Sehingga tampak
seperti :

#: translatorinfo.cpp:1
msgid ""
" : NAME OF TRANSLATORS\n"
"Your names"
msgstr "Translator One,Translator Two,Translator Three"

#: translatorinfo.cpp:3
msgid ""
" : EMAIL OF TRANSLATORS\n"
"Your emails"
msgstr "translator.one@some.domain,,translator.three@another.domain"



5
Penerjemahan GUI

Bab ini akan menerangkan proses penerjemahan GUI dari KDE beserta aplikasinya. Untuk mendapatkan
informasi mengenai mekanisme berkas po dan pot, harap membaca informasi tentang gettext.

5.1 POT and PO Files

Untuk menyediakan template untuk pekerjaan penerjemah, menu bahasa Inggris, dan teks dialog dari
program telah disediakan berkas ASCII dengan nama belakang .pot (singkatan dari PO Template, dan
.po dari Portable Object). Dari template standard atau “berkas POT”, penerjemah akan menghasilkan
berkas “PO” untuk tiap bahasa. Hal ini dapat dilakukan dengan mudah, yaitu mengedit “nama file.pot”
atau menggunakan program bantu (misal KBabel) dan menyimpannya dalam “nama file.po”. Setelah
menerjemahkan teks di dalam file ini, maka berkas PO ini akan berisi file untuk menu dalam bahasa
tersebut. Sebetulnya ada langkah yang menyebabkan dihasilkannya berkas MO (Machine Object) dari
berkas “PO” ketika dilakukan kompilasi. Tetapi hal ini tidak begitu perlu dikhawatirkan oleh pener-
jemah. Dalam arti selama penerjemahan dilakukan dengan format yang benar, hal ini tidak menjadi
permasalahan.

Berkas PO untuk bahasa Inggris dan dokumentasi dapat diperoleh ditiap direktori paket program.
Berkas POT dapat diperoleh di kde-i18n/template

Sedangkan berkas PO untuk bahasa tertentu dapat diperoleh di
kde-i18n/$LANG/messages/nama-packet. misal kde-i18n/de/messages/kdebase/konqueror
untuk berkas bahasa Jerman. $LANG merupakan variabel yang berisi kode bahasa, seper-
ti “de”, “fr”. Untuk Indonesia menggunakan “id”. Kode bahasa ini dapat dibaca di
http://lcweb.loc.gov/standards/iso639-2/englangn.html.

5.2 Hal penting untuk penerjemahan GUI

Ada dua cara untuk mengetahui program mana yang belum diterjemahkan pada suatu bahasa :

• Melihat pada tabel status di halaman KDE Internationalization

• Membandingkan berkas POT dengan PO pada bahasa tertentu. Jika belum ada file PO pada pro-
gram tertentu di bawah direktori kde-i18n/$LANG/messages/(nama-paket) maka berarti program
tersebut belum ada yang menerjemahkan. Proses perbandingan ini dapat dilakukan secara otomatis
oleh Catalog Manager dari KBabel.

Tetapi sebelum memulai penerjemahan sebaiknya berkonsultasi dengan koordinator penerjemahan. De-
ngan memiliki infrastruktur informasi yang baik, maka duplikasi pekerjaan dapat dihindari.
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Program KDE selalu berkembang, sebagai dampaknya teks pada GUI akan selalu berubah, dan
penerjemahan selalu dibutuhkan Untuk mengetahui program mana yang yang perlu direfisi maka dapat
dilihat di “Highscore lists”. Keluaran dari teks informasi tersebu sebagai berikut ini

de:
kdelnk: 4 fuzzy
kexpress: 1 fuzzy
killustrator: 5 fuzzy
klyx: 1 fuzzy
kmail: 1 untranslated
kohtml: 1 fuzzy 3 untranslated
kticker: 5 untranslated
ktop: 3 fuzzy 1 untranslated
webmaker: 1 fuzzy 9 untranslated

“Fuzzy” ini artinya bagian yang masih belum pasti penerjemahannya. Bagian ini ditandai secara otomatis
oleh rutin (dalam msmerge) dan dianggap masih belum selesai. Program yang belum diterjemahkan tidak
akan muncul pada “Highscore lists”, tetapi terlihat pada tabel status i18n. Berapa banyak pekerjaan
yang telah dilakukan oleh tiap kelompok penerjemah bisa diliat juga di situs i18n.kde.org. Berdasarkan
data inilah diputuskan apakah suatu bahasa disertakan pada rilis resmi KDE. Biasanya kdelibs, dan
desktop.po harus diterjemahkan, dan kdebase paling tidak sudah mencapai 80,80%.

5.3 Penerjemahan berkas PO dan POT

Untuk informasi umum mengenai penerjemahan bisa dibaca di halaman Info dari paket gettext. Untuk
memberikan informasi tetnagn hal mendasar dari penerjemana KDE berikut ini adalah keterangan yg
berkaitan dg POT dan PO sebelum dikerjakan dengan program seperti KBabel :

• Jika tak ada terjemahan untuk program tersebut (misal tak ada berkas PO dengan nama yang
sama pada direktori “kde-18n/$LANG/messages/(nama-paket)/”) dan misal memang ternyata
belum ada yang mengerjakan (kontak koordinator), maka berkas POT diedit dengan editor ASCII.
Berkas POT tersebut dibaca dan lalu disipan dengan akhiran “PO” di subdirektori tersebut. Ini
menjadikan adanya file kde-i18n/$LANG/messages/(nama-paket)/(nama-program).po”. Misal
bila KWrite belum diterjemahkan maka pertama adalah membaca file
kde-i18n/template/kdeutils/kdewrite.pot, dan menyimpannya dengan nama baru
kde-i18n/$LANG/messages/kdeutils/kwrite.po. Lalu penerjemahan dapat dimulai

• Mulai tahapan in maka proses translasi dilakukan pada berkas po tersebut. Pekerjaan yang akan
dilakukan adalah melakukan pembaharuan, memerbaiki berkas po ini.

• Setelah header pada berkas diperbaharui atau diisi, Misal keterangan, siapa kapan, dan juga meng-
hapus tag “fuzzy) maka string yang kosong dapat diisi dengan terjemahan. Pada POI yang telah
diterjemahkan ebelumnya maka perlu diperiksa terjemahan yang masih diberi tanda “fuzzy” dan
perbaiki bila perlu. Cara lain adalah hilangkan tag “fuzzy” pada awal baris setiap selesai mener-
jemahkan bagian tersebut.

Saat ini langkah di atas dapat dilakukan secara otomatis oleh program khusus seperti KBabel. Dari
memilih berkas POT, menyimpan sebagai berkas PO hingga memperbaharui header dan mengganti isian
fuzzy dan pemeriksaan sintaks. Suatu header dapat dicontohkan sebagia berikut :

msgid ""
msgstr ""
"POT-Creation-Date: 2000-02-17 00:58+0100\n"
"PO-Revision-Date: 2000-02-17 08:43+MET\n"
"Last-Translator: Thomas Diehl <thd@kde.org>\n"
"Language-Team: Deutsch <kde-i18n-de@kde.org>\n"
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"MIME-Version: 1.0\n"
"Content-Type: text/plain; charset=utf8\n"
"Content-Transfer-Encoding: 8bit\n"
"X-Generator: KBabel 0.4\n"

Jika melakukan pengeditan dengan menggunakan editor teks biasa, maka jangan hilangkan
‘‘msgid/msgstr”. Jika tidak maka kompilasi akan berhenti dengan “parse error”. Jangan lupa meng-
hilangkan “fuzzy” yang ada sebelumnya. Bila tidak, maka akan didapatkan hasil yang tidak tepat pada
isian di “Highscore list” walaupun penerjemahan telah benar.

Isian untuk Content-Type dan Transer-Encoding saat ini tidak penting. Tetapi charset harus diisi
dengan bena r, dalam hal ini UTF-8 (8 bit Unicode Transfer Format). Penerjemahan tersebut akan
menjadi sebagai berikut :

#: kedit.cpp:90 kedit.cpp:1071
msgid "Show &Status Bar"
msgstr ""

Maka ketika diterjemahkan menjadi :

#: kedit.cpp:90 kedit.cpp:1071
msgid "Show &Status Bar"
msgstr "&Tampilkan Statusbar"

Bentuk penerjemahan yang tidak benar:

#: ReniceDlg.cpp:31
#, fuzzy
msgid "Renice Process"
msgstr "Prioritas proses diubah"

Maka penerjemahan yang benar :

#: ReniceDlg.cpp:31
msgid "Renice Process"
msgstr "Prioritas proses diubah"

Ada beberapa kesalahan yang sering timbul ketika berpindah dari KDE 1.x ke KDE versi terbaru :

#: kpackage.cpp:613
#, fuzzy, c-format
msgid "Unknown package type: %1"
msgstr "Jenis paket tak dikenal: %s"

Penerjemahannya sendiri benar, tetapi string dari variabel memliiki format yang salah. Maka harus
diubah menjadi:

#: kpackage.cpp:613
#, c-format
msgid "Unknown package type: %1"
msgstr "Jenis paket tak dikenal: %1"

Perlu diketahui bahwa variabel dengan jenis yang benar (“%1”, “%2”, dan lainnya) tak mementingkan
urutannya dalam penerjemahannya. Tetapi pada variabel dengan jenis yang lama mengharuskan pengu-
rutan yang benar (“%d”, “%s”, dan sebagainya). Urutan ini harus benar seperti aslinya. Setelah perbaikan
dilakukan maka perlu dihapus tag “fuzzy”. Jika tidak maka string yang telah dibenarkan tersebut akan
diabaikan dalam proses kompilasi. Kadang ada beberapa baris yang diawali dengan tanda “#” seperti :
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#~ msgid "Where do you want to go tomorrow?"
#~ msgstr "Where do you want to go tomorrow?"
#~ msgid "No comment available"
#~ msgstr "Keine Erklärung verfügbar"

Baris ini telah diberi tanda sebagai komentar. sebab biasanya telah tidak digunakan lagi, dan dapat
dihapus. KBabel akan melakukannya seara otomatis.

5.4 Hal khusus dan permasalahan

Seperti yang dijelaskan sebelumnya bahwa karakter “#” dan “.” memiliki arti khusus. Beberapa hal
perlu diperhatikan :

• Karakater “&” menandai “accelerator key” atau tombol penyingkat. Biasanya digunakan dengan
kombilnasi dengan tombol Alt untuk menjalankan suatu perintah. Misal Alt + S untuk “Show
&Status Bar”. Perlu diperhatikan dan dipasitkan bahwa huruf yang sama tidak digunakan dua
kali pada suatu menu. Ada suatu cara semi otomatis untuk melakukan pemeriksaan ini (“accelerator
clash”. Baca bagian Kompilasi, Konteks, dan Tombol penyingkat)

• Beberapa berkas PO mengandung “context information” yang memungkinkan penerjemah menge-
tahui, apakah “home” itu berarti direktori pengguna, atau suatu tombol di keyboard atau awal dari
baris. Informasi semacam ini biasanya diletakkan dengan huruf dan dikombinasikan dengan “ :“.
Hal yang terpenting adalah string pada bagian ini tidak boleh terlihat pada terjemahan. Dengan
kata lain, jangan salinkan bagian ini ke bagian “msgstr” dari berkas PO.

Sebagai contoh :

#: kdeui/kstdaction.cpp:669
msgid ""
" : beginning (of line)\n"
"&Home"
msgstr "&Dateianfang"

#: src/kernel/qaccel.cpp:562
msgid ""
" : QAccel\n"
"Home"
msgstr "Pos1"

Karakter khusus seperti tanda kutip harus ditulis dengan dimulai tanda miring terbalik (backslah). Hal
ini bila ingin menggunakannya sebagai bagian dari teks. Tanda kutip yang ditulis tanpa tanda “\” akan
diterjemahkan oleh program senbagai bagian akhir dari “msgstr”. Rutin msgfmt --statistics , alkan
berhenti dan menunjukkan sebagai kesalahan. KBabel akan membantu dalam menemukan kesalahna ini.

#: cardmaps.cpp:105

#, c-format

msgid "kpat: PANIC, cannot load card pixmap \"%1\"\n"
msgstr "KPat: schwerer Fehler, kann Kartenbild \"%1\" nicht laden\n"

Permasalahan untuk bahasa yang memiliki terjemahan lebih panjang daripada bahasa Inggris (misal
Jerman, Indonesia) adalah kenyataan bahwa seringkali kotak dialog menjadi terlalu kecil, terpotong,
dan terlihat sumpek. Hal ini hanya bisa ditentukan dengan cara melakukan kompilasi dan menjalankan
program. Tetapi salah satu pemecahan adalah dengan mencoba menerjemahkan dan menjaga panjang
string tetap sama.

Terkadang suatu teks bahasa Inggris tetap muncul dalam program, walaupun berkas PO telah
diterjemahkan lengkap, tetapi teks tersebut tak ada. Hal ini terjadi karena teks tersebut datang dari
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paket lain (sering dari kdelibs yang banyak digunakan oleh komponen GUI KDE, atau dari modul terpisah
dari program tersebut, yang memiliki berkas PO tambahan). Kemungkinan lainnya adalah teks tertentu
belum dibuat oleh si pembuat program sehingga sesuai dengan l18n sehingga tidak bisa menggunakan
bahasa lainnya.

Setiap string yang akan terlihat oleh epngguna seharusnya akan dilewatkan pada fungsi C QString
i18n(const char *text). Ini menjamin bahwa string yang telah melalui proses lokalisasi dengan benar,
akan ditampiulkan (tentunya bila telah ada teks yang diterjemahkan). Sehingga teks yang diterjemahkan
hanya akan muncul bila program tesrebut memang telah mempersiapkan hal itu (dikenal dengan istilah
telah mengikuti kaidan localization). Dalam kasus teks yang tidak diterjemahkan tak dapat ditemukan
di berks PO, mungkin pembuat program telah terlupa. Jika ingin memastikannya maka dapat dilakukan
dengan meliaht source code dari program. Misal untuk menemukan nama file dan nomor baris dapat
dilakukan grep -n ‘‘text in question’’ *.cpp pada direktori kode program (source code)

Bila memang ditemui masalah ini sebaiknya dilaporkan ke bugs.kde.org atau menulis email ke pem-
buat program. Jangan dibiarkan saja.

5.5 Program khusus untuk penerjemahan GUI

Ada beberapa program yang dapat digunakan untuk menerjemahkan GUI. Secara otomatis program in
akan mencari string yang masih bersifat fuzzy atau belum diterjemahkan, mebandingkan penerjemah-
an, memeriksa sintaks, ejaan dan lainnya. Pada saat ini program KBabel merupakan program yang
sangat disarankan. Karena baru KBabel yang dapat menangani Unicode dengan benar. KTranslator
dan Emacs masih membutuhkan program tambahan, dan harus digunakan secara hati-hati. Di samping
itu KTranslator sudah tidak dikembangkan lagi, dan Emacs dengan modul PO masih kurang beberapa
fitur dibandingkan KBabel

5.5.1 KTranslator

Ditulis oleh Andrea Rizzi untuk KDE 1.x tetapi sudah tak dikembangkan. Saat ini Andrea bekerja untuk
mengembangkan program database yang digunakan sebagai tambahan pada KBabel. Versi terakhir
KTranslator adalah 0.6.1 dan memiliki fitur sebagai berikut :

• Kemampuan naviasi yang lengkap (auto scrooll untuk istilah yang belum diterjemahkan atau pesan
masih fuzzy, menuju baris tertentu dan lain-lain).

• Pengelolaan CVS untuk berkas PO dan POT dengan statistiknya

• Pembaharuan header secara otomatis

• “Terjemahan kasar” untuk penerjemahan pertama

• Pencarian dalam $LANG.messages (compendium) untuk membantu pengujian konsistensi. Juga
pencarian string yang telah diterjemahkan dalam PO pada bhasa lain dan berkas GMO (untuk
perbandingan dan uji konsistensi).

• Pemeriksaan sintaks, dan dukungan KSpell

Program ini tampaknya jalan baik dengan KDE 1. Pada KDE 2 juga berjalan tetapi tak mendukung
Unicode. Program ini dapat diperoleh dari paket kdesdk.

5.5.2 KBabel

Program ini dikembangkan oleh Matthias Kiefer. Program ini sangat direkomendasikan untuk penerje-
mahan. Fitur pada versi 0.8 adalah sebagai berikut :

1. KBabel PO Editor:
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• Memiliki user interface yang bisa diatur, dan sesuai dengan KDE 2

• Luwes dan dapat ditambah fungsinya melalui plug-in

• Mampu membaca dan menyimpan dalam berkas Unicode (UTF-8 dan UTF-16)

• Memeriksa kesalahan sintaks secara otomatis, jika suatu kesalahan muncul maka dengan mu-
dah dicari.

• Pemeriksa ejaan, dan dukungan untuk kamus melalui plugin

• Perangkat bantu penerjemahan kasar (mengganti string yang bersifat fuzzy dan untranslated
dari berkas compendium atau kamus secara otomatis)

• Pembaharuan header berkas secara otomasi

• Pemeriksaan dan pengubahan secara otomatis atau manual status fuzzy tersebut

• Melakukan pencarian pada berkas compendium untuk pemeriksaan konsistensi

• Melakukan pencarian di berkas “auxilary” (berkas PO dari bahasa lainnya)

• Dapat membuka banyak berkas (dengan bukaan yang banyak untuk berkas yang sama)

• Fungsi pengeditan yang banyak, dapat diakses melalui GUI dan juga melalui tombol singkatan
yang dapat didefinisikan oleh pengguna, termasuk Undo yang tak terbatas, drag & drop dan
lain sebagainya

• Tag diberi tanda warna lain

• Kemampuan navigasi yang beragam (mencari ke string yang fuzzy atau untranslated atau ke
error berikutnya)

2. KBabel Catalog Manager:

• Pengelola manajer yang dapat melihat direktori kde-18n dengan cara yang enak.

• Berbagai mekanisme umembaca file untuk diedit dengan KBabel, misal Drag & Driop, double
click dan menu konteks

• Fungsi “Mark file”, yaitu untuk menandai berkas PO mana yang menjadi tanggung jawab
penerjemah lainnya)

• Kemampuan membandingkan secara otomatis dan melakukan perhitungan statistik berkas
POT dan PO untuk melihat hasil pekerjaan sekilas, mengetahui berapa berkas yang belum
diterjemahkan, dan berkas mana yang sudah terlalu lama.

• Memeriksa sintaks untuk berkas yang ada (msgfmt –statistics) untuk mengetahui apakah
berkas dapat dikompilasi ketika didistribusikan.

• Perintah yang dapat dikonfigurasikan yang dapat dijalankan dari menu konteks (seperti make,
make instal atau update cvs)

3. KBabeldict:

• Membuat berkas kompendium dalam berbagai model

• Melakukan pencarian pada berkas kompendium

KBabel Editor dan Catalog Manager memiliki Help dengan Whats this yang membuat tiap fungsi mudah
dipahami dan digunakan. Program ini dapat diperoleh dari module kdesdk atau pada
i18n.kde.org/tools/kbabel

5.5.3 (X)Emacs in PO Mode

Untuk mengatur modus PO dengan GNU Emacs, ikuti keterangan pada berkas po-mode.el yang diser-
takan pada paket GNU gettext. Paket ini juga dapat bekerja dengan XEmacs jika dilakukan pengaturan
seperti berikut :
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• Salin po-mode.el (bukan berkas tercompile *.elc), dari paket gettext ke direktori yang bisa terlihat
oleh XEmacs (misal /usr/X11R6/lib/site-lisp/):

• Buatlah isian berikut ini pada berkas .emacs. Ini bergantung pada distribusi yang digunakan,
berkas .emacs-option pada direktori home :
autoload ‘‘po-mode po-mode’’

• Lalu buat isian beriku pada Option -> Customize -> Variable
auto-mode-alist: "\\.po[tx]?\\’\\|\\.po\\." (dengan tanda kutip) pada bagian baris atas
dan po-mode pada bagian bawah garis (tanpa tanda kutip).

Fungsi yang diberikan oleh Emacs dengan modus PO adalah sebagai berikut :

• Kemampuan navigasi utama (ke fuzzy berikutnya, untranslated dan sebagainya)

• Penyisipan data header secara otomatis

• Melakukan validasi (pemeriksaan untuk mengetahui bila format telah benar)

• Pencarian suatu string pada berkas auxilary untuk penerjemahan di bahasa lainnya

• Pencarian suatu string di dalam berkas.

Emacs merupakan editor yang khas, sehingga untuk membiasakan menggunakan editor ini dibutuhkan
waktu penyesuaian. misal ketika membuka suatu berkas, maka berkas tersebut bersifat hanya dapat
dibaca, sehingga harus membuka suatu buffer baru untuk melalukan pekerjaan. Tetapi kemampuan
Emacs sangat membantu sehingga sangat baik untuk dipelajari. Hal lainnya adalah Emacs masih
merupakan perangkat bantu yang terbaik untuk mengedit DocBook yang merupakan format dokumen-
tasi KDE. Suatu keterangan tentang pentunjuk bekerja dengan modul SGML ini dapat diperoleh di
www.snee.com/bob/sgmlfree/index.html

Untuk membuat agar Emacs dapat bekerja untuk berkas Unicode dapat dibaca di
http://www.cs.ust.hk/~otfried/Mule/

5.6 Memeriksa dan mengumpulkan pekerjaan

Harap jangan memasukkan berkas PO ke CVS tanpa melakukan validasi sintaks. Dan jangan lupa
pemeriksa ejaan.

5.6.1 Pemeriksaan sintaks: msgfmt –statistics

msgfmt --statistics /path/to/translated/files

Perintah ini merupakan pemeriksaan minimal yang harus dilakukan untuk setiap berkas, sebelum berkas
itu dikirimkan kepada koordinator dan dimasukkan ke dalam CVS. Perintah ini akan memberikan infor-
masi mengeani string yang belum diterjemahkan (untranslated) dan poisisnya, dan juga kesalahan format
yang ada di berkas tersebut. “msgfmt” ini merupakan bagian dari paket program GNU gettext.

Beberapa program khusus seperti KBabel akan membantu melakukan hal ini. KBabel memiliki
sistem pemeriksaan sintaks secara otomatis yang akan menghemat waktu dalam melakukan hal ini,

msgfmt --statistics

Juga dijalankan secara otomatis oleh skrip pada server l18n pada semua berkas PO. Hasil pengujian ini
akan dikirimkan kepada para koordinator penerjemahan. Nantinya keluaran ini akan disertakan pada
sistem penjejakan bug dari KDE. Agar proses keseluruhan berhasil dengan baik, maka disarankan setiap
penerjemah melakukan pemeriksaan ini sebelum menyerahkan berkas tersebut pada koordinator.
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5.6.2 Memeriksa variabel hilang dan masalah lainnya

Di samping pemeriksaan sintaks, maka harus juga dipastikan bahwa tak ada permasalahan sebagai berikut
:

• Context information : seperti yang disebutkan sebelumnya, berkas PO dapat berisi komentar yang
berkatian dengan arti pasti dari suatu string (misal “home” bisa berarti direktori pegguna, suatu
tombol pada keyboard, atau awal dari baris). Informasi kontekstual ini tidak boleh tampil pada
terjemahan

• Argumen : Banyak string yang menunjukkan variabel (%1, %2, %3...) yang akan diganti de-
ngan isi sebenarnya ketika program dijalankan. Semua variabel dari string asli harus tampil pada
terjemahan (walau tidak perlu dengan urutan yang sama pada KDE 2)

• Kesamaan ; harus dijaga keseimbangan pada penerjemahan dan teks asli

KBabel melakukan beberapa rutin validasi terhadap masalah di atas. Pada versi terbaru memungkinkan
dilakukannya pengujian ejaan pada berkas.

5.6.3 Kompilasi, Pemeriksaan Konteks dan Akselerator

Agar dapat memeriksa paket yang diterjemahkan hingga sesuai dengan konteks dari interface program,.
maka perlu dihasilkan berkas “(G)MO”. Hal ini dapat dilakukan dengan melakukan kompilasi dari sub
direktori pada paket kde-i18n yang sesuai yang sesuai dengan bahasa yang telah diterjemahkan :

• Pindah ke direktori “kde-i18n”, buka berkas di subdirektori, dan hilangkan bahasa yang lainnya
kecuali bahasa yang akan dicompile (misal ingin mengkompilasi bahasa Indonesia, maka hilangkan
bahasa yang lainnya kecuali “id”). Tetapi jangan di”commit” ke CVS

• Lalu compile dengan perintah :
make -f Makefile.cvs & & ./configure & & make & & make install .

• Ketika ada banyak kesalahan dalam proses itu, mungkin dapat dicoba
./configure & & make -k; make -k docs; make -k install.
dengan parameter -k direktori yang tidak dikompilasi akan dilewati. Harap dibaca keterangan lebih
lengkap di HOWTO.

• Setelah itu dapat dipilih bahasa tersebut, dan melihat hasil terjemahan pada interface program
(diasumsikan program juga dikompilasi). Setelah ini dapat dilakukan pemeriksaan kontekstual,
Lakukan pemeriksaan untuk tiap menu, dialog dan periksa semua terjemahan apa cocok dengan
situasinya. Sering terjadi ternyata melenceng dari perkiraan ketika dilakukan penerjemahan berkas.
Untuk itu perlu dilakukan perbaikan PO, rekompilasi, dan periksa kembali.

Pemeriksaan konteks ini sering terpaksa harus dilewati, karena jadwal rilis. Tetapi akan terlihat tidak
profesional dan aneh bila semua program terlihat keluar dari konteks penerjemahnnya. Sehinga sebaiknya
harus dilakukan pemerikaan konteks ini.

Pemeriksaan lainnya yang harus dilakukan setelah program selesai dikompilasi adalah pemeriksaan
“tombol penyingkat” (Accelerator key) dikenal dengan pemeriksaan “accelerator clash”. Seperti telah
disebutkan di atas, karakter “&” pada berkas PO untuk menandai “tombol penyingkat” (accelerator key)
yaitu suatu tombol yang digabung dengan Alt atau Alt+Gr digunakan untuk menjalankan suatu perintah.
Penulis program dan penerjemah harus memastikan bahwa tak ada tombol penyingkat itu yang muncul
dua kali pada meu yang sama (misal “&Save” dan “&Save As” tidak boleh terjadi, tetapi “&Save” dan
“Save &as” boleh). Dengan kata lain harus dicegah terjadinya “accelerator clash” ini.

Ada cara semi otomatis untuk melakukan pemeriksaan ini. Hal ini dapat dilakukan :

• Sistem KDE tentunya sudah terinstal, dan tambahkan pada berkas
~/.kde/share/config/kdeglobals:
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[Development]
CheckAccelerators=<keyname>

• Sebagai contoh

[Development]
CheckAccelerators=F8

• Maka akan diperoleh laporan setiap kali terjadi accelerator clashes ketika tombol tersebut ditekan.

5.6.4 Mengumpulkan hasil ke CVS

Setelah memeriksa pekerjaan, maka penerjemah dapat mengirimkan terjemahannya ke koordinator. Ko-
ordinator biasanya akan memeriksa kembali dan memasukkan ke CVS utama pada cvs.kde.org Informasi
tentang CVS, CVSUP dan user interfacenya diberikan pada bagian berikut. Juga informasi tambahan.
Untuk mendapatkan berkas seperti Makefile dan .cvsignore serta perintah dan parameter yang dibu-
tuhkan. Bagi user dengan CVSUP, untuk memperoleh hanya bahasya yang diinginkan dari kde-i18n
maka lakukan :

cvsup -g -i kde-i18n/$LANG your cvsup command.file

Satu hal yang perlu diperhatikan adalah konflik versi. Jika berkas yang dimasukkan ke CVS lebih tua
dari berkas yang ada di server, maka akan dtolak, dan akan dibuat di direktori lokal versi baru yang berisi
tentang bagian yang konflik. Bila dicoba mengupdate berkas lokal yang konflik dengan server remote,
maka sistem akan menggabung perbedaan tersebut ke berkas lokal dan memberikan piilihan bagaimana
memprosesnya.

Jika konflik versi ini tak dapat dipecahkan, dan Anda yakin bahwa hanya Anda yang , maka bras
PO. Maka Anda dapat mengupdate di CVS dari salinan lokal di mesin anda. Biasanya proses update
dilakukan setiap 24 jam sekali. Setelah itu setiap mengakses CVS akan mendapatkan versi yang telah
diupdate itu.
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Penerjemahan Dokumentasi

Informasi mengenai dokumentasi KDE dapat diperoleh di http://i18n.kde.org/doc/. Saat ini ada dua
perubahan penting pada dokumentasi KDE yaitu :

• Format dokumentasi tidak lagi SGML tetapi XML

• Proses penerjemahan sekarang dapat dilakukan dengan menggunakan berkas PO (seperti halnya
penerjemahan GUI)

Hal ini mengakibatkan semua berkas dokumentasi dikonversi ke format Unicode yaitu UTF-8. Telah pula
disedikaan stylesheet yang menghasilkan file Help KDE yang dapat dilihat baik dengan browser. Untuk
memprosesnya dibutuhkan stylesheet KDE dalam hal ini.

6.1 Prasyarat KDE Docbook SGML Markup

Beberapa hal perlu diperhatikan dalam penulisan KDE DocBook ini yaitu :

• Format ditentukan berdasarkan kemudahan dibaca dan isi, bukan format layout dokumen saja.
Bukan menjadi perhatian penulis untuk menentukan layout dari dokumentasi. Jika digunakan tag
yang sesuai dengan konten dari dokumentasi tersebut, maka program jade akan mengusahakan
dokumen akhir akan terlihat baik. Jangan mengganti tag DocBook yang tak sesuai menurut anda,
hanya karena menurut anda tampilan tersebut tidak baik. Sebaiknya gunakan white space untuk
membuat berkas DocBook lebih mudah terbaca oleh penulis. Jangan gunakan INDENT, kecuali
benar-benar perlu.

• Lakukan yang dapat menjamin bahwa anda memperoleh berkas DocBook yang benar.
Pemeriksa memang akan memeriksa berkas DocBook tetapi jika penulis melakukan hal ini maka
akan mempermudah kerja secara keseluruhan. Manfaatkan jade yang terinstall pada sistem anda
untuk memvalidasi berkas DocBook yang ditulis. Pemeriksa memang akan memvalidasi kesalahan
DocBook, tetapi harap ditekan serendah mungkin kesalahan ini dengan cara menulis berkas yang
valid. Jika ada jade diinstal beserta berkas yang dibutuhkannya, harap periksa dokumen dengan
cara menjalankannya. Sehingga dapat diyakinkan bahwa dokumen telah bebas dari kesalahan.

• Kata berbahasa non inggris harap diberi tag dengan cara sebagai berikut :

<foreignphrase lang="de">Wort</foreignphrase>.

• Penggaris-bawaan dan huruf besar seluruh kata harap jangan digunakan.

• Jangan menggunakan tanda petik dalam dokumentasi yang dibuat. Jika mengingkan suatu kata
diakhiri dengan tanda kutip maka letakkan di antar tag <quote> . Contoh :
This software is provided <quote>as is</quote>.
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• Ada tiga garis sambung yang berbeda yang sering ditemui dalam dokumentasi. Garis sambung
hypen yang menghubngkan dua atau lebih kata menjadi satu kata (misal mother-in-law). Garis
sambung ini dapat diketik langsung dari keyboard. Garis sambung en-dash digunakan untuk
memisahkan angka, tanggal dan lain-lain (Contoh : section 1-3 review basic concept). Garis sam-
bung en-dash dapat ditulis dengan menggunakan “&ndash;”. Garis sambung em-dash digunakan
untuk memisahkan kalimat atau menunjukkan sesuatu yang hilang. Tandai ini jarang digunakan
pada dokumentasi teknis, tetapi sering digunakan untuk menunjukkan suatu kalimat yang diputush
oleh kalimat lainnya. Untuk menulis garis sambung em-dash ini digunkan “&mdash;”.

• Ketika harus menentukan antara list bernomor dan list tak bernomor, dapat dilakukan dengan
bertanya pada diri sendiri “Apakah urutan dari list tersebut merupakna hal yang penting ?”, atau
“Jika saya ubah urutan list itu, apakah arti dari list akan berubah ?”. Jika jawabannya adalah
“Tidak” untuk pertanyaan tersebut, maka list yang digunakan adalah list tak bernomor (unordered
list)

• Semua tag <chapter> dan <sectN> harus diberikan atribute “id”. Atribute “id” dengan garis
sambung yang menghubungkan beberapa kata : <sect1 id="how-to-obtain-kapp">.

• Semua element harus memiliki tag penutup yang lengkap, kecuali jika element kosong.
Salah : <para/Blah blah/ atau <para>Blah blah</>
Benar : <para>Blah blah</para>

• Tak ada atribut yang diminimalkan
Salah : attribute=value atau attribute=’value’
Benar : attribute="value"

• Setiap entitas harus diakhiri dengna tanda titik koma (;)
Contoh :
%parameterentity;
&generalentity;

• Element GI (Kata pertama pada suatu tag) harus ditulis dengan huruf kecil.
Salah : <MediaObject> atau <MEDIAOBJECT>
Benar : <mediaobject>
Entiti bergantung pada huruf besar/kecil, sehingga kesalahan dalam penulisan akan menyebabkan
kesalahan validasi

• Pada bagian awal dokumen gunakan bentuk seperti ini :
<!DOCTYPE book PUBLIC "-//KDE//DTD DocBook V3.1-Based Variant V1.0//EN" [

<!ENTITY kappname "&knode;">

<!ENTITY % addindex "IGNORE">

<!ENTITY % English "INCLUDE" -- change language only here -->

<!ENTITY % ents PUBLIC "-//KDE//ENTITIES Documentation V1.0//EN">

%ents;

]> <book lang="&language;">

Ganti ”&knode;” dengan nama entiti dari aplikasi dan “English” dengan bahasa yang digunakan.
Dapat diatur penggunakan FDL licence dengan baris seperti berikut ini

<!ENTITY % FDLIS "INCLUDE">
<!ENTITY FDLISTitles "title 1, title 2, title 3">
<!ENTITY % FDLFCT "INCLUDE">

• &addindex; mengatur penyertaan indeks.

• Pada bagian akhir dokumen gunakan sesuatu seperti,
&underFDL; <!-- FDL licence for the documentation -->

&underGPL; <!-- GPL License for the application -- >

</chapter> &kdedocindex;

</book>
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Ganti &underGPL; jika aplikasi tersebut menggunakan lisensi lainnya. Lisensi dari dokumentasi
KDE selalu FDL. Entiti akan melakukan pengisian ditail keterangan lisensi tersebut. Untuk tiap
entiti lisensi ada 2 file. Satu link ke lisensi itu, dan lisensi itu sendiri. Dua file untuk tiap lisensi ini
berada pada kdelibs/ksgmltools/customization. Lisensi ini boleh diterjemahkan, tetapi versi
terjemahan harus berisi link yang mengacu kepada versi Inggris aslinya.

• Editor dokumentasi dapat meletakkan namanya pada <authorgroup> yang terletak pada bagian
awal dokumen dan di dalam bagian “Credit” pada bab akhir dari dokumen. Pada bagian
<authorgroup>, harus dituli sdengan menggunakan markup berikut ini:
<author>
<firstname>William</firstname>
<surname>Shakespeare</surname>
<affiliation>
<address><email>bill@eternity.net</email></address>
</affiliation>
<contrib>First draft</contrib>
</author>

Jangan gunakan tag <editor> . Penerjemah dapat menuliskan namanya pada <authorgroup>
di awal dokumen dan di bab “Credit” pada bagian akhir dokumen. Pada <authorgroup>, harus
ditulis dalam bentuk:
<othercredit role="translator">
<firstname>Thierry</firstname>
<othername>U.</othername>
<surname>Xenakis</surname>
<affiliation>
<address><email>tux@paradis.fr</email></address>
</affiliation>
<contrib>Traduction française</contrib>
</othercredit>
Kontributor lainnya dapat menggunakan model tag yang sama seperti penerjemah. Yaitu dengan
tag <othercredit> dan paa bagian “Credit” . Setiap kelompok tugas yang berbeda menggunakan
penunjuk <contrib> yang berbeda, misal translator, developer, graphist, musician dan
tester. Kata-kata ini tak dapat diterjemahkan, karena didefinisikan dalam DTD. Seperti pada
contoh, kata-kata yang terletak di antara tag yang akan ditampilkan pada pengguna.

• Tentukan copyright dan lisensi dalam <bookinfo> dengan format :
<copyright>
<year>1999</year>
<year>2000</year>
<holder>George N. Ugnacious</holder>
</copyright>
<legalnotice>&FDLNotice;</legalnotice>
Setiap tahun ketika dokumentasi diubah, maka pernyataan hak cipta harus diperbaharui (misal
dengan menambah tahun atau pengarang, bila terjadi perubahan pengarang).

• Tentukan tanggal dan versi aplikasi dengan format :
<date>2000-12-31</date>
<releaseinfo>1.02.03</releaseinfo>
<date> merupakan tanda terakhir kali dokumen diperbaharaui. <releaseinfo> selalu sama de-
ngan nomor versi dari program aplikasi yang diterangkan pada dokumentasi. Suatu dokumentasi
terjemahan selalu memiliki <date> dan <releaseinfo> yang sama dengan dokumen asli dalam
bahasa Inggris. Perlu diperhatikan ini merupakan mekanisme untuk mengelola proses penulisan
dan penerjemahan.

• Daftar entitas untuk aplikasi dikelola secara terpusat. Nama entitas yang muncul pada nama apli-
kasi semuanya tertulis dalam huruf kecil. Bila nama yang dibutuhkan belu mada, maka dapat
mengirimkan email kepada kde-docbook@kde.org atar ditambahkan. Untuk kebutuhan validasi
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ketika program tersebut masih baru, maka dapat ditambahkan pada prolog dari dokumen. Tetapi
ketika mengumpulkan dokumen tersebut, penambahan ini harus dihilangkan dari prolog dari doku-
men.

• Untuk entitas yang tidak spesifik untuk suatu bahasa, maka digunakan dtd/kde-genent.entities
dan untuk entitas yang sepsifik utnuk bahasa tertentu digunakan lang/user.entities. Jangan
sampai terjadi ketidak sesuaian dengan entitas KDE yang telah ada.

• Berkas en/user.entities sebaiknya diperbaharui dengan mengingat bahwa penerjemahan
dimungkinkan. Berikut ini diberikan contoh bagaiman suatu penerjemahan dapat dikelola. &LMB;
adalah suatu entitas yang merupakan kependekan dari ”Left Mouse Button” . Ketika diter-
jemahkan ke bahasa Prancis, maka jangan hanya menerjemahkan isi entitas itu, tetapi juga nama
entitas ke &BGS (atau &bgs), untuk menggambarkan perubahan dari kata-kata aslinya :
<!ENTITY "LMB" "left mouse button">
Menjadi
<!ENTITY "BGS" "bouton gauche de la souris">
Bahasa yang memiliki perubahan bentuk kata benda seperti bahasa Jerman atau Rusia, dapat
menggunakan model seperti ini :

<!ENTITY "LMT-n" "linke Maustaste">
<!ENTITY "LMT-d" "linken Maustaste">

• Jika dirasa ada suatu element yang tidak cocok, maka dapat digunakan atribute “role”. Tetapi
harap kontak tim DocBook untuk melakukan perubahan sehingga dokumen tidak menjadi invalid.

• Gunakan <qandaset> untuk FAQ , jangan gunakan <itemizedlist>. Bagilah FAQ menjadi be-
berapa bab, atau seksi. Jika file FAQ menjadi terlalu besar, hal ini biasanya tidak disukai oleh
pengguna.

• Singkatan dan akronim harus ditandai dengan suatu tag juga. Gunakan tag DocBook <abbrev> dan
<acronym> untuk singkatan dan akronim. Bedakan di antara keduanya, akronim adalah sesuatu
seperti GUI, KDE, sementara singkatan seperti dll, mis, hlm.

• Gunakan <glossterm> atau <firstterm> setiap kali menggunakan suatu terminologi baru.

• Ingatlah bahwa tanda ’$’ ditimbulkan oleh shell, dan bukan bagian dari nama variabel environment
:
ls -l $KDEDIR

<userinput>

<command>ls</command>

<option>-l</option>

<parameter>$<envar>KDEDIR</envar></parameter>

</userinput>

export KDEDIR=/usr/local/kde

<userinput>

<command>export</command>

<parameter><envar>KDEDIR</envar>=<filename>/usr/local/kde</filename></parameter>

</userinput>

• Hanya gunakan <ulink> untuk URL, jangan untuk link pada file (berbeda dengan <A> dalam
HTML) juga jangan untuk email.

• Elemen <graphic> dan <inlinegraphic> tidak digunakan lagi. Ubah bentuk seperti ini :
<graphic fileref="flowers.png"></graphic>
menjadi

<mediaobject>
<imageobject>
<imagedata format="PNG" fileref="flowers.png"></imagedata>
</imageobject>
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<imageobject>
<imagedata format="EPS" fileref="flowers.eps"></imagedata>
</imageobject>
<textobject>
<phrase>Flowers as they usually get offered</phrase>
</textobject>
</mediaobject>

• Elemen <beginpage> dan <bridgehead> tak diperbolehkan dan telah dihilangkan dari DTD yang
digunakan untuk KDE. <revisionhistory> juga telah dihilangkan.

6.2 Konversi dari format SGML ke XML/PO Format

Format dokumentasi KDE telah mengalami beberapa perubahan. Awalnya menggunakan HTML, lalu
LinuxDoc SGML untuk KDE 1.x dan lalu dikonversi menjadi DocBook SGML untuk KDE 2.0. TApi satu
hal yang selalu menjadi permasalahannya adalah masih stimbul kesulitanbagi penerjemahn untuk menja-
ga agar pekerjaan penerjemahan tersinkronkan dengan pengembangan perangkat luak aslinya. Sehingga
seringkali akhirnya pekerjaan penerjemahan dokumentasi ini berhenti. Di samping itu penggunaan for-
mat SGML membutuhkan berbagai perangkat lunak tambahan yang kompleks dengan keterkaitan dan
parameter yang rumit dan tidak mudah. Karena KDE berkembang dan makin tersebar. maka per-
masalahan dengan terbatasanya pengkodean SCII mulai timbul, sehingga dokumentasi KDE sekarang
menggunakan XML dan Unicode (saat ini dengan UTF-8).

Untuk membuat dokumentasi lebih mudah dirawat, maka berkas sumber (source) dikonversi ke
format PO. Format ini telah digunakan oleh penerjemah GUI dengan sukses. Matthias Kiefer telah
memberikan kontribusi untuk menambah kemampuan KBAbel sehingga dapat melakukan tugas ini (misal
dengan modus warna untuk perbedaan teks, database penerjemahan, penanganan extended line feed).
Sehingga bisa dikatakan KBabel adalah suatu keharusan bukan saja bagi penerjemah GUI tapi juga bagi
mereka yang menerjemahkan dokumentasi. Stephan Kulow telah membuat sehingga KDE Help Center
dapat memparsing berkas XML langsung dan menghasilkan berkas HTML secara langsung.

Demikianlah latar belakang dari proses penerjemahan dokumentasi ini. Berikut ini keterangan
mengenai proses penerjemahan dokumentasi itu. Jika dokumentasi yang ditulis masih dalam bentuk
SGML maka perlu dibaca keterangan berikut ini yang menerangkan bagimana melakukan konversi berkas
tersebut. Jika koversi tersebut telah dilakukan maka bagian ini dapat dilewati.

Untuk proses konversi, dibutuhkan berkas DocBook dari dokumentasi yang lama
(TRANSLATED.docbook) dalam format SGML dan berkas docbook dalam bahasa Inggris yang sesuai
(ENGLISH.docbook). Sangat penting bahwa kedua berkas tersebut cocok satu sama lain,. Jika berkas ini
belum ada maka dapat diperiksa versi lama dari CVS.

• Juga dibutuhkan beberapa program untuk melakukan konversi. Stephan Kulow telah menyediakan
program ini dalam paket kdesdk.

• Sebagai tambahan juga dibutuhkan program iconv yang biasanya telah disertakan pada distribusi
Linux. Program ini digunakan untuk melakukan konversi berkas, dari suatu encoding ke encoding
lainnya. Untuk mengetahui encoding yang didukung oleh program ini dapat dilakukan dengan
pemanggilan “iconv --list”.

• Program lainnya yang dibutuhkan adalah msmerge yang tidak termasuk pada module kdesk tetapi
merupakan bagian dari paket gettext. Program ini dibutuhkan untuk melakukan pekerjaan dengan
berkas PO.

PENTING : sebelum melakukan konversi harus dilakukan perubahan entitas dari karakter dan disesuaikan
dengan encoding yang tepat untuk konversi ke UTF-8. Sebagai contoh untuk penerjemahan bahasa
Jerman maka entitas &auml; ke karakter dalam bahasa Jerman “ä”. Jelas hal ii tidak begitu penting
untuk pekerjaan penerjemahan bahasa Indonesia.

Pertama kali lakukan konversi dari encoding yang ada ke UTF-8 ;
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iconv -f YOUR ENCODING -t utf8 ENGLISH.docbook
iconv -f YOUR ENCODING -t utf8 TRANSLATED.docbook

Kemudian dilakukan koreksi markup, sebab XML pada beberapa hal lebih ketat daripada SGML :

fixsgml ENGLISH.docbook
fixsgml TRANSLATED.docbook

Lalu sekarang bisa dilakukan konversi ke XML

xmlizer ENGLISH.docbook >ENGLISH.xml
xmlizer TRANSLATED.docbook >TRANSLATED.xml

Pada tahap ini perpindahan ke XML telah selesai. Sekarang dokumentasi baru perlu diperiksa benar
atau tidaknya sintaks, untuk itu dilakukan ;

checkXML ENGLISH.xml
checkXML TRANSLATED.xml

Kemudian dokumentasi bahasa Inggris dipecah menjadi msgid dalam berkas POT ;

xml2pot ENGLISH.xml >ENGLISH.pot

Setelah itu dokumentasi yang diterjemahkan dipesah menjadi msgstr dalam berkas PO :

split2po ENGLISH.xml TRANSLATED.xml >TRANSLATED.po
msgmerge -o TRANSLATED.po TRANSLATED.po ENGLISH.pot

Selesailah proses konversi ini, langkah yang penting adalah pemanggilan split2po. Jika markup berbeda,
maka pesan kesalahan (error) akan diberikan). Ada dua hal yang penting diperhatikan :

• Credit untuk translator perlu dihilangkan dari TRANSLATED.xml sebelum memanggil split2po,
sebab bagian ini tidak ada di dokumentasi bahasa Inggris, sehingga akan menghasilkan ketidak-
cocokan. Dalam berkas TRANSLATED.po akan ditemukan 2 msgid, yang dapat diisi dengan
credit dengan markup yang sesuai (perhatikan keterangan beriku tini). msgid itu adlah
ROLES OF TRANSLATOR dan CREDIT FOR TRANSLATORS.

• Beberapa kelompok penerjemah sering menerjemahkan ID pada dokumen (ID digunakan untuk
menandai seksi, bab dan lainnya dalam berkas DocBook). split2po akan mencoba mencocokkan
ID yang cocok dan akan gagal karena ID yang diterjemahkan ini (misal id=introduction jangan
diterjemahkan menjadi id=pengantar). Untuk itu dapat diberikan perintah agar split2po tidak
memeriksa ID ini bila variabel environment diset REPORT MISMATCHES=no. Sehingga perintah baris
(command line) akan menjadi :

REPORT MISMATCHES=no split2po TRANSLATED.xml ENGLISH.xml >TRANSLATED.po

Keluaran dari split2po (konversi dokumen yang tidak sinkron antara TRANSLATED.xml dan
ENGLISH.xml). Keluaran dari spli2po sebagai berikut :

id="knode-article-cleanup" not in the same paragraphs (245 vs 233)

id="anc-knode-article-cleanup" not in the same paragraphs (246 vs 0)

id="subscribing" not in the same paragraphs (269 vs 249)

id="anc-subscribing" not in the same paragraphs (270 vs 0)

id="fetch-group-list" not in the same paragraphs (271 vs 251)

id="fetch-and-read-news" not in the same paragraphs (251 vs 271)

id="anc-fetch-and-read-news" not in the same paragraphs (311 vs 0)
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id="post-and-mail-news" not in the same paragraphs (390 vs 359)

id="anc-post-and-mail-news" not in the same paragraphs (391 vs 0)

id="more-knode-features" not in the same paragraphs (453 vs 417)

id="using-filters" not in the same paragraphs (454 vs 418)

id="anc-using-filters" not in the same paragraphs (455 vs 0)

id="knode-editor-advanced" not in the same paragraphs (463 vs 427)

id="anc-knode-editor-advanced" not in the same paragraphs (464 vs 0)

id="supersede-and-cancel" not in the same paragraphs (497 vs 459)

id="anc-supersede-and-cancel" not in the same paragraphs (498 vs 0)

Bila diperhatikan lebih ditail :

id="knode-article-cleanup" not in the same paragraphs (245 vs 233)

Hal itu berarti hingga section terakhir dengan id (biasanya sect2, sect1, chapter, appendix) se-
muanya benar. Tetapi ada beberap paragraf tambahahan (pemisahan biasanya terjadi pada tag <para>,
<listitem> atau seperti itu). Maka diperoleh 12 paragraf tambahan pada berkas yang pertama
(ENGLISH.XML) yang telah terhapus pada saat pembuatan berkas po. Maka buatlah cadangan (back-
up), lalu isi kembali paragraf tersebut dengan membuat berkas pot dan menjalankan msgmerge pada
berkas po yang dihasilkan, sehingga tak ada paragraf yang hilang.

Perhatikan baris kedua :

id="anc-knode-article-cleanup" not in the same paragraphs (246 vs 0)

Hal itu menunjukkan bahwa suatu tag dengan nama “id” pada berkas pertama (ENGLISH.XML) tapi tak
ada pada berkas kedua. Pada kasus ini nama yang diberikan adalah petunjuknya, ini berarti id dari suatu
tag achor yang hanya dibutuhkan disalin dari berkas kedua. Jika id adalah untuk suatu chapter, sect1,
atau sect2, hal itu berarti seluruh section bukan merupakan bagian dari berkas kedua. Sehingga Anda
perlu menghapus seluruh section dari berkas pertama untuk membuat kedua berkas cocok.

Sekarang lihat kasus lainnya ;

id="fetch-group-list" not in the same paragraphs (271 vs 251)

id="fetch-and-read-news" not in the same paragraphs (251 vs 271)

Dua section in itelah diganti dalam berkas kedua (TRANSLATED.XML)
Untuk melakukan perbandingan, ada beberapa perangkat bantu yang dapat digunakan :

• kate, sangat berguna untuk membandingkan 2 berkas. Jika 2 berkas dibuka dengan kate maka
akan ditampilkan terbagi secara vertikal sehingga dua berkas ini atas-bawah. Juga memiliki modus
pewarnaan (highlight) untuk XML, sehingga mudah melakukan indentifikasi bagian manakah yang
perlu dihapus.

• Untuk membandingkan struktur dua berkas XML dapat digunakan skrip sgmldiff, yang akan
menghasilkan perbedaan struktural dari 2 berkas XML. Hal ini sangat membantu untuk mengi-
dentifikasi paragraf manakah yang telah ditambah atau dihapus. Keluaran dari program ini cukup
ditail sehiningga mudah dilihat. Sebagian besar perbedaan tak mempengaruhi proses konversi
terutama untuk tag <PARA>

Setelah tahapan ini maka telah didapatkan berkas PO. Berkas PO hasil ini kini dapat diletakkan di
CVS. Ketika proses penggabungan otomatis berikutnya, maka akan digabung dengan berkas PO ini akan
digabung dengan berkas PO yang telah ada dan berkas POT bahasa Inggris. Dengan cara ini maka berkas
PO dapat sinkron dengan berkas aslinya. Berkas baru akan muncul sebagai string yang “untranslated”
dan “fuzzy”. Sampai tahap ini proses konversi telah selesai dan pekerjaan dapat dilakukan dengan format
baru ini.
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6.3 Prasyarat umum penerjemahan Doc

Seperti diterangkan sebelunya, bahwa dokumentasi dan online-help dari program KDE sekarang ditulis
semuanya dengan format XML (eXtensible Markup Language). Format ini memungkikan definisi markup
melalui suatu DTD (Document Type Definition). Suatu DTD menentukan element dari suatu dokumen
dan urutannya. Salah satu contoh DTD adalah HTML, contoh lainnya adalh LinuxDoc dan yang lainnya
lagi adalah DocBOok yang merupakan dasar dari KDE DTD. DocBook telah digunakan secara luas
sebagai standard untuk dokumentasi teknis.

Salah satu keuntungan dari DocBook SGML adalah kemampuannya (dengan XML menjadi makin
simple) dalam melakukan konversi dari satu format markup ke format lainnya, misal dari XML ke HTML
atau PostScript.Bila telah pernah bekerja dengan bahasa penanda (markup language) seperti HTML atau
LATEXmaka dengan XML tidaklah menjadi masalah. Bila Anda belum pernah menggunakannya sebaiknya
mempelajari dasar pengetahuan markup language ini. Informasi lanjutan akan diterangkan juga pada
buku ini.

Software yang dibutuhkan untuk membuat dokumentasi :

• KBabel buatan Matthias Kiefer, sama dengan yang digunakan untuk penerjemahan GUI. Program
ini dikembangkan pada KDE 2 dan merupakan bagian dari module kdesdk. Telah mendukung
UTF-8 yang dibutuhkan pada dokumentasi dan on-line help.

• Untuk screenshot, dapat digunakan program seperti KSnapshot (dari paket kdegraphics) atau xv

• Juga disarankan untuk memiliki program untuk memeriksa sintaks dari penerjemahan dokumentasi
yang telah selesai. Untuk itu dibutuhkan “meinproc” buatan Stephan Kulow. Parser ini bagian
dari modul kdelibs.

• Parser meinproc membutuhkan pustaka (library) libxml2. Versi saat ini untuk libxml2 ada dalam
paket kdesupport yang merupakan paket untuk KDE. Seperti halnya kdelibs, maka paket ini
biasanya telah ada pada sistem KDE yang diinstal. Jika tidak, maka dapat didownload dari
ftp.xmlsoft.org. Sangat dibutuhkan versi terbaru dari pustaka ini, sebab beberapa fitur yan
dibutuhkan. Jika yang diinstal adalah libxml2 dari paket biner, maka dibutuhkan linuxml2 dan
libxml2-devel

• Lalu dibutuhkan po2xml. Program ini akan membaca berkas po dan menghasilkan berkas dokumen
XML. Program ini merupakan bagian dari paket kdesdk.

Program-program tersebut sangat membantu proses penerjemahan (terutama ketika harus mencari dan
memperbaiki string yang masih bersifat “fuzzy” dan “untranslated”). Proses perbandingan antar
berkas baru dan lama juga akan dipermudah, pemeriksaan sintaks, dan alur akan lebih mudah.

6.4 Berkas POT dan PO untuk dokumentasi

Berkas yang perlu diterjemahkan adalah dalam bentuk format Unicode (UTF-8) dengan akhiran .pot dan
po. Pemisahan ini untuk memudahkan penerjemah. Pada berkas aslinya, dokumentasi bahasa inggris
disertakan pada berkas DocBook. Setiap kali penulis dokumentasi memberikan hasilnya ke CVS maka
program xml2pot akan mengekstrak kata-kata yang dapat diterjemahkan dari berkas yang bersangkutan.
Lalu menulis kata tersebut ke dalam berkas POT. Cara membuat berkas POT ini tak berbeda dengan
berkas penerjemahan GUI.

Berkas POT berbahasa Inggris adalah modal utama untuk penerjemah untuk menghasilkan tiap
berkas PO dari tiap berkas POT. Berkas PO ini yang menyediakan string yang diterjemahkan, dan
dengan program po2xml menghasilkan berkas DocBook. po2xml secara berkala dijalankan pada server
i18n.kde.org. Jika seorang pengguna KDE memiliki set lengkap bahasa untuk KDE misal “German”
atau “Icelandic”, dan membuka KDE Help Center, maka berkas DocBook terjemahan ini akan diproses
oleh help ioslave buatan Stephen Kulow dan menghasilkan berkas HTML yang tampil di layar. Proses
pembuatan berkas DocBook hasil terjemahan dari po2xml ini mensyaratkan berkas PO harus benar
sintaksnya.
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Anda dapat memperoleh dokumentasi DocBook bahasa Inggris dalam subdirektori dari kode pro-
gram (source code) dari paket program yang bersangkutan. Berkas POT dan berkas PO yang diter-
jemahkan serta berkas DocBook untuk semua bahasa terletak pada paket KDE yang diberi nama
kde-i18n. Untuk paket “EXAMPLE” dapat ditemukan

• Berkas POT pada direktori kde-i18n/templates/docs/(EXAMPLE).

• Berkas PO yang diterjemahkan pada direktori
kde-i18n/$LANGUAGE/messages/docs/(EXAMPLE)/

• Berkas dokumentasi bahasa Inggris diperoleh di direktori (EXAMPLE)/doc/. Berkas ini dibutuhkan
untuk menghasikan berkas DocBook terjemahan.

• Dokumentasi yang diterjemahkan (dalam format DocBook) pada direktori
kde-i18n/$LANGUAGE/docs/(EXAMPLE)

Arsip semua berkas dari paket kde-i18n (termasuk berkas dokumentasi XML) dapat ditemukan diper-
oleh di
ftp://ftp.kde.org/pub/kde/unstable/CVS/snapshots/current/. Berkas ini sangat besar, se-
bab berisi semua terjemahan lebih dari 50 kelompok bahasa (walau tidak semua telah mener-
jemahkan dokumentasi). Anda bisa menemukan tiap paket untuk tiap bahasa dengan nama
kde-i18n-NN.tar.bz2, “NN” adalah singkatan dari bahasa. Arsip yang sama dapt juga diperoleh di
i18n.kde.org/translation archive. Berkas tersebut dapat juga didownload melalui CVS, CVSUP,
atau WebCVS.

6.5 Hal penting penerjemahan dokumentasi

Claudiu Costin telah membuat suatu skrip untuk menyajikan statistik dokumentasi harian. Halaman
ini akan memberikan keterangan singat tentang dokumenasi yang ada pada tiap bahasa, dan statusnya
(kuno, atau terbaru). Statistik ini berisi hanya dokumnetasi yang telah lengkap diterjemahkan, hal ini
sebab secara gampang statistik ini diperoleh dengan cara membandingkan berkas DocBook. Berkas ini
dihasilkan oleh po2xml hanya jika berkas PO telah berisi terjemahan yang lengkap (tidak ada sting yang
bersifat fuzzy atau untranslated)

Bila pada sistem lokal ada kode program (source code) kde-i18n maka Catalog Manager dari KBabel
akan berisi informasi yang lebih banyak lagi. Karena transisi ke berkas PO untuk terjemahan dokumentasi
belum lengkap, maka beberapa dokumentasi saat ini masih kosong

Jika ingin menerjemahkan dokumenasi baru yang belum diterjemahkan sebelumnya, berikut ini akan
dijelaksan langkah demi langkah. Juga diberikan sedikit informasi mengenai bagiamana cara menjaga
agar dokumentasi selalu terjaga. Perubahan dari format SGML ke format baru XML sifatnya sangat
khusus sehingga akan diberi penjelasan berikut.

Suatu dokumentasi yang ditulis dalam format SGML dapat ditandai pada bagian headernya, yang
dimulai dengan :

<!DOCTYPE book PUBLIC "-//KDE//DTD DocBook V3.1-Based Variant V1.0//EN" [

Sedangkan dengan XML, berkas DocBook akan dimulai dengan

<xml version="1.0" ?>

Informasi tentang status dokumentasi dapat dibaca pada situs :
http://i18n.kde.org/doc/current.html. Sebaiknya antar penerjemah dilakukan pembagian peker-
jaan, sehingga satu paket dikerjakan oleh hanya satu orang.
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6.6 Langkah penerjemahan dokumentasi

Penjelasan berikut ini mengasumsikan bahwa Anda telah terbiasa dengan struktur dan sintaks berkas
DocBook. Untuk informasi lebih lanjut tentang format ini dapat dilihat pada situs dokumentasi. Pada
umumnya, KBabel harus diinstal dan terjemahkan berkas PO seperti yang telah dijelaskan pada bagian
GUI. Sebagai tambahan dibutuhkan juga versi terbaru dari direktori
kde-i18n/templates/docs/, kde-i18n/$LANGUAGE/messages/docs/ dan (PACKAGE)/doc/ dari server
CVS.

PENTING : Karena standard, format selalu berubah, maka penting bagi para penerjemah untuk
mengikuti mailing list kde, dan memperhatikan pengumuman soal ini.

• Jika memulai KBabel pertama kali, maka akan ditanyakan beberapa keterangan pengguna yang
harus diberikan secara benar. Dari informasi ini header dari berkas PO akan secara otomatis
dihasilkan. Ingatlah untuk mengatur Setting -> Configure KBabel ...Preferences -> Save
-> Encoding;: Default ke UTF-8 (8 bit Unicode Transfer Format). Sebagai tambahan harus
juga diisikan path ke berkas PO untuk Catalog Manager, dan juga aktifkan Preferences -> Edit
the Show surronding quotes on the Apperance tab sebab jika tidak maka spasi pada akhir baris tak
terlihat.

• Pertama kali setelah menjalankan KBabel, adalah harus memulai Catalog Manager dari menu
Tools -> Catalog Manager ... Maka Catalog Manager menampilkan dokumen manakah yang
perlu dikerjakan (fuzzy, unstranslated dan program). Agar ini dapat berfungsi, maka perlu didap-
atkan salinan terbaru dari direktori kde-i18n/templates/docs/ dan
kde-i18n/$LANGUAGE/messages/docs/, Juga harus diisikan path ke berkas-berkas ini pada pen-
gaturan (setting) KBabel.

• Jika Catalog Manager menunjukkan tak ada terjemahan pada program tersebut (misal tak ada
berkas PO yang sesuai pada
kde-i18n/$LANGUAGE/messages/docs/(PACKAGE), dan memang hanya karena ini. Maka double
klik lah berkas POT akan dimuatkan ke editor dan disimpan dengan akhiran PO pada direktori
yang sama dimana berkas itu tidak ada, yaitu
kde-i18n/$LANGUAGE/messages/docs/(PACKAGE)/(PROGRAM).po.

• KBabel melakukan hal ini secara otomatis jika dilakukan pembacaan berkas dari Catalog Manager
dan kemudian menyimpannya. Yang harus perlu dilakukan adalah pastikan bahwa telah diisikan
nama path yang benar pada Settings -> Configure KBabel ... pada dialog di Catalog Manager

• Mulai saat ini yang perlu diedit adalah berkas PO untuk program ini. Pekerjaan utama pener-
jemahan adalah mengubah dan menjaga agar dokumen terjemahan tetap terbaru (dalam bentuk
berkas PO)

• Maka sekarang tinggal menerjemahkan string dengan tanda untranslated, dan memeriksa string
sudah diterjemahkan tapi ditandai sebagai “fuzzy”. Untuk memperbaiki fuzzy ini KBabel memiliki
“diff mode”. Pada modus ini (untuk pekerjaan perbaikan, sebaiknya modus ini selalu dihidupkan -
on), bagian baru dan terhapus dari msgid akan diterangi (highlight), Untuk pekerjaan ini, KBabel
menjaga database terjemahan dimana secara otomatis akan meyimpan msgid yang diterjemahkan
dan msgstr. Segera setelah dilakukan perubahan msgstr tanda “fuzzy” akan hilang. Jika dipu-
tuskan bahwa msgstr tidak diubah dan tidak dianggap fuzzy lagi, maka hapuslah tanda “fuzzy”
dengan cara menekan Ctrl+U. Ini penting, sebab berkas DocBook hanya akan bisa dihasilkan bila
berkas PO sudah 100% diterjemahkan.

• Jika direktori dokumentasi dari program berisi screen shot, maka perlu dihasilkan versi bahasa
tersebut (dengan GUI yang telah diterjemahkan). KSnapshot merupakan perangkat bantu yang
dapat dipakai. Memakai program apa saja tidak menjadi masalah, yang penting harus disimpan
dalam berkas PNG. Harus digunakan disain standard KDE untuk screen shot. Bentuk screen
yang tidak biasa akan membuat bingung pengguna. Gambar GUI yang telah diterjemahkan harus
disimpan dengan nama berkas yang sama seperti dokumen aslinya pada direktori DocBook yang
telah diterjemahkan sesuai dengan direktori dokumenasi bahasa Inggris (bukan direktori berkas
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PO). PENTING : Screen shot tak diperbolehkan dalam format GIF. Harus dalam format PNG.
Untuk informasi mengenai berkas PO dan penerjemahannya dapat dibaca pada bagian GUI

6.7 Kesulitan dan hal khusus

Linebreak (pembatas garis) tak memiliki pengaruh dalam pengaturan format Docbook. Dapat disisipkan
pembatas garis ini dimanapun saja. Tetapi perlu diingat harus diletakkan spasi pada akhir dari baris.
Sebagai contoh :

"... volume of your"
sound card."

Harus ditulis sebagai :

... volume of yoursound card.

Antara <keyword> dan </keyword> hanya teks yang diperbolehkan, sebagai contoh <keyword> &kmidi
</keyword> adalah tidak benar. Harus ditulis sebagai <keyword> kmidi </keyword>

• Screenshot harus selalu menunjukkan penampilan dari GUI dari aplikasi terbaru

• Sebagai saran : jangan terjemahkan kata demi kata atau kalimat demi kalimat. Tetapi coba tangkap
artinya, baca bagian tersebut secara lengkap, dan terjemahkan.

6.7.1 Tag tambahan untuk penerjemah

Sebagai tambahan pada fungsi “#” dan “.” ada beberapa hal yang penting :
Ada dua “msglds” yang ditujukan untuk penerjemahan dokumentasi. Keduanya tidak penting

untuk dokumentasi dalam bahasa Inggris, yaitu
CREDIT FOR TRANSLATOR dan ROLES OF TRANSLATORS. Keduanya digunakan untuk meletakkan nama dan
alamat email. Penting untuk diketahui, bahwa msgstr ini memiliki markup yang khusus yang dibuat
agar cocok untuk konteksnya. Berikut ini adalah contoh dari 2 translator yang berbeda.

msgid "CREDIT FOR TRANSLATORS"

msgstr ""

"<para>Translation FIRSTNAME1 LASTNAME1 "

"<email>EMAILADDRESS1<email></para>"

"<para>Correction of the Translation FIRSTNAME2 LASTNAME2 "

"<email>EMAILADDRESS2</email></para>"

dan

msgid "ROLES OF TRANSLATORS"

msgstr ""

"<othercredit "

"role=\"translator\"><firstname>FIRSTNAME1</firstname><surname>LASTNAME1</surname>"
"<affiliation><address><email>EMAILADDRESS1</email><address></affiliation>"

"<contrib>Translation</contrib></othercredit>"

"<othercredit "

"role=\"translator\"><firstname>FIRSTNAME2</firstname><surname>LASTNAME2</surname>"
"<affiliation><address><email>EMAILADDRESS2</email><address></affiliation>"

"<contrib>Correction of the Translation</contrib></othercredit>"

Pada KBabel tanda kutip (“) memiliki arti khusus. Dengan kata lain harus dibutuhkan pada beberaap
tempat dalam markup atau teks biasa. Pada kasus ini maka harus diawali dengan tanda “\”, Pada contoh
di atas dapat dilihat :
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"...role=\"translator\"...

bukan ditulis sebagai

"... role="translator"...

KBabel membantu hal ini sebab jika Anda menekan tanda kutip pada keyboard, maka KBabel sebenarnya
menyisipkan “\” sebelum tanda kutip secara otomatis.

Karakter “&” pada msgid digunakan pada terjemahan GUI untuk menandai tombol penyingkat pa-
da isian menu. Untuk membantu proses penerjemahan KBabel akan menyoroti (highlight) msgstr sebagai
isian yang salah, bila karakter yang digunakan tidak seimbang antara msgid dan msgsr (sebetulnya KBa-
bel mencoba menebak apakah Anda menerjemahkannya seimbang, tetapi seringkali tak tersedia informasi
yang cukup untuk menebak hal ini). Berbeda dengan penerjemahan menu, pada penerjemahan dokumen-
tasi keseimbangan antara msgstr dan msgid tidak begitu penting, sehingga fungsi pemeriksaan ini dapat
dimatikan dari menu (Settings->Configure KBabel... and Edit, General, Change text color
on error).

6.7.2 Organisasi dan sintaks

Jika dokumenasi kehilangan sesuatu, atau tidak up-to-date dengan GUI yang diguakan, maka sebaiknya
penulis program dikontak, tanyakan tentang bagian yang hilang pada dokumentasi aslinya. Bila penulis
program tak dapat dikontak, maka dapat dikontak koordinator dokumentasi. Memang kecil kemungkinan
yang ada antara terjemahan dan berkas asli dalam bahasa inggris. Karena dalam proses penghasilan
berkas PO untuk penerjemahan dokumentasi digunakan berkas bahasa Inggris sebagai patokan. Sehingga
struktur dari dokumen harus selalu sesuai dengan versi Inggris. Bila anda ingin menambah satu paragraf,
maka sebaiknya ditanya terlebih dahulu kepada penulis dokumentasi asli. Sehingga akan diberikan msgid
tambahan untuk diterjemahkan.

Untuk hal khusus, ada kemungkinan dilakukannya penambahan paragraf yang hanya ada di doku-
mentasi terjemahan, tettapi tak ada di dokumentasi aslinya. Tetapi hal ini harus dilakukan dengan ekstra
hati-hati. Ada 2 msgid yang merepresentasikan teks yang tak ada dalam dokumentasi bahasa Inggris.
Keduanya adalah CREDIT FOR TRANSLATOR dan ROLES OF TRANSLATOR. Kedua msgid ini dihasilkan oleh
komentar khusus pada dokumentasi bahasa Inggris. Anda dapat menemui baris :

<!-- TRANS:CREDIT FOR TRANSLATORS -->

dan

<!-- TRANS:ROLES OF TRANSLATORS -->

Keduanya adalah komentar XML dan tidak ditampilkan dalam dokumentasi bahasa Inggris. Tetapi
spli2po akan menghasilkan msgid untuk 2 komentar ini dan po2xml akan mengisikan msgstr ke doku-
mentasi terjemahan. Kemampuan ini dapat diunakan untuk menambah paragraf yang hanya dibutuhkan
oleh dokumentasi terjemahan. Setiap komentar dalam dokumentasi bahasa Inggris akan menjadi sebuah
msgid. PENTING : Harus sangat diperhatikan untuk penggunaan markup yang benar, sehingga msgstr
yang diterjemahkan cocok dengan konteksnya.

Sebaiknya bekerjasama sebaik mungkin dengan penerjemah GUI. Selalu pastikan bahwa istilah yang
digunakan pada GUI sama dengan dokumentasi.

Untuk nama program, maka gunakan entitiy yang didefinisikan untuk program ini. Misal program
KApp akan memiliki entity yang terdefinisikan sebagai &kapp;. Harus selalu digunakan entity ini untuk
memastikan bahwa nama ditulis dengan cara yang konsisten.

Screen shot dan gambar lainnya harus dalam format PNG (Portable Network Graphics). Format
GIF tak dipakai lagi karena permasalahan lisensi.
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6.7.3 Style

Setiap tim penerjemahan sebaiknya memiliki panduan dasar gaya penerjemahan, menentukan pengguna
dan sebagainya. Istilah teknis dari GUI harus diterjemahkan secara konsisten (seperti tombol, menu
dan sebagainya). Untuk membantu ini kamus visual pada KDE Help Center sebaiknya digunakan. Jadi
setiap kali suatu bagian diterjemahkan, maka sebaiknya terminologi itu digunakan secara konsisten untuk
semua penerjemah pada bahasa tersebut.

KBabel memiliki database terjemahan. Database ini mengumpulan seluruh msgid dan msgtr yang
diterjemahkan untuk membantu proses penerjemahan. Mungkin akan membantu bila seluruh penerjemah
memasukkan hasil terjemahannya ke dalam databse ini. Juga perlu dijaga konsistensi (Setting ->
Configure Dictionary -> Translation database)

Ada juga Kamus KDE yang berbasiskan Web yang dapat digunakan untuk membantu proses pe-
nerjemahan.

6.8 Memeriksa dan mengumpulkan hasil

Ada dua hal yang harus diperiksa ketik selesai menerjemahkan dokumentasi, yaitu ejaan dari kata dan
sintaks dari markup XML.

Untuk memeriksa ejaan pada bahasa tertentu dapat digunakan penguji ejaan pada KBabel (Tools
-> Spelling -> Spell check ...). Penguji ejaan ini harus dikonfigurasi melalui dialog Preferences
(Settings -> Configure KBabel ...)

Untuk memeriksa sintaks XML, maka harus dihasilkan XML terjemahan, (DocBook) dari berkas
PO. Setelah itu dapat diperiksa sintaks dari berkas DocBook ini dengan menggunakan parser XML.
Paling tidak ada 2 kemungkinan untuk melakukannya tergantung apakah ada berkas dokumentasi atau
bagian yang dibutuhkan dari seluruh kode program dokumentasi dari bahasa yang diterjemahkan

Jika dimiliki hanya bagian yang dibutuhkan (bagian di mana berkas PO yang akan diperiksa dis-
impan ) dari kode program paket kde-i18n dari bahasa tersebut dan bagian doc dari kode program dari
paket yang diterjemahkan (bagian di mana berkas DocBook bahasa Inggris untuk berkas yang akan
diperiska disimpan) maka dapat digunakan skrip update xml. Untuk ini juga dibutuhkan po2xml pada
path yang digunakan, karena akan dipanggil oleh skrip update xml. Skrip ini akan menghasikan berkas
DocBook dari berkas PO untuk bahasa tersebut. Skrip ini mengunaan “bahasa” sebagai parameter per-
tama, sehingga bila direktori bahasa yang digunakan adalah “NN” maka harus diketik update xml NN
untuk menjalankan skripi ini. Skrip lalu akan mengupdate semua file yang dapat ditemui pada “tree”
bahasa yang akan diterjemahkan tersebut. Jika ingin hanya mengupdate paket atau program tertentu,
maka nama program dapat digunakan sebagai parameter kedua ketika memanggil update xml. Misal
untuk mengupdate paket terjemahan bahasa Indonesia untuk kdemultimedia maka digunakan

update xml id kdemultimedia

update xml secara otomatis akan menjalankan parser XML, meinproc dengan opsi --check, yang akan
memvalidasi dokumen XML. Jika proses parsing gagal, maka akan diberikan informasi pada baris mana-
kah dan pesan kesalahan.

Jika tak ada persyaratan di atas, maka dapat dipanggil po2xml langsung dan menghasilkan berkas
DocBook. Untuk melakukan hal ini po2xml membutuhkan berkas DocBook bahasa Inggris (biasanya
diletakkan di subdirektori doc dari paket dengan nama index.docbook). dan berkas PO yang telah
diterjemahkan. Sintaks yang digunakan adalah :

po2xml English.docbook translated.po > translated.docbook

Perintah ini akan menghasilkan berkas translated.docbook

Pada header dari berkas yang dihasilkan maka perlu ditentukan bahasa yang digunakan. Misal jika
bahasa Indonesia ubah baris:

<!ENTITY % English "INCLUDE" ><!-- change language only here -->
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menjadi seperti ini

<!ENTITY % Indonesia "INCLUDE" ><!-- change language only here -->

Sekarang dengan berkas DocBook pada bahasa yang diterjemahkan tersebut, maka dapat diperiksa
apakah sintaks tersebut benar, dan penggunaan entitiy dapat diterjemahkan dengan benar.

PENTING : Tidak cukup pemeriksaan dianggap selesai, bila berkas DocBook dapat ditampilkan
pada KDE Help Center, karena ada optimasi parser, untuk kecepatan. Sehingga tidak dilakukan pe-
meriksaan sintaks secara total dari dokumen XML tersebut. Sebaiknya gunakan parser XML meinproc
dari Stephan Kulow. Sintaks menjalankannya adalah :

meinproc --check translated.docbook

Jika parsing gagal, maka akan memberi tahu nomor baris dan pesan kesalahannya. Dalam memperbaiki
kesalahan, perlu diingat bahwa yang perlu diperbaiki adalah berkas PO, sebab berkas DocBook dihasilkan
secara otomatis dari sini. Mulai perbaikan dari awal dokumen, sebab satu kesalahan dierror dapat
menyebabkan kesalahan berantai.

Jika memperoleh pesan kesalahan “file dtd/kde.dtx that could not be found” mungkin versi
libxml2 yang digunakan bukanlah yang paling baru.

Untuk memeriksa redaksional dari dokumentasi sebaiknya digunakan orang lain yang membaca
dokumen tersebut. Ini akan memberikan hasil yang lebih baik, sebab biasanya seseorang sering ter-
lewatkan ketika memeriksa ejaan atau kalimat.

Biasanya koodinator akan melakukan proof-reading dan memasukkan hasil penerjemaan ke CVS.
Sebaiknya perika kebijakan ini. Perlu selalu diingat bahwa dokumentasi ini akan diterbitkan di web server
KDE dan juga disebarkan ke seluruh dunia,. dengan kata lain akan dibaca berjuta-juta orang. jadi hasil
terjemahan ini akan mempengaruhi pandangan orang terhadap KDE.



7
Membuat screenshot

Beberapa hal berikut ini perlu diperhatikan dalam pembuatan screen shoot sebagai ilustrasi :

• Sebaiknya hanya gunakan format file PNG dan JPEG (lebih disukai PNG)

• Jangan gunakan GIF, karena ada permasalahan legalitas dalam hal ini.

• Untuk memberikan tampilan yang baik dan konsisten, maka diputuskan untuk menggunakan the-
ma/style yang seragam untuk kebutuhan dokumentasi yaitu :
Window decoration: KDE Default
Widget style: KDE default (locolor)

• Screen shot dibuat ketika X11 (XWindow) dalam modus 8bp). Sangat perlu diperhatikan un-
tuk mengusahakan agar ukuran file sekecil mungkin. Untuk tujuan itu dapat digunakan perintah
“startx -- -depth 8” untuk X 4.x and ”startx -- -bpp 8”untuk X 3.3.6.

• Pastikan bahwa berkas gambar tersebut tidak lebih dari 10 KByte ketika disimpan sebagai PNG.
Bila lebih dari ini berarti masih belum benar melakukannya.

• Berkas gambar ini harus terletak pada direktori yang setingkat dengan berkas yang meman-
faatkanya. Jangan letakkan di subdirektori lainnya.

• Nama berkas yang digunakan harap diterjemahkan.
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Laporan bug

Penerjemahan saat ini menjadi bagian dari sistem KDE bug track. Hal ini berarti koordinator penerjemah
dapat menerima :

• Hasil pengujian berkas PO.

• Berbagai laporan dari pengguna yang menganggap penerjemahan itu salah

• Laporan bug.

8.1 Penanganan kesalahan terjemanan

Sistem penjejakan bug KDE (KDE Bugtracking system) dapat dibaca penjelasannya pada bugs.kde.org.
Penjelasan ini sangat ditail. Pada dasarnya prosedur yang digunakan adalah

• Memasukkan laporan bug (submit),

• Bekerja mengatasi bug itu (work on) dan

• Menyatakan bug itu telah diatasi (close).

8.1.1 Memasukan laporan bug

Pertama kali, suatu laporan bug akan dikirim dengan email ke submit@bugs.kde.org. Laporan ini
kemudian akan diberikan nomor, lalu pengirim akan diberi tahu, dan akan diteruskan ke kde-bugs-dist.
Jika si pelapor memberikan nama paket yang memiliki bug, maka si perawat paket itu akan mendapatkan
juga sebuah salinan dari laporan bug ini. Dalam kasus ini, maka paket untuk penerjemah adalah translasi
yang terkait (“i18n-$LANG”), dan koordinator yang terdaftar di berkas “Maintainer” dari modul “bug”
di CVS akan menerima salinan dari laporan ini. Sebagiai contoh bila seorang pengguna memprotes suatu
penerjemahan “German” maka sistem penjejakan bug akan mencari baris :

i18n-de Thomas Diehl <thd@kde.org>

dalam berkas Maintainer dan memproses report itu.
Baris Subject dari mail yang dikirim akan memiliki nomor bug ditambahkan sebagau “bug#nnn”,

dan isian “reply-to” akan diisikan alamat pengirim laporan dan “nnn@bugs.kde.org”
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8.1.2 Menutup laporan bug

Penerjemah yang menerima laporan bug dari sistem penjejakan ini akan mengatasi masalah ini dan akan
mengirimkan jawaban kepada pelapor dengan isian “to” pada jawabannya akan berisi
“nnn-done@bugs.kde.org” atau “nnn-close@bugs.kde.org”, bukan hanya “nnn@bugs”. Alamat dari
pelapor asli akan juga dimasukkan ke dalam “to” secara otomatis (sebab sistem penjejakan bug akan
menyertakannya dalam isian “reply-to”)

Mereka yang menyelesaikan bug dan yang memberikan laporan akan mendapat pemberitahuan ten-
tang status pelaporan itu.

8.1.3 Mengikuti pesan

Jika penerjemah mau menjawab suatu laporan bug tanpa menandai bug sebagai telah ditutup, mereka
dapat dengan mudah menjawab pesan itu tanpa mengedit isian “to”. Jawaban ini akan terkirim ke
“nnn@bugs” dan ke pengirim asli dari laporan bug ini. Bug ini tidak akan ditandai sebagai bug yang
telah diselesaikan (atau kasusnya tetap belum dianggap tertutup).

Jangan gunakan fitur “reply to all recipients” atau “followup” dari program email, kecuali jika Anda
ingin mengedit alamat penerima. Jangan mengirim pesan ke bersamaan ke “nnn@bugs.kde.org” dan ke
“submit@bugs.kde.org”, karena sistem penjejakan bug akan mendapatkan dua salinan dan keduanya
akan diteruskan ke kde-bugs-dist
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Perangkat bantu dan sumber informasi

Berikut ini adalah bagian rujukan untuk beberepa keterangan petngin bagi penerjemah

9.1 Server penting untuk i18n

Server i18n.kde.org merupakan server utama untuk pekerjaan penerjemahan KDE, tersedia beragam
dokumentasi, perangkat bantu. Bila ada program bantu yang disumbangkan, maka dapat diletakkan
pada server ini. Yang bertanggung jawab pada server ini adalah Claudiu Costin (sisi teknis, pengelolaan
web dan CVS beserta skripnya) dan Thomas Diehl (isinya).

Setiap tim penerjemah suatu bahasa dapat memiliki akses di server ini, misal untuk pekerjaannya,
dokumentasinya dan lain-lain. Keuntungan di server ini, adalah ketersediaan CVS tambahan yang di
luar CVS utama dari sistem KDE. Jika tertarik menggunakan fasilita sini dapat mengontak Claudia, dan
kirimkan nama dan password dalam bentuk terenkripsi.

Informasi tentang CVS., CVSUP dan frontend grafis telah dijelaskan sebelumnya. Bagi pengguna
CVSUP, untuk mendapatkan berkas bahasa dari direktori kde-18n maka dapat dilakukan

cvsup -g -i kde-i18n/$LANG your cvsup command.file

Penggunaan WebCVS cukup mudah. Satu hal yang perlu diketahui adalah, bila ingin membuat “link”
langsung dari suatu situs web ke WebCVS, maka link tersebut harus dalam bentuk
http://webcvs.kde.org/cgi-bin/cvsweb.cgi/~checkout~/path/to/your file.

Milis untuk penerjemah dan penulis dokumentasi (kde-i18n-doc@kde.org), diarsipkan juga dengan
beperapa milis KDE lainnya pada lists.kde.org. Milis ini digunakan untuk diskusi, laproan permasala-
han, pemberitahuan dan berabagai hal yang terkait dengan penerjemahan dan dokumentasi KDE. Jelas
ini merupakan sumber informasi paling kini. Milis lainnya yang menyediakan informasi sangat membantu
terutama dari sisi teknis adalah milis pengembanga kDE yaitu kde-devel@kde.org. Ada juga milis yang
berkaitan dengan DocBook di KDE yaitu kde-docbook@kde.org.

Ruang chat yang sering digunakan adalah di irc.kde.org. Fasilitas chat ini memungkinkan
berbiacara langsung dengan para developer. Dapat juga digunakan untuk pertemuan penerjemah se-
cara virtual. Forum yang lumayan popular ada KDE Dot News (dengan gaya Slashdot). Forum seperti
ini lumayan efektif untuk mendapatkan masukan dari orang banyak. Karena orang tak perlu bergabung
terlebih dahulu untuk memberikan saran.

Ada beberapa situs yang berkaitan :

• Situs KDE utama www.kde.org yang berfungsi sebagai pusat informasi KDE.

• i18n.kde.org, situs untuk penerjemahan

• Situs lainnya adalah www.kde.org/international



Perangkat bantu dan sumber informasi 40

• lists.kde.org, situs arsip dari berbagai mailing list

• bugs.kde.org, situs untuk sistem penjejakan bug

• devel-home.kde.org, situs beberapa aplikasi KDE

• koffice.kde.org, situs proyek KOffice

• www.kdevelop.org, situs pemrograman di lingkungan KDE

• kde.themes.org, situs thema untuk KDE .

• Situs ftp ftp.kde.org yang berisi soruce code dari KDE

9.2 Berkas yang digunakan

Berkas yang harus diterjemahkan oleh tiap bahasa diletakkan pada lokasi berikut ini :

• Berkas GUI asli (POT) diletakkan di kde-i18n/templates. (bisa diambil dari server
i18n.kde.org)

• Berkas yang telah selesai diterjemahkan (PO) diletakkan di
kde-i18n/language/messages.

• Berkas dokumentasi asli (format DocBook atau masih dalam format LinuxDoc) disimpan pada
direktori tiap-tiap paket ( kdebase, kdeutils dan lain-lain)

• Dokumentasi yang diterjemahkan diletakkan di kde-i18n/language/docs.

9.3 Statistik

Halaman-halaman berikut ini menunjukkan status dari terjemahan. Biasanya informasi ini diperbaharui
tiap hari. Kebanyakan dari informasi ini dihasilkan oleh skrip yang dibuat oleh Claudiu Costin.

• The status table of KDE Translation untuk HEAD branch memberikan ringkasan mengenai
bagaimana tingkat pengerjaan tiap bahasa (dalam prosentase dari paket utama tiap kelompok).
Tabel ini digunakan untuk menentukan apakah suatu bahasa dimasukkan sebagai rilis KDE atau
tidak

• i18n-status-table menunjukkan GUI dari program manakah yang telah diterjemahkan dan mana
yang belum.

• Ada yang disebut “Highscore lists” yang menerangkan berkas terjemahan GUI manakah yang perlu
diperbaiki (Berkas PO yang tak diterjemahakn tidak tampil di sini, hanya tampil di i18n-status-
table). Dalam daftar ini terjemahan yang masih diragukan ditandai sebagai “fuzzy”, string yang
belum diterjemahkan ditandai dengan “untranslated”. Biasanya string akan menjadi “fuzzy” bila
terjadi perubahan pada berkas aslinya. Ada beberapa versi Highscore list ini :

– Berkas “all-in-one” hanya teks dan HTML yang menjadikan satu.

– Berkas “split-up” yang menunjukkan informasi sama untuk tiap kelompok bahasa.

• Statistik dokumentasi menunjukkan daftar dokumentasi yang telah diterjemahkan utnuk tiap ba-
hasa.
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9.4 Kamus dan perangkat bantu pemeriksa konsistensi

Beberapa perangkat bantu tambahan

• kdedict buatan Matthias Kiefer: tersedia skrip cgi utnuk menyimpan terjemahan standard dan
dapat dipanggil melalui web.

• kbabeldict buatan Andreas Rizzi yang merupakan bagian dari paket KBabel, digunakan untuk
membuat berkas kompendium dan menyediakan suatu interface yang enak untuk mencari suatu
istilah.

• Flexicon buatan Logi Ragnarsson, suatu database kata-kata, dengan keterangan untuk tiap bahasa.

• Kamus online dan berbagai sumber informasi dapat dibaca di
http://www.yourdictionary.com
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Penerjemahan halaman manual Linux

10.1 Prinsip man page

Pada sistem Linux atau Unix pada umumnya menyediakan fasilitas keterangan bantuan yang dapat
dipanggil dengan menggunakan perintah man. Fasilitas ini dapat dikatakan terdapat pada semua varian
Unix. Halaman keterangan manual suatu perintah ditulis dengan format groff. Format ini sebetulnya
digunakan untuk keperluan typesetting sehingga menuliskannya harus mengikuti suatu kaidah format
tertentu. Penulisan dengan format ini lazim dikenal sebagai source dokumen manual tersebut.

10.2 Penggunaan groff, nroff, troff

Menampilkan halaman manual memanfaatkan program pengolah teks. troff dan nroff adalah program
pemroses teks yang banyak digunakan di lingkungan UNIX. Versi pertama dari pemroses teks ini dikenal
dengan nama roff (kependekan dari runoff). Kemudian ada juga troff yang dapat menghasilkan model
typesetter tertentu pada saat itu. nroff adalan versi yang lebih baru yang menjadi pemroses teks standard
pada sistem UNIX. groff adalah implementasi GNU dari nroff dan troff digunakan pada sistem Linux.
Termasuk beberapa kemampuan tambahan dan driver untuk beberapa divais printer. groff mampu
menghasilkan dokumen, artikel, dan buku seperti halnya TEX. Bagaimanapun juga groff (sebagaimana
aslinya nroff) memiliki suatu kemampuan yang tak ada pada TEXdan variannya, yaitu kemampuan untuk
menghasilkan keluaran ASCII. Bila TEXsangat baik untuk menghasilkan dokumen yang akan dicetak,
maka groff mampu menghasilkan dokumentasi yang akan ditampilkan di layar secara online. groff
adalah salah satu alternatif untuk pekerjaan menampilkan dokumen di layar, alternatif lainnya adalah
Texinfo.

groff memiliki keuntungan lainnya, yaitu lebih kecil daripada TEX, sehingga membutuhkan file
pendukung, dan program yang lebih sedikit daripada TEX versi minimal. Salah satu aplikais khusus dari
groff adalah untuk memformat manual UNIX.

Seperti halnya TEX, groff menggunakan suatu bahasa pemformatan untuk menerangkan bagaimana
teks tersebut nantinya diproses oleh groff. groff juga menyediakan beberapa paket makro yang dapat di-
gunakan bersamaan dengan groff. Paket makro ini telah disesuaikan dengan jenis dokument tertentu.
Sebagai contoh makro mgs pilihan yang tepat untuk menulis artikel, sedangkan paket makro man digu-
nakan untuk halaman manual.

Ringkasan format untuk membangun halaman manual :
Tanda untuk mengubah font suatu teks yang bukan merupakan argument dapat digunakan :

• \fB.....\fP merubah font menjadi bold (tebal)

• \fI.....\fP merubah font menjadi italic (miring)

• \fR.....\fp merubah font menjadi Roman
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Penanda Penjelasan
.TH Judul di atas (title heading) argumen adalah nama

perntah dan bagian (section)
.SH Bagian (session heading) nama ditulis dengan huruf

besar sesuai dengan kesepakatan
.TP Paragraph bertanda (tag), menggunakna pargraf

menggantung (hanging indent)
.TP n Menentukan jumlah sisi masuk (indent)
.PP Memulai paragraf baru
.IP Paragraf menggantung (indent)
.nf Menghentikan autofilling (pengaturan kata pada

baris untuk perataan paragraf)
.fl Menghidupkan autofilling kembali
.B Menggunakan huruf tebal (bold) untuk teks yang

merupakan argumen
.I Menggunakan huruf miring (italic) utnuk tesk yang

merupakan argumen
.R Menggunakan huruf Roman untuk teks yang meru-

pakan argumen

Tabel 10.1: Ringkasan perintah groff

10.3 Format source manual

Berikut ini adalah contoh source dari suatu halaman manual yang diambil dari file
/usr/man/man8/halt.8 :

.\"{{{}}}

.\"{{{ Title

.TH HALT,REBOOT 8 "Februari 02, 1997" "" "Linux System Administrator’s Manual"

.\"}}}

.\"{{{ Name

.SH NAME

halt, reboot \- stop the system.

.\"}}}

.\"{{{ Synopsis

.SH SYNOPSIS

.B /sbin/halt

.RB [ \-n ]

.RB [ \-w ]

.RB [ \-d ]

.RB [ \-f ]

.RB [ \-i ]

.br

.B /sbin/reboot

.RB [ \-n ]

.RB [ \-w ]

.RB [ \-d ]

.RB [ \-f ]

.RB [ \-i ]

.\"}}}

.\"{{{ Description

.SH DESCRIPTION

\fBHalt\fP notes that the system is being brought down in the file

\fB/var/log/wtmp\fP, and then either tells the kernel to halt or

reboot the system. If \fIhalt\fP or \fIreboot\fP is called when the system is

\fInot\fP in runlevel \fB0\fP or \fB6\fP, \fIshutdown(8)\fP will be

invoked instead (with the flag \fB-h\fP or \fB-r\fP).
.\"}}}
.\"{{{ Options

.SH OPTIONS

.IP \fB\-n\fP
Don’t sync before reboot or halt.
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.IP \fB\-w\fP
Don’t actually reboot or halt but only write the wtmp record

(in the \fB/var/log/wtmp\fP file).

.IP \fB\-d\fP
Don’t write the wtmp record. The \fB\-n\fP flag implies \fB\-d\fP.
.IP \fB\-f\fP
Force halt or reboot, don’t call shutdown.

.IP \fB\-i\fP
Shut down all network interfaces just before halt or reboot.

.\"}}}

.\"{{{ Diagnostics

.SH DIAGNOSTICS

If you’re not the superuser, you will get the message ‘must be superuser’.

.\"}}}

.\"{{{ Notes

.SH NOTES

Under previous \fBsysvinit\fP releases, \fIreboot\fP and \fIhalt\fP should

never be called directly. From this release on \fIhalt\fP and \fIreboot\fP
invoke \fIshutdown\fP if the system is in runlevel 1-5.

.PP

.\"}}}

.\"{{{ Author

.SH AUTHOR

Miquel van Smoorenburg, miquels@cistron.nl

.\"}}}

.\"{{{ See also

.SH "SEE ALSO"

shutdown(8), init(1).

.\"}}}

Sepintas lalu kode-kode tersebut membingungkan tetapi sebetulnya tidak. Pertama yang perlu diper-
hatikan tanda .\"{{{ dan .\"}}} mengapit suatu blok bagian. Jadi suatu bagian akan diapit seperti
contoh di bawah ini

.\"{{{ Nama bagian

.

.

.

.\"}}}

Format lainnya yang perlu diperhatikan ada baris yang dimulai dengan sebuah titik (.). Misal pada baris
pertama terdapat .TH penanda ini menentukan judul (titel) manual, dan dinyatakan sebagai bagian 1
dari manual perintah tersebut. Juga penanda .TH ini membutuhkan tanggal manual terakhir kali direvisi.
Jadi lengkapnya

.TH judul bagian tanggal

Pada baris dua terdapat .SH yang memulai suatu bagian dari manual yang bernama NAME. Perhatikan
hampir pada semua halaman manual UNIX menggunakan bagian yang diberi nama berurutan sebagai
berikut :

• NAME

• SYSNOPSIS

• DESCRIPTION

• OPTIONS

• FILES

• SEE ALSO

• NOTES
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• AUTHORS

• BUGS

Dan dapat juga diberikan tambahan nama bagian lainnya bila diperlukan misal PENERJEMAH.
Baris selanjutnya mendefinisikan nama perintah/program, dan setelah tanda minus (-) dapat di-

tuliskan sedikit keterangan. Format ini harus digunakan pada bagian NAME sehingga halaman manual
dapat ditambahkan pada database whatis yang digunakan oleh man -k dan perintah appropos.

Baris berikutnya merupakan ringkasan (sinopsis) dari syntaks yang digunakan perintah tersebut.
Perhatikan font bold yang digunakan untuk karakternya didefinisikan dengan menggunakan .B. Hal ini
digunakan untuk menandai parameter pada perintah baris (command line). dan argumen tambahan
diletakkan antara kurung persegi [....]. Pada baris berikutnya untuk membuat agar font menjadi bold
dan roman digunakan .RB.

Pada baris berikutnya yaitu bagian DESCRIPTION digunakan tag untuk merubah bentuk font dari
teks yang bukan berupa argument. Yaitu teks keterangan. Hal itu dapat dilakukan dengan menggunakan
\fB...\fP yang akan mengubah teks menjadi tercetak tebal (bold).

Bagian berikutnya adalah bagian OPTIONS yang berisi penjelasan untuk menjelaskan option yang
dapat digunakan untuk perintah ini. Untuk menjelaskan point-point dari option ini digunakan bentuk
seperti bullet (daftar ke bawah) yang terformat dalam bentuk paragraf menggantung. Untuk itu digu-
nakan tag .IP. Dan di baris bawahnya terletak keterangan dari option tersebut. Dapat dilihat pada
contoh di bawah ini

.\"{{{ Options

.SH OPTIONS

.IP \fB\-n\fP
Don’t sync before reboot or halt.

.IP \fB\-w\fP
Don’t actually reboot or halt but only write the wtmp record

(in the \fB/var/log/wtmp\fP file).

.IP \fB\-d\fP
Don’t write the wtmp record. The \fB\-n\fP flag implies \fB\-d\fP.
.IP \fB\-f\fP
Force halt or reboot, don’t call shutdown.

.IP \fB\-i\fP
Shut down all network interfaces just before halt or reboot.

.\"}}}

Format tersebut akan menghasilkan bentuk seperti

OPTIONS

-n Don’t sync before reboot or halt.

-w Don’t actually reboot or halt but only write the

wtmp record (in the /var/log/wtmp file).

-d Don’t write the wtmp record. The -n flag implies

-d.

-f Force halt or reboot, don’t call shutdown.

-i Shut down all network interfaces just before halt

or reboot.

Di samping menggunakan cara di atas yaitu memsisahkan OPTIONS , terkadang digunakan cara menyajikan
lainnya. Yaitu dengan cara memanfaatkan OPTION sebagai sub section dari DESCRIPTIONS. Cara ini dapat
dilakukan dengan memanfaatkan tag .SS yaitu untuk menyatakan sebagai sub section. Baris selanjutnya
memberikan penjelasan dari perintah tersebut. Huruf italic menandai perintah, nama file, dan pilihan
(option) bagi user. Pada baris selanjutnya suatu sub bagian (subsection) yang ditandai dengan .SS
Option . Lalu diikuti oleh daftar option yang disajikan dengan baris yang diberi tag (penanda).
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Setiap baris ditandai dengan .TP . Bagian setelah .TP adalah penanda (tag) yang diikuti dengan
teks itu sendiri. Perhatikan baris setelah .TP harus terletak pada baris baru, seperti halnya dengan .IP.
Sebagai contoh kode pada baris di atas dapat diganti menjadi

.SH OPTIONS

.TP

\fB\-n\fP
Don’t sync before reboot or halt.

.TP

\fB\-w\fP
Don’t actually reboot or halt but only write the wtmp record

(in the \fB/var/log/wtmp\fP file).

.TP

\fB\-d\fP
Don’t write the wtmp record. The \fB\-n\fP flag implies \fB\-d\fP.
.TP

\fB\-f\fP
Force halt or reboot, don’t call shutdown.

.TP

\fB\-i\fP
Shut down all network interfaces just before halt or reboot.

Hal ini akan ditampilkan sedikit berbeda yaitu :

DESCRIPTION

Halt notes that the system is being brought down in the

file /var/log/wtmp, and then either tells the kernel to

halt or reboot the system. If halt or reboot is called

when the system is not in runlevel 0 or 6, shutdown(8)

will be invoked instead (with the flag -h or -r).

OPTIONS

-n Don’t sync before reboot or halt.

-w Don’t actually reboot or halt but only write the

wtmp record (in the /var/log/wtmp file).

-d Don’t write the wtmp record. The -n flag implies

-d.

-f Force halt or reboot, don’t call shutdown.

-i Shut down all network interfaces just before halt

or reboot.

Sebaiknya setiap option pada perintah baris (command line) harus dijelaskan dengan cara ini.
Baris-baris selanjutnya dapat merupakan bagian FILES dari halaman manual. Bagian ini menje-

laskan file-file yang mungkin digunakan oleh perintah/program tersebut. Suatu list dengan penanda .TP
juga digunakan dalam hal ini. Baris berikutnya adalah bagian SEE ALSO, yang memberikan referensi
silang (cross reference) dengan manual lainnya. Perhatikan SEE ALSO juga diikuti dengan .SH menggu-
nakan tanda petik ("..."). Sebab .SH menggunakan whitespace delimited argumen seperti pada bagian
judul. Sehingga setiap judul bagian yang lebih dari satu kata harus dibatasi dengan tanda kutip sehingga
akan dianggap sebagai argumen tunggal.

Bagian manual berikutnya adalah BUGS dan dapat juga bagian tambahan lainnya misal HISTORY.

10.4 Memformat dan menginstall manual

Untuk memformat halaman manual dan menampilkannya di layar dapat digunakan perintah

$groff -Tascii -man myhalt.8 | more
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Option -Tascii memerintahkan groff untuk menghasilkan keluaran ASCII murni, dan -man memerin-
tahkan groff untuk menggunakan kumpulan macro manual-page.

Misal pada contoh di atas yang diambil dari file halt.8 telah sedikit dimodifikasi dengan mengganti
bagian atau section OPTION menjadi seperti contoh di atas, yaitu memanfaatkan sub-section. Maka setelah
file yang baru (diberi nama myhalt.8 di atas dieksekusi akan ditampilkan :

HALT,REBOOT(8) Linux System Administrator’s Manual HALT,REBOOT(8)

NAME

halt, reboot - stop the system.

SYNOPSIS

/sbin/halt [-n] [-w] [-d] [-f] [-i]

/sbin/reboot [-n] [-w] [-d] [-f] [-i]

DESCRIPTION

Halt notes that the system is being brought down in the

file /var/log/wtmp, and then either tells the kernel to

halt or reboot the system. If halt or reboot is called

when the system is not in runlevel 0 or 6, shutdown(8)

will be invoked instead (with the flag -h or -r).

OPTIONS

-n Don’t sync before reboot or halt.

-w Don’t actually reboot or halt but only write the

wtmp record (in the /var/log/wtmp file).

-d Don’t write the wtmp record. The -n flag implies

-d.

-f Force halt or reboot, don’t call shutdown.

-i Shut down all network interfaces just before halt

or reboot.

DIAGNOSTICS

If you’re not the superuser, you will get the message

‘must be superuser’.

NOTES

Under previous sysvinit releases, reboot and halt should

never be called directly. From this release on halt and

reboot invoke shutdown if the system is in runlevel 1-5.

AUTHOR

Miquel van Smoorenburg, miquels@cistron.nl

SEE ALSO

shutdown(8), init(1).

groff juga mampu menghasilkan keluaran untuk berbagai jenis keluaran.
Penggunaan -Tps akan menghasilkan keluaran PostScript yang dapat disimpan pada suatu file, di-

tampilkan dengan Ghostview, atau dicetak dengan menggunakan printer PostScript. Penggunaan option
-Tdvi menghasilkan keluaran dvi (device-independent). Pada sebagian besar sistem UNIX, halaman
manual terletak di /usr/man/man1 ... / usr/man/man8. Setiap manual diberi nama sesuai cara berikut
ini:

nama program.nomor section

nama program adalah nama program atau perintah dan nomor section adalah nomor section dari per-
intah tersebut. Sebagai contoh ls.1 adalah untuk perintah ls section 1. Untuk file ini akan diletakkan
di sub-direktori /usr/man/man1. Sedangkan halt.8 merupakan file manual untuk perintah halt section
8, dan akan terletak di sub-direktori /usr/man/man8.
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Penggunaan dot untuk pohon menu

Seringkali dibutuhkan suatu gambar bagan atau diagram berdasarkan suatu relasi yang harus dinyatakan
secara benar. Misal untuk diagram organisasi, struktur data, pohon menu, perjalanan waktu dan lain
sebagainya. Menggambar diagram sejenis ini memang bisa dilakukan dengan program editor grafik seperti
xfig , sketch atau lainnya. Tetapi terkadang seringkali bila relasi yang harus digambar sangat kompleks,
dan kita tidak ingin melakukan kesalahan penggambaran, proses penggambaran secara manual ini lebih
menyulitkan.

11.1 Paket graphviz

Biasanya pada model gambar sejenis ini benar-tidaknya relasi lebih penting dari nilai artistiknya gambar
tersebut. Untuk menggambar suatu gambar relasi berdasarkan suatu deskripsi dapat dilakukan dengan
mudah misal menggunakan paket graphviz, yang memiliki utilitas seperti dot, neato, dotty, lefty dan
lainnya. Paket ini dikeluarkan oleh AT&T, dan dapat didownload pada :

http://www.research.att.com/sw/tools/graphviz/

Pada paket graphviz ada beberapa utilitas. Pada tulisan ini akan lebih banyak dibahas utilitas dot.
Sedangkan masing-masing utilitas tersebut berfungsi sebagai :

• dot digunakan untuk menggambar grafik berarah (directed graph ) sebagai suatu hirarki (bert-
ingkat).

• neato digunakan untuk menggambar grafik tak berarah (undirected grap h).

• dotty, merupakan editor grafik interaktif, dapat membaca dan mengolah file input untuk program
dot.

• lefty, merupakan editor grafik dengan 2 tampilan.

Program dot bekerja dengan menggunakan suatu file teks deskripsi dari gambar. Pada file deskripsi
tersebut dijelaskan deskripsi dari node-node yang akan digambar. Misalkan pada contoh yang paling
mudah ini akan digambarkan suatu struktur data pohon. Pada node teratas adalah F yang memiliki
cabang, A dan B. Suatu data gambar dimulai dengan kata kunci digraph { .... } (ada kata kunci
lainnya, tetapi untuk sementara ini saja yang digunakan). Setiap deskripsi dilakukan per baris, yang
ditutup dengan titik koma (;). Setiap relasi antara node 1 dengan node lainnya digambarkan dengan
menggunakan tanda panah (->). Paket graphviz akan menggambar relasi dan menentukan tata letak
secara otomatis.

Berikut ini adalah contoh untuk gambar struktur pohon tersebut:
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digraph "Grafikku" {
F -> A;
F -> B;
A -> 11;
A -> 12;
B -> 21;
B -> 22;
11 -> 111;
11 -> 112;
11 -> 113;
11 -> 114;
21 -> 211;
21 -> 212;
21 -> 213;
}

Pada contoh di atas, kita cukup mendefinisikan relasi antar node tersebut dengan menggunakan cara
yang mudah. Kita tak perlu memusingkan layout atau tata letak dari gambar tesrebut. Program dot
akan melakukannya untuk kita. Misal file tersebut diberi nama belajar1.dot. Maka file tersebut dapat
diolah dengan dot dengan menggunakan perintah :

# dot -Tps belajar1.dot -o belajar1.ps

Perintah di atas akan menghasilkan file postscript, yang siap dimasukkan ke dalam dokumen atau dilihat
dengan menggunakan postscript viewer, misal ghostview, atau lainnya. Gambar yang didapatkan adalah
:

F

A B

11 12 21 22

111 112 113 114 211 212 213

Gambar 11.1: Stuktur pohon

Bila kita ingin melihat hasil tanpa mengkonversi jadi suatu file postscript maka dapat digunakan
utilitas dotty .

# dotty belajar1.dot

Setelah itu dapat dilakukan pengeditan dari gambar tersebut secara interaktif. Mengubah layout,
attiribute dan dapat menyimpannya kembali dalam format dot tersebut.

Pada Gambar 11.1, di atas secara otomatis akan digambarkan pohon dengan urutan dari atas ke
bawah. Bila kita menginginkan urutan dari kiri ke kanan, maka kita dapat menggunakan perintah :
rankdir=LR. Sehingga contoh di atas menjadi

digraph "Grafikku" {
rankdir=LR;
F -> A;
F -> B;
A -> 11;
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Gambar 11.2: Mengubah secara interaktif dengan dotty

A -> 12;
B -> 21;
B -> 22;
11 -> 111;
11 -> 112;
11 -> 113;
11 -> 114;
21 -> 211;
21 -> 212;
21 -> 213;
}

File deskripsi di atas akan menghasilkan gambar seperti berikut ini :

F

A

B

11

12

21

22

111

112

113

114

211

212

213

Gambar 11.3: Arah kiri ke kanan
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rankdir adalah salah satu atribut untuk grafik. Suatu grafik akan dapat diubah sesuai dengan
atribut yang dapat diberikan pada grafik tersebut. Atribut tersebut yaitu :

• center, menentukan apakah gambar diletakkan pada tengah kertas

• clusterrank, penentuan kelompok node, dapat berisi global atau local.

• color, menentukan warna latar belakang.

• concentrate, menentukan penggunaan edge concentrator.

• fontcolor, warna huruf.

• fontname, jenis huruf.

• fontsize, ukuran huruf.

• label, sebarang kata-kata untuk menamai grafik.

• layers, id untuk layer.

• margin, margin gambar

• mclimit, digunakan untuk algoritma layout (abaikan dulu).

• nodesep, jarak antar node dalam inchi.

• nslimit, digunakan untuk algoritma layout (abaikan dulu).

• ordering

• orientation, bisa portrait atau landscape

• page, ukuran pagination.

• rank, dapat berisi max, min atau same

• rankdir, dapat berisi LR (kiri ke kanan) atau TB (atas ke bawah).

• ratio, jarak antar tingkat node (rank)

• size, menggambar bounding box dalam inchi.

11.2 Berbagai bentuk node

Bentuk node pada gambar dapat diubah dengan menentukan atribut tiap node tersebut. Perubahan
atribut node ini dapat dilakukan dengan mudah dengan menggunakan perintah [shape=’’...’’]. Isian
dari atribut itu sendiri dapat berupa ellipse, box, circle, doublecircle, diamond, plaintext, record,
polygon, epsf. Berikut ini adalah contohnya :

digraph "Grafikku" {
F -> A;
F [shape=ellipse];
A [shape=box];
F -> B;
B [shape=circle];
A -> 11;
11 [shape =doublecircle];
A -> 12;
12 [shape =diamond];
B -> 21;
21 [shape =plaintext];
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B -> 22;
11 -> 111;
111 [shape=polygon, sides=6];
11 -> 112;
11 -> 113;
11 -> 114;
21 -> 211;
21 -> 212;
21 -> 213;
}

File deskripsi tersebut akan menghasilkan gambar seperti di bawah ini. Pada gambar tersebut tampak
beragam model node.

F

A B

11 12 21 22

111 112 113 114 211 212 213

Gambar 11.4: Berbagai bentuk node

Node dapat memiliki beberapa atribut yang dapat diubah misal :

• color, warna.

• fontcolor, warna huruf.

• fontname, jenis huruf.

• fontsize, ukuran huruf.

• height, width, ukuran node dalam inchi

• label, teks yang ditulis pada node. Bila atribut ini tak digunakan maka id dari node akan digunakan
sebagai label.

• layer, id layer.

• shape, bentuk node.

• shapefile, file bila node dari file eps.

• style, gaya garis pembentuk node, dapat berupa bold, dotted, atau filled

11.3 Berbagai model relasi

Edge (panah) yang menghubungkan antar node dapat diubah-ubah modelnya. Untuk melakukan itu
maka digunakan kata kunci yang dituliskan setelah deskripsi suatu relasi. Jadi misal untuk mengatur
panah antar A dan B maka akan ditulis dalam A -> B [atribute edge=...]. Atribute edge yang dapat
digunakan adalah sebagai berikut :

• color, warna panah.
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• decorate, jika diset, maka akan digambar garis menghubungkan label relasi tersebut.

• dir, arah panah dapat diisi dengan forward, back, both atau none

• fontcolor, warna huruf.

• fontname, nama huruf Postscript yang digunakan.

• fontsize, ukuran huruf.

• id, nama panah digunakan bila panah jamak.

• label, teks untuk tulisan pada relasi tersebut.

• layer, id layer tumpang tindih.

• minlen, jarak ranking minimal antara kepala dan buntut.

• style, jenis garis panah, dapat berubah bold, dotted, atau filled

• weight, bilangan bulat yang menentukan pentingnya panah ini.

digraph "Grafikku" {
F -> A [color="red"];
F -> B [color="blue"];
A -> 11[label="satu-satu", minlen="3"];
A -> 12 [label="satu-dua"];
B -> 21;
B -> 22;
11 -> 111;
11 -> 112;
11 -> 113[dir="both"];
11 -> 114;
21 -> 211[style="dotted"];
21 -> 212;
21 -> 213;
}

Pada contoh di atas ada beberapa attribute dari edge (panah) yang ditampilkan. Misal penggunaan
atribute [color=...] akan mengubah warna panah yang digunakan. Atribut [label=...], akan mem-
berikan label untuk panah tersebut. Atribut [dir=...] akan menentukan apakah arah panah yang di-
gunakan untuk menghubungkan antar node. Kemungkinan yang digunakan adalah both, forward, back,
dan none. Sedangkan atribut [style = ...] menentukan jenis panah misal pada contoh di atas adalah
dotted. Sedangkan atribute minlen=3 mengakibatkan panah tersebut menggeser node tersebut menjadi
tingkatan node yang berbeda. Karena didefinisikan bahwa panah tersebut menghubungkan antara node
ke node yang berbeda 3 tingkat hierarkhinya.

11.4 Menggambar Struktur data

dot memiliki fasilitas untuk menggambar suatu struktur data dengan mudah. Model gambar ini sering
digunakan bagi mereka yang mendisain database, ataupun mendisain program. Berikut ini adalah contoh
untuk menggambar suatu sturktur data.

digraph "struktur-dataku" {
node [shape =record, height=.1]
node0[label = "<f0> | <f1> G| <f2>"];
node1[label = "<f0> | <f1> E| <f2>"];
node2[label = "<f0> | <f1> B| <f2>"];
node3[label = "<f0> | <f1> F| <f2>"];
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F

A B

11

satu-satu

12

satu-dua

21 22

111 112 113 114

211 212 213

Gambar 11.5: Berbagai jenis relasi

node4[label = "<f0> | <f1> R| <f2>"];
node5[label = "<f0> | <f1> H| <f2>"];
node6[label = "<f0> | <f1> Y| <f2>"];
node7[label = "<f0> | <f1> A| <f2>"];
node8[label = "<f0> | <f1> C| <f2>"];
node0:f2 -> node4:f1;
node0:f0 -> node1:f1;
node1:f0 -> node2:f1;
node1:f2 -> node3:f1;
node2:f2 -> node8:f1;
node2:f0 -> node7:f1;
node4:f2 -> node6:f1;
node4:f0 -> node5:f1;

Ketika telah didefinsikan bahwa suatu node itu berbentuk record, setelah itu kita bisa menentukan field
yang ada pada record tersebut, yaitu dengan menggunakan <nama port> label field. Setiap field
dipisahkan dengan tanda garis lurus (|). Perintah yang khas adalah digunakan pada model gambar di
atas adalah identifikasi port yaitu titik penghubung pada suatu node. Misal pada contoh di atas titik
node1 f0 maka berarti panah akan dimulai pada bagian f0. Bila tak ada port maka dianggap panah
dihubungkan pada bagian tengah node. Sebagai contoh pada gambar di bawah ini pada node0 dan port
f2 (yaitu sebelah kanan) akan dihubungkan dengan node4 pada bagian tengah (port f1).

Di samping menampilkan model struktur data yang sederhana, dapat juga ditampilkan struktur
data yang lebih kompleks seperti gambar berikut ini.

digraph structs {
node [shape=record];

struct1 [shape=record, label ="<f0> kiri | <f1> tengah | <f2>kanan"];

struct2 [shape=record, label ="<f0> satu | <f1> dua"];

struct3 [shape=record, label ="<f0> halo\nteman| {b | {c | d | e}| f}| g | h"];
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Gambar 11.6: Struktur data

struct1:f1 -> struct2:f0;

struct1:f2 -> struct3:ini;

}

kiri tengah kanan

satu dua
halo

teman

b
c d e

f
g h

Gambar 11.7: Struktur data yang lebih kompleks

Dapat juga digunakan untuk menggambar diagram Finite State . Seperti pada contoh di bawah
ini :

LR_0

LR_2SS(B)

LR_1

SS(S)

LR_3

LR_4

LR_8
LR_6

S(b)

LR_5

S(a)

S(A)

SS(b)

SS(a)

S($end)

S(b)

S(a)
S(a)

LR_7

S(b)

S(b)

S(a)

Gambar 11.8: Diagram Finite State

File deskripsi yang digunakan untuk menggambar Finite State tersebut adalah seperti berikut ini.
Perhatikan pada koneksi yang dilakukan di node itu juga. Misal pada LR 6 -> LR 6, paket graphviz akan
membuat panah secara otomatis menuju node itu sendiri.

digraph finite state machine {
rankdir=LR;
size="8,5"
orientation=land;
node [shape = doublecircle]; LR 0 LR 3 LR 4 LR 8;
node [shape = circle];
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LR 0 -> LR 2 [ label = "SS(B)" ];
LR 0 -> LR 1 [ label = "SS(S)" ];
LR 1 -> LR 3 [ label = "S($end)" ];
LR 2 -> LR 6 [ label = "SS(b)" ];
LR 2 -> LR 5 [ label = "SS(a)" ];
LR 2 -> LR 4 [ label = "S(A)" ];
LR 5 -> LR 7 [ label = "S(b)" ];
LR 5 -> LR 5 [ label = "S(a)" ];
LR 6 -> LR 6 [ label = "S(b)" ];
LR 6 -> LR 5 [ label = "S(a)" ];
LR 7 -> LR 8 [ label = "S(b)" ];
LR 7 -> LR 5 [ label = "S(a)" ];
LR 8 -> LR 6 [ label = "S(b)" ];
LR 8 -> LR 5 [ label = "S(a)" ];

Dengan fungsi menggambar struktur data tersebut, maka utilitas ini dapat digunakan untuk menggambar
pohon menu. Misalnya dengan skrip seperti di bawah ini akan digambarkan struktur menu dari program
aplikasi karm:

digraph G {

rankdir=LR;

ranksep=1.5;

node [shape=record];

menu1 [shape="record", label="<f0>File|<f1>Clock|<f2>Task|<f3>Settings|<:f4>Help"];

menu11 [shape="record", label="<f0>Save Ctrl+S|<f1>Print Ctrl+P|<f2>Recent Session time Ctrl+R|<f3>Quit Ctrl+Q", width=2];

menu12 [shape="record", label="<f0>Start Ctrl+S|<f1>Stop Ctrl+T",width=2];

menu13 [shape="record", label ="<f0>New Ctrl+N|<f1>New Subtask Ctrl+Alt+N|<f2>Delete Del|<f3>Edit Ctrl+E"];

menu14 [shape="record", label ="<f0>Configure Key Binding|<f1>Configure KArms"];

menu15 [shape="record", label ="<f0>Contents F1|<f1>What’s this Shift+F1|<f2>Report Bug|<f3>About KArms|<f4>About KDE"];

menu1:f0 -> menu11;

menu1:f1 -> menu12;

menu1:f2 -> menu13;

menu1:f3 -> menu14;

menu1:f4 -> menu15;
}

11.5 Aplikasi lainnya

Dari contoh di atas tampak bahwa program grafik berbasiskan skrip (file deksripsi) seperti dot ini memiliki
suatu fungsi yang sulit digantikan oleh program gambar secara interaktif. Di tambah lagi sifatnya yang
dapat dioperasikan melalui skrip, maka paket ini dapat digunakan untuk berbagai aplikasi tambahan,
sebagai contoh :

• apache2dot yang akan menerjemahkan file log apache ke suatu format yang dapat digunakan oleh
neator atau dot. Utilitas ini akan menggambarkan relasi dari halaman yang dikunjungi orang pada
suatu situs web. Setiap file akan dinyatakan dalam bentuk node, dan panah akan digambar dari
tiap referrer ke situs tersebut. Tingkat kegelapan panah menunjukkan berapa kali link tersebut
digunakan. Utilita sini dapat diperoleh di
http://www.chaosreigns.com/code/apache2dot/

• cinclud2dot, dapat digunakan untuk menghasilkan grafik hubungan yang ada pada file #include
pada suatu program C. Dapat diperoleh di
http://www.chaosreigns.com/code/cinclude2dot/

• sig2dot, utilitas yang ditulis dalam bahasa Perl ini digunakan untuk memparsing debian-keyring
(kunci public) ke dalam format yang dapat dioleh graphviz. Dapat digunakan untuk sebarang
keyring gpg. Dapat diperoleh di http://www.chaosreigns.com/code/sig2dot/
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File
Clock
Task

Settings
Help

Save Ctrl+S
Print Ctrl+P

Recent Session time Ctrl+R
Quit Ctrl+Q

Start Ctrl+S
Stop Ctrl+T

New Ctrl+N
New Subtask Ctrl+Alt+N

Delete Del
Edit Ctrl+E

Configure Key Binding
Configure KArms

Contents F1
What’s this Shift+F1

Report Bug
About KArms
About KDE

Gambar 11.9: Struktur menu Karms

• referer2dot. utilitas ini akan menerjemahkan log file referer dari apahe menjadi suatu grafik
yang dapat ditampuilkan dengan dot. Referer ini dapat menunjukkan dari manakah orang yang
mengkases suatu halaman web. Dapat diperoleh di : http://perso.respublica.fr/ppcm/

• txt2graph, utilitas ini menunjukkan struktur dan keterkaitan (dependencies) dari suatu teks yang
dibaca dari stdin dan menghasilkan suatu file deksripsi dot pada stdout yang dapat diproses dengan
menggunakan graphviz Dapat diperoleh di
http://andreas-romeyke.de/privat/txt2graph/txt2graph.html

• Beberapa contoh menarik dapat dilihat di situs AT&T, dapat dilihat di
http://www.research.att.com/sw/tools/graphviz/webapps.html
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Penggunaan KBabel

KBabel adalah editor untuk PO file (gnu gettext message catalogs) yang mudah digunakan dan canggih.
Tersedia pula berbagai fungsi dari Catalog Manager, dan beberapa feature canggih lainnya seperti ke-
mampuan pencarian dari katalog, penyorotan (highlighting) teks dan sekaligus memberikan keleluasaan
bagi pengguna untuk mengkustomisasikannya.

Kbabel adalah editor file-PO yang mudah dan banyak fungsinya. File PO adalah file gnu gettext
message catalog yang digunakan untuk proses internasionalisasi program. Memiliki fungsi Pengelolaan
katalog (Catalog Manager) dan fungsi lanjutan lainnya. Misal pencarian katalog, highlighting, dan juga
bermacam opsi yang dapat diubah-ubah. Termasuk pemeriksaan sintaks, fungsi statistik, file manager,
yang memudahkan proses penterjemahan secara konsisten.

Kbabel merupakan bagian dari proyek KDE http://www.kde.org. Untuk mendapatkannya bisa
didownload dari ftp://ftp.kde.org/pub/kde. Untuk menginstalnya dibutuhkan KDE 2.0.

12.1 Pengantar

Umumnya pesan program dan dokumentasi ditulis dalam bahasa Inggris. Namun demikian, sejak di-
gunakannya framework khusus dalam bekerja yang terdiri dari perangkat bantu dan pustaka, maka
dimungkinkan untuk menyusun aplikasi favorite dalam bahasa kita sendiri (bukan bahasa Inggris), misal
bahasa Indonesia. Proses adaptasi terhadap bahasa khusus ini disebut sebagai proses lokalisasi. Ter-
masuk pula penerjemahan interface program dan dokumentasi untuk beberapa bahasa. Hal ini memang
dibutuhkan oleh banyak user biasa. User dari berbagai daerah seringkali membutuhkan adanya input
ataupun output yang sesuai dengan konvensi yang berlaku di daerah atau di negara tertentu. KBabel
ini adalah salah satu alat bantu yang bisa digunakan untuk mendukung proses internasionalisasi. Dalam
proses ini kita dapat mengusahakan adanya interface dari aplikasi tertentu dalam berbagai bahasa.

Setiap program yang telah mendukung internasionalisasi akan memberikan kemungkinan untuk
menerjemahkan satu atau beberapa pesan dari file-file katalog. Umumnya file ini berekstensi POT -
Portable Object Template. Setiap penerjemah menggunakan salinan dari sebuah file POT dan mulai
menerjemahkan pesannya. File tersebut akan menjadi PO file (Portable Object) yang merepresentasikan
hanya satu bahasa. Setelah proses penerjemahan file tesk ini selesai (seringkali file ini berisi karakter
non-ASCII), maka file ini dikompilasi kedalam format biner, yang dapat dibaca oleh mesin. Cara ini
hampir sama dengan suatu sistem database, dimana hal tersebut dilakukan untuk mempercepat waktu
mencari pesan yang diterjemahkan. File ini memiliki ekstensi .mo dan dinamai MO file - Machine Object.

Namun tetap ada pertanyaan: Apakah saya perlu mengetahui apa yang ada dalam sebuah PO
file? jawabannya tentu saja adalah : Ya. Karena terkadang ada beberapa situasi dimana sebuah pesan
dalam katalog rusak dan harus diperbaiki secara manual. Banyak yang sangat tidak menyukai adanya
konflik CVS saat proses penerjemahan dikoordinasi dengan dengan sebuah system versi konkuren (lihat
dokumen CVS). Dalam hal ini, KBabel tidak dapat banyak membantu anda, selain dari editor teks,
CVS dan pengetahuan PO file. Perlu diperhatikan bagaimana sebuah PO file dibuat. Konsep yang
paling prinsip adalah tanda msgid dan msgstr yang dilanjutkan dengan string seperti yang digunakan
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dalam bahasa C (dibatasi dengan tanda kutip ganda). Kedua kelompok ini diawali dengan msgid dan
kadangkala dengan msgstr. Msgid dituliskan dalam teks berbahasa Inggris didalam user interface Aplikasi
sedangkan msgstr merupakan teks yang diterjemahkan. Baris yang kosong dan yang diawali dengan
angka akan diabaikan. Baris dengan angka merepresentasikan komentar dan merupakan poin yang bagus
untuk mengindikasi dari file mana pesan berbahasa Inggris yang dapat diterjemahkan atau komentar
tambahan untuk penerjemahan yang dibuat oleh developer dari aplikasi tersebut. KBabel menampilkan
baris komentar untuk setiap pesan. Pada banyak kasus pasangan pertama dari msgid dan msgstr dalam
PO file merupakan isian palsu (header dari PO file) yang berisi berbagai infomrasi tentang bagaimana
menerjemahkan PO file, seperti: nama aplikasi, tanggal penerjemahan, nama penerjemah dan banyak
lagi.

12.2 Editor

Berikut ini adalah layar utama dari Kbabel. Window utama akan dibagi menjadi 4 bagian :

Gambar 12.1: Window Utama KBabel

• Kiri atas merupakan edit box , yang bersifat hanya dapat dibaca read only . Kotak ini berisis field
msgid saat itu (current msgid ) dari file PO yang dibuka, dan teks bahasa Inggrisnya.

• Kiri bawah adalah field msgstr yang berakitan, di kotak ini dapat dilakukan pengeditan teks yang
diterjemahkan.

• Sisi kanan merupakan bagian untuk mencari string yang diterjemahkan pada file PO.

• Pada window sebelah bawahnya, adalah katalog yang terkompilasi, atau file yang didefinisikan
sendiri oleh pengguna.

Pada bagian bawah, disediakan toolbar untuk mempercepat operasi. Juga disediakan beberapa langkah
singkat (short cut ).

Isian msgid dapat memiliki tiga kemungkinan status :

• untranslated: berarti belum ada teks yang diterjemahkan yang berkaitan dengan msgstr tersebut.



Penggunaan KBabel 60

• fuzzy: msgmerge mencoba untuk mencocokkan string yang diterjemahkan pada bagian sisa isian
PO-file. Hal ini tak bekerja sempurna, sehingga harus diedit teks yang diterjemahkan secara manual
agar cocok dengan teks bahasa inggris yang ada.

• translated: ini berarti isian pada msgid telah diterjemahkan.

isian saat ini ditunjukkan oleh 2 indikator (seperti LED). Bergantung pada konfigurasi yang digunakan.
Dapat berada di statusbar, atau pada bagian atas box edit dari string yang diterjemahkan. Hal ini dapat
dikonfigruasikan berigut juga dengna warna yang digunakan untuk menampilkan status tersebut.

12.3 Katalog Manager

Gambar 12.2: Window Katalog Manager

Katalog manager akan menggabungkan dua direktori pada satu pohon direktori dan menampilkan
seluruh file PO dan POT dalam direktori ini. Dengan cara ini maka dapat dengan mudah dilihat jika ada
template baru yang telah ditambahkan atau dihilangkan. Juga ditampilkan beberapa informasi tambahan
mengenai file yang sedang diterjemahkan tersebut, misal : jumlah total, jumlah entri yang masih pada
status fuzzy, jumlah entri yang belum diterjemahkan, saat revisi terakhir, dan penerjemah terakhir file
tersebut.

Untuk mempermudah menemukan file, mencari bagian yang kurang, maka status file tersebut juga
ditampilkan dengan ikon :

• Entri di file ini semuanya telah diterjemahkan.

• Entri dari file ini masih belum pas diterjemahkan (status fuzzy).
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• File tak ada pada direktori file PO.

• File ini memiliki kesalahan sintaks.

Jika suatu icon berikut: diberi tanda seperti misal: , maka menunjukkan bahwa tak ada file POT
di direktori tersebut. File dapat ditandai dengan cara memilih Toggle Marking pada context menu pada
suatu file. Jika ingin mengubah atau menghilangkan seluruh mark pada suatu direktori, maka dapat
dilakukan dengan menekan tombol mouse ketika pointer berada di atas direktorii ini, dan pilih Toggle
Marking atau Remove Marking. Penanda akan otomatis disimpan ketika selesai menggunakan KBabel.

Untuk membuka suatu file, klik dua kali pada file, atau pilih dan tekan tombol RETURN atau Ctrl-
O, atau memilih Open dari menu. Untuk mengkonfigurasi Catalog Manager dapat dilakukan dengan
memilih Configure pada bagian bawah atau memilih bagian Catalog Manager pada dialog Preference.



13
Dialog Preferensi

Bukalah dialog Preference dengan memilih Settings -> Configure KBabel... lalu tampilah dialog
box Preference. Tampilan yang tampak sangatlah struktural sehingga memudahkan untuk memilih opsi
yang ada. Bagian kiri dari dialog box berisi daftar kategori untuk mengkustomisasi item yang ada. Di
sebelah kanan menampilkan tab yang berhubungan dengan categori yang dipilih. Dibagian kanan inilah
kita dapat menentukan preference yang kita perlukan. KBabel akan selalu menyesuaikan antara categori
dan komponen yang tampil di bagian kanan, dan bila semua preference yang dibutuhkan telah di-set,
maka untuk menyimpan nya klik lah tombol OK. Help system juga tesedia pada dialog ini. Anda cukup
memilih/meng-klik ikon “tanda tanya” pada bagian kanan atas, dan setelah kursor yang tampak berubah
menjadi tanda panah dengan “tanda tanya” di sampingnya, bila anda klik panah ini diatas label, tombol
ataupun entri pada dialog ini, maka akan tampak informasi tambahan dari item yang bersangkutan.

13.1 Identitas

Bagian ini digunakan untuk menentukan isian baku yang digunakan untuk tiap file PO yang diter-
jemahkan. Pada isian ini ditentukan nama, alamat email, nama bahasa, alamat email untuk team pener-
jemah. Juga timezone yang digunakan untuk menjejaki penerjemahan terbaru. Timezone tersebut dapat
ditentukan dalam bentuk seperti EEST atau perbedaan dengan GMT misal +0100 (contoh untuk Berlin).
Informasi ini berguna untuk memperbaharui header dari tiap file. Opsi isian mana yang diperbaharui
pada hedaer, dapat diperoleh dari dialog Save dalam menu Preference.

13.2 Editor

Pengaturan preferensi editor terbagi atas 3 window kecil yaitu :

• General

• Appereance

• Font.

Semua isian ini menentukan bagaimana editor tampil dan bekerja

13.2.1 General

Hanya ada satu checkbox yang akan diset ketika status fuzzy di reset. Ketika opsi ini dimatikan, maka
harus secara manual diubah meluai menu Edit -> Unset Fuzzy Status atau dengan menekan Ctrl-U.
Ini berarti kata “fuzzy” dihilangkan dari isian komentar pada file PO tersebut.
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Kelompok checkbox yang ada dibagian bawah sangat berguna untuk mendukung proses penerje-
mahan, namun bukan untuk memperbaiki hasil terjemahan, hanya sekedar untuk logika. Banyak dari
pesan yang ada merepresentasikan item yang ada pada menu dengan tombol penyingkat dan string yang
memiliki format seperti pada bahasa C.

Check Arguments,

Bila ditandai, maka string ada dalam format C yang asli dan terjemahannya dicek untuk menemukan
apakah nomer format sekuensnya identik dan urut.

Check Accelerator,

Bila ditandai, maka akan membantu proses pencarian apakah jumlah karakter penyingkat sama an-
tara string yang asli dengan yang sudah diterjemahkan. Perlu dicatat bahwa tanda penyingkat
adalah “&”, tapi tidak disemua alat bantu pemrograman. Lihat pada bagian Miscellaneous
dibawah untuk mengetahui bagaimana caranya mengganti tombol penyingkat itu.

Check Equation,

Ini merupakan fituer dari proyek pengembangan KDE. file .desktop yang merupakan file teks,
yang memiliki berbagai parameter di format value=key. Sebagian dari key ini dapat diterjemahkan.
Hanya saja perlu diperhatikan untuk tidak merubah kualitas di bagian kiri. Bila Equasi dicek akan
memungkinkan anda untuk melihat adanya kesalahan (error) yang terjadi dari algoritma fuzzy
msgmerge. Perlu dicatat bahsa situasi ini terjadi saat fungsi ini mengenerate error yang salah pada
beberapa PO file.

Look . yang tidak berguna. Tandai box ini untuk meyakinkan bahwa kita akan mendapatkan pesan
peringatan tentang adanya kesalahan sejenis pada file.

Beep on error,

Sistem anda akan mengeluarkan suara “beep” saat anda memberikan isian dengan kesalahan seperti
yang telah dijelaskan diatas.

Change text color on error,

Merupakan salah satu jenis peringatan tentang adanya error pada pesan. Bagi pengguna yang
memiliki keterbatasan pendengaran atau untuk mereka yang tidak menyukai bunyi-bunyian, maka
pilihan ini memberikan keleluasaan bagi mereka untuk penyesuaian. LIhat pula pada bagian tab
Appearance untuk mengetahui cara merubah warna untuk teks pada kesalahan (error).

13.2.2 Appearance

Opsi ini digunakan untuk mengkonfigurasikan penampilan dari editor pesat. Pada bagian atas ada 4
checkbox yaitu:

• Highlight Syntax:
Setting untuk menggarisbawahi sintak (highlight syntax) untuk karakter tertentu, akselerator dan
seting latarbelakang untuk teks pada viewer msgid dan editor msgstr. Bila kita tidak memiliki
tampilan monokrom atau adanya kekurangan pada kemampuan visual, maka opsi ini hendaknya di
enable kan.

• Highlight Background:
Memilih background hanya dapat dilakukan untuk karakter yang ada pada msgid dan msgstr ter-
masuk pula spasi. Hal ini sangat berguna, bila anda tidak ingin melihat quote yang ada pada PO
entri, tapi anda tetap dapat memeriksa spasi awal dan akhir yang ada pada barisan teks.

• Mark whitespaces with points:
Setiap spasi putih akan ditandai dengan points. Bila anda merasa perlu mengetahui berapa jumlah
spasi yang ada atau background highlight yang tidak sesuai dengan selera anda, maka anda dapat
memeriksanya pada opsi yang tersedia untuk melihat spasi putih yang diisi dengan point. Sebagai
catatan, yang dimaksud dengan point adalah tanda point pada bagian tengah dari kotak karakter
dan bukan merupakan desimal point.
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• Show surrounding quotes:
Bila anda merasa bahwa melihat tampilan karakter pada terminal pada barisan teks msgid atau
msgstr lebih baik daripada memeriksa opsi ini untuk melihat kuote yang ada setiap baris. Sama
halnya apabila pengalaman yang anda miliki dalam mengedit PO file dengan editor teks bisa mem-
berikan kenyamanan bagi anda, maka anda dapat mengikuti awal dan akhir dari kuote ganda yang
ada pada baris PO file.

Untuk tiap bagian teks yang diedit tersedia pilihan warna. Warna dapat diubah dengan mengklik pada
tombol pemilih warna (color-picker). Warna yang dapat diatur adalah :

• Background color.:
Warna latar belakang untuk karakter pada tayangan MsgID dan MsgStr. Untuk latar belakang
semuanya atau kotak edit, maka harus diubah melakui KDE Control Center.

• Color for quoted character :
Dapat diubah untuk menghindari karakter tertentu seperti \double quotes atau \newline.

• Color for syntax errors :
Ini adalah warna dari keseluruhan teks yang ada apabila ditemukan kesalahan saat anda menyimpan
PO file. Kesalahan disebabkan karena tidak diakhirinya msgid atau msgstr atau saat kita melewati
karakter yang salah.

• Color for c-format characters :
Perintah ini akan menberikan warna khusus untuk fungsi-fungsi tertentu seperti pada bahasa pe-
mrograman C (misal pada fungsi: printf atau scanf). Secara umum, tanda ini akan di awali pada
karakter (%) atau persen dan dilanjutkan oleh satu karakter berikutnya.

• Color for keyboard accelerators :
Akselerator keyboard diawali dengan tanda (&) atau disebut juga karakter “ampersand”. Satu hu-
ruf berikutnya diwarnai untuk memperjelas karakter yang digunakan dengan kombinasi penekanan
tombol ALT. Status untuk isian yang telah diedit ditandai dengan dua LED. Untuk memberikan
kenyamanan, kita dapat memilih akan meletakkan LED ini di: status bar atau pada editor (antara
isian msgid dan msgstr).

Bila ditemukan kesulitan untuk melihat tampilan dari beberapa warna atau anda perlu meyakinkan
bahwa anda dapat mengukuti status perubahan LED dengan mudah tanpa merubah posisi mata anda,
maka anda dapat memilih warna yang sesuai dengan menggunakan tombol pemilih warna.

Fonts

Ini merupakan dialog pemilihan font yang klasik dengan sedikit penambahan. Anda dapat memilih
untuk menampilkan font yang pasti/tetap dengan memilih pilihan “Show only fixed point”. Hal ini
sangat disarankan pada penterjemahan yang sederhana. Dialog font akan memberikan anda keleluasaan
untuk mengatur keluarga font (font family), style, ukuran (size) dan encoding. Kotak terbawah akan
menunjukan tampilan sementara dari font yang dipilih untuk memudahkan user melihat perubahan dari
pengaturan font ini

13.2.3 Penguji Ejaan (Spell Check)

Dengan fasilitas ini preferensi penguji ejaan (Spell chek) dapat diatur. Hal ini bermanfaat bila terdapat
file kamus yang dipergunakan untuk penterjemahan. Berikut ini adalah elemen yang patut di pertim-
bangkan dalam proses pengaturan.

Create root/affix combinations not in dictionary:
Untuk beberapa kata baru yang ditambahkan pada kamus pribadi, program penguji ejaan membuat
kombinasi root/affix agar sesuai dengan beberapa variasi lain.
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Consider run together words as spelling errors:
Bila fungsi ini diaktifkan, maka kata-kata yang tergabung didalamnya, akan dianggap sebagai ke-
salahan. Namun kondisi ini cukup lumrah pada bahasa yang memiliki banyak kata yang berasal
dari gabungan beberapa kata lain.

Dictionary:
Dari popup list anda dapat memilih kamus mana yang akan digunakan. Perlu dicatat bahwa anda
harus menginstall kamus yang sesuai dengan bahasa yang anda gunakan. Periksa distribusi ispell
atau aspell anda untuk mengetahui apa yang anda miliki.

Encoding:
Anda dapat memilih encoding untuk teks anda. Pilihan ini tepat bila anda menggunakan penguji
ejaan (spellchecker). Fungsi ini akan meng-encoding kata-kata yang ada pada kamus anda. Lihat
dokumentasi kspell untuk keterangan lebih lanjut.

Client:
Ini merupakan program backend untuk penguji ejaan. Untuk sementara ini yang digunakan adalah
to: ispell (international Ispell) dan aspell.

Remember ignored words:
Fungsinya untuk menjejaki kata-kata yang diabaikan oleh user pada saat menguji PO-file. Hal ini
memberikan kenyamanan untuk mengabaikan singatan-singkatan atau kombinasi charakter yang
aneh yang dapat anda temukan pada interface GUI.

File to stored ignored words:
Fungsi ini dapat membantu untuk menemukan file dari kata-kata yang diabaikan. Dengan meng-
klik folder atau ikon yang ada pada baris yang diedit di sebelah kanan, anda dapat memilih path
dan nama untuk file kata-kata yang diabaikan. Defaultnya adalah:
$(HOME) /.kde/share/apps/kbabel/spelliignores, dimana $(HOME) adalah home direktori
dari user yang bersangkutan.

13.2.4 Fonts

Ini merupakan dialog pemilihan font yang klasik dengan sedikit penambahan. Anda dapat memilih
untuk menampilkan font yang pasti/tetap dengan memilih pilihan “Show only fixed point”. Hal ini
sangat disarankan pada penterjemahan yang sederhana. Dialog font akan memberikan anda keleluasaan
untuk mengatur keluarga font (font family), style, ukuran (size) dan encoding. Kotak terbawah akan
menunjukan tampilan sementara untuk memudahkan user.

13.3 Search

Seksi pencarian (search) memungkinkan untuk mengkustomisasi berbagai pengaturan untuk pencarian
pada string yang sebelumnya telah diterjemahkan.

13.3.1 General

Pengaturan umum merupakan hal yang umum pada semua tipe pencarian (search). Bila anda menandai
pilihan/opsi “Automatically start search”, maka proses pencarian akan dilakukan secara otomatis kapan
saja anda beralih ke isian lainnya pada editor. Untuk saat ini ada tiga kemungkinan yang dapat dip-
ilih. Tapi karena KBabel dapat menggunakan kamus plug-in, maka keberadaan kamus tertentu sangat
tergantung dengan apa yang sudah di install. Dengan Setting -> Configure Dictionary -> ...., anda
dapat mengkonfigurasi setiap plug-in program pencari. Default Plug-in yang telah diinstall adalah:

• KDE Database Search Engine: merupakan metoda baru yang masih berada pada tahap alpha
dalam pengembangannya dan program ini dikembangkan dengan didasarkan pada task yang ada
pada KBabelDict yang menyertai KBabel. Lihat dokumentasi KBabelDict untuk keterangan lebih
lanjut tentang bagaimana mengkonfigurasi program pencari.
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• PO Compendium: compendium merupakan PO-file normal, yang seharusnya berisi standard penter-
jemahan untuk team yang mengerjakan penterjemahan. Bila anda tidak memilikinya, maka dapat
digunakan file yang berisi semua terjemahan dari team yang bekerja (misal: file $lang.message pada
proyek KDE, dapat ditemukan pada 118n.kde.org).

• PO Ausxilary : Tambahan (auxilliary) dapat membantu mencari konteks dari penterjemahan dengan
melihat pesan yang sama pada katalog pesan dari paket yang sama tetapi diterjemahkan untuk
bahasa yang lainnya. Dengan cara ini, maka dapat dilihat bagaimana pesan ini diterjemahkan
kedalam bahasa lainnya.

Anda dapat pula melakukan pencarian secaa manual dengan cara memilih satu isian yang ada pada
popup menu yang tampil baik saat meng-klik Dictionaries --> Search Text --> PO Compendium
atau dengan menekan tombol search untuk sementara waktu.

13.4 Save

Pada bagian ini dapat di edit opsi untuk penyimpanan PO-file. Kelompok Checkbox pertama akan
mengontrol sifat umum untuk aktivitas yang dilakukan pada saat perintah “simpan” (saving) pada PO
file.

• Update header when saving:
Tandai tombol ini, untuk memperbaharui informasi pada “header” dari file, setiap kali file tersebut
di simpan. “Header” tersebut umumnya menyimpan informasi tentang tanggal dan waktu manakala
file tersebut diperbaharui, atau saat terakhir diterjemahkan, dll. Anda dapat memilih informas yang
akan diupdate dari area checkbox “Fields to update”. Field yang tidak ada dapat ditambahkan pada
“header”. Bila akan ditambahkan field tambahan pada “header” dapat dilakukan secara manual
dengan memilih Edit -> Edit Header pada window editor.

• Check syntax of file when saving:
Dengan menandai bagian ini, maka secara otomatis sintaks dari file akan ditandai dengan msgfmt –
statistic saat proses penyimpanan file. Anda akan mendapat pesan kesalahan bila terjadi kesalahan
(error). Karenanya akan lebih baik bila opsi ini diaktifkan kecuali jika anda mengetahui dengan
pasti apa yang anda lakukan.

Bila anda tidak menginginkan adanya perubahan pada field yang terdapat pada “header” dari PO-file
atau ingin memaksa perubahan pada field tertentu, terdapat lima checkbox yang fungsinya mengontrol :
tanggal revisi, bahasa pada PO-file, encoding teks, nama penterjemah terakhir, dan charset. Bila sebuah
field tidak ada, maka field tersebut ditambahkan pada header. Bila akan ditambahkan informasi tertentu
pada header, dapat dilakukan secara manual dengan memilih Edit -> Edit Header pada window editor.

Untuk tanggal dan waktu dari field header PO-Revision-Date, anda dapat memilih satu dari format
berikut ini:

• Default adalah format normal yang digunakan dalam PO-file

• Local adalah format spesifik untuk negara anda

Custom memberikan keleluasaan untuk menentukan format sesuai dengan yang kita inginkan sendiri,
misalnya: anda dapat menggunakan string yang “C-like” (mirip dengan style pada bahasa C), seperti:

Tabel 13.1: Tahun
Format Arti Kisaran

%y year 00 s/d 99
%Y year 0001 to 9999
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Tabel 13.2: Bulan
Format Arti Kisaran

%m month of year 01 s/d 12
%f month of year 1 s/d 12

Tabel 13.3: Hari
Format Arti Kisaran

%ja day of the year 001 s/d 366
%d day of the month 01 s/d 31
%e day of the month 1 s/d 31
% weekday abbreviation Sun s/d Sat

Bagian bawahnya akan di kelompokan pada opsi encoding untuk PO-file saat proses penyimpanan.
Popup list akan memberikan keleluasaan untuk memilih pesan yang diencoding. Diperlukan setidaknya
pengaturan bahasa dan UTF-8. Bila karena satu dan lain hal anda tidak ingin encoding PO-file anda
secara tidak sengaja berubah, maka matikan fasilitas “Keep the encoding of the file”.

13.5 Catalog Manager

Bagian ini memungkinkan anda untuk mengedit opsi yang ada untuk Catalog Manager.

13.5.1 General

Berikut ini adalah dua baris editing dengan Browse .... buttons. Ketikan pada direktori yang berisi
semua PO dan POT-file anda. File-file dan direktori yang ada pada direktori ini akan digabungkan
kedalam satu rangkaian pada window Catalog Manager.

Berikut ini dapat di hidupkan atau dimatikan sesuai dengan kebutuhan:

• Open files in the new window:
Bila semua file aktif yang dibuka pada Catalog Manager dibuka pada sebuah window baru.

• Kill processes on exit:
Bila anda menandai bagian ini, maka KBabel akan menghentikan proses yang tidak ditutup saat
program akan diakhiri dengan cara mengirimkan sinyal “kill”.

13.5.2 Directory Commands

Pada bagian ini anda dapat menyisipkan perintah yang akan dieksekusi pada direktori dari Catalog
Manager. Perintah-perintah tersebut akan ditampilkan pada perintah submenu yang terdapat pada
konteks menu dari Catalog Manager.

Sisipkan pada field Name, nama dari perintah. Nama ini dapat dipilih secara bebas dan ini hanya akan
ditampilkan pada menu. Pada field Command, sisipkan perintah, yang akan di eksekusi saat pemilihan
item item dari menu yang berhubungan. Lalu tekanlah tombol Add, untuk menambahkan perintah
tersebut pada perintah yang sudah ada. Untuk mengedit perintah tersebut, pilihlah perintah tersebut

Tabel 13.4: Minute, Second, Timezone
Format Meaning Range

%M Minute 00 s/d 59
%S Second 00 s/d 59
%Z timezone (given in identity settings)
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lalu tekan tombol menu Edit lalu tekan Add saat mengakhirinya. Sedangkan untuk menghilangkan
perintah, caranya adalah pilihlah salah satu dari perintah yang ada pada daftar perintah, lalu tekan
tombol Remove. Bila anda mengingkan urutan yang berbeda pada kontekstual submenu, anda dapat
memanfaatkan tombol “up” dan “down”.

Perintah akan dieksekusi melalui default shell, sehingga anda dapat mengeksekusi sekaligus beberapa
perintah sekaligus hanya dengan membatasi perintah-perintah tersebut dengan titikcoma antara satu
dengan lainnya. Bahkan anda dapat pula mengatur variabel dari environment, bila memang diperlukan.
Perintah yang dieksekusi pada direktori PO-file yang sudah anda pilih pada Catalog Manager.

Berikut ini adalah string yang akan menggantikan perintah:

• @PACKAGE@: merupakan nama dari direktori tanpa path

• @PODIR@: adalah nama dari direktori PO dengan path

• @POTDIR@: adalah nama dari direktori template dengan path

misal: bila anda ingin mengeksekusi perintah make dan make install, maka anda dapat menyisipkan
di field Name dengan Make Install lalu di field Command dengan make; make install. Bila anda
memilih Commands->Make Install dari menu konteks dari suatu direktori, maka perintah yang tertulis
di atas akan dieksekusi pada direktori ini.

13.5.3 File Commands

Pada bagian ini, anda dapat menyisipkan perintah yang anda ingin eksekusi pada file dari Catalog
Manager. Perintah tersebut kemudian akan ditampilkan pada submenu Commands pada menu Catalog
Manager.

Sisipkan pada field Name , nama dari perintah. Nama ini dapat dipilih bebas dan hanya akan
ditampilkan pada menu. Pada field Command sisipkan perintah, yang anda ingin eksekusi pada saat
dilakukan pemilihan pada item menu yang bersangkutan. Lalu tekanlah tombol Add untuk menambahkan
perintah anda pada perintah yang sudah ada. Sedangkan untuk mengedit perintah, pilihlah perintah
tersebut, lalu tekan tombol Edit . Setelah itu tekan tombol Add setelah anda selesai mengedit. Sedangkan
untuk menghilangkan perintah, caranya adalah pilihlah salah satu dari perintah yang ada pada daftar
perintah, lalu tekan tombol Remove. Bila anda mengingkan urutan yang berbeda pada kontekstual
submenu, anda dapat memanfaatkan tombol “up” dan “down”.

Perintah akan dieksekusi melalui default shell, sehingga anda dapat mengeksekusi sekaligus beberapa
perintah sekaligus hanya dengan membatasi perintah-perintah tersebut dengan titik koma antara satu
dengan lainnya. Bahkan anda dapat pula mengatur variabel dari environment, bila memang diperlukan.
Perintah yang dieksekusi pada direktori PO-file yang sudah anda pilih pada Catalog Manager.

Berikut ini adalah string yang akan menggantikan perintah:

• @PACKAGE@: merupakan nama file tanpa path dan extensi

• @POFILE@: adalah nama dari PO-file dengan path dan extensi

• @POTFILE@: adalah nama dari file template yang berhubungan dengan path dan extensi

• @PODIR@: adalah nama direktori dimana PO-file berada dengan path

• @POTDIR@: adalah nama direktori dimana file template berada dengan pathnya

Misal: bila anda akan menggabungkan antara file template dengan PO-file anda, anda dapat menyisip-
kannya di field Name dengan Merge dan di field Command dengan

msgmerge @POFILE@ @POTFILE@ > @PACKAGE@.new && mv @PACKAGE@.new ‘‘@PACKAGE@.po.

Bila selanjutnya anda memilih Command -> Merge dari menu konteks file, maka PO file dapat diga-
bungkan dengan template filenya.Misal: bila anda ingin mengeksekusi perintah make dan make install,
maka anda dapat menyisipkan di field Name dengan Make Install lalu di field Command dengan
make; make install. Bila anda memilih Commands->Make Install dari menu konteks dari suatu di-
rektori, maka perintah yang tertulis di atas akan dieksekusi pada direktori ini.
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13.6 Miscellaneous

Bagian ini berisi beberapa pengaturan yang mungkin tidak bisa dikelompokkan dengan salah satu kelom-
pok diatas. Untuk sementara ini terdapat dua hal, yaitu:

• Marker for keyboard accelerator:
Anda dapat menempatkan karakter anda sendiri yang berfungsi sebagai marker atau penanda un-
tuk indikator keyboard akselerator di GUI. Secara default merupakan tanda “&” (ampersand), tapi
di beberapa toolkit programming bisa saja merupakan karakter lain. Sebagai contoh pada penter-
jemahan Gnome/GTK, karakter “ ” (underscore atau garisbawah) adalah tanda untuk keyboard
akselerator.

• Regular expression for context information:
Untuk para user biasa yang belum berpengalaman, “Expresi Regular ” (Regular Expression) meru-
pakan hal yang aneh. Namun demikian, anda disarankan untuk merubah nilai default bila an-
da mengetahui apa yang akan anda kerjakan. Beberapa toolkit untuk pemrograman GUI sudah
dilengkapi dengan metoda deskripsi konteks informasi. Bila anda akan menerjemahkan PO file dilu-
ar dari spesifikasi KDE, ada baiknya anda mengkonsultasikannya dengan user yang sudah berpen-
galaman. Demi kelengkapan maka dapat disebutkan disini bahwa secara default yang dimaksud
dengan ekspresi regular adalah: “ teks yang diawali dengan tanda : dan diikuti oleh satu atau
lebih karakter dan diakhiri dengan garis baru.
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14.1 Menu KBabel

14.1.1 Menu File

File->Open (Ctrl-O)
Bila file yang sedang aktif ini dimodifikasi, maka anda akan diminta untuk menyimpannya terlebih
dahulu.

File->Open Recent
Sehingga anda dapat segera membuka PO-file yang beberapa saat terakhir sering dibuka.

File->Save As
Bila tidak ada modifikasi yang terjadi pada berkas, maka proses penyimpanan tidak akan terjadi.

File->Save As
Dengan perintah ini akan melakukan penyimpanan file dengan nama baru.

File->New View
Membuka window KBabel baru dengan file yang dimuatkan di dalamnya. Hal ini sangat berguna
bila anda ingin menerjemahkan file yang besar dan anda perlu untuk selalu melihat kembali pada
string tertentu.

File->New Window
Membuka satu jendela baru KBabel yang kosong.

File->Quit (Ctrl-Q)
Keluar dari KBabel.

14.1.2 Menu Edit

Edit->Undo (Ctrl-Z)
Membatalkan aksi edit terakhir pada kotak edit translasi.

Edit->Redo (Ctrl-Shift-Z)
Ulangi aksi terakhir yang telah dibatalkan pada proses edit pada kotak edit translasi.

Edit->Cut (Ctrl-X)
Memotong teks yang telah dipilih dan pindahkan ke clipboard.

Edit->Copy (Ctrl-C)
Menyalin bagian yang telah dipilih ke clipboard.
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Edit->Paste (Ctrl-V)
Tempelkan isi dari clipboard pada posisi kursor saat ini pada kotak edit translasi.

Edit->Select All
Memilih semua teks yang ada dari kotak edit translasi.

Edit->Find ...
Membuka dialog pencarian untuk mencari string tertentu pada PO file.

Find->Find Next
Untuk menemukan kecocokan berikutnya dari string yang dicari pada proses pencarian sebelumnya.

Edit->Replace... (Ctrl-R)
Membuka dialog replace untuk mencarian dan penggantian string pada PO file.

Edit->Copy msgid to msgstr (Ctrl-Space)
String berbahasa Inggris yang asli disalin ke bagian bawah pada kotak edit translasi. Hal ini
bermanfaat bila anda tidak membuat penyesuaian atau hanya sekedar melakukan perubahan kecil
dari teks asli bahasa Inggrisnya (msgstr)

Edit->Copy search result to msgstr (Ctrl-Alt-Space)
String yang ditemukan setelah proses pencarian translasi disalin pada kotak edit MsgStr. Hal ini
bermanfaat bila anda tidak ingin mengulang penerjemahan pesan-pesan yang sama.

Edit->Unset Fuzzy Status (Ctrl-U)
Mereset status fuzzy dari seluruh isian pada PO file. Anda hendaknya tidak melakukan hal ini
kecuali anda mengertibetul apa yang anda kerjakan. Karena masih adanya kemungkinan penerje-
mahan yang tidak sesuai.

Edit->Edit Header
Mengedit header dari PO-file. Ada beberapa baris pada header, yang mana baris ini menyim-
pan informasi tanggal terakhir penerjemahan, nama penerjemah, email, bahasa dan encoding teks
translasi, dll.

14.1.3 Menu Go

Go->Previous (PgUp)
Lewati ke isian sebelumnya pada PO file.

Go->Next (PgDown)
Lewati ke isian berikutnya pada PO file.

Go->Go to...
Membuka dialog untuk melompat ke isian nomer tertentu pada PO file.

Go->Last Entry
Melompat ke isian pertama pada PO file.

Go->Previous fuzzy or untranslated (Ctrl-Alt-PgUp)
Melompat ke isian pertama sebelumnya yang belum diterjemahkan atau yang ditandai sebagai
fuzzy.

Go->Next fuzzy or untranslated (Ctrl-Alt-PgDown)
Melompat ke isian pertama berikutnya yang belum diterjemahkan atau yand ditandai sebagai fuzzy.

Go->Previous fuzzy (Ctrl-PgUp)
Melompat ke isian fuzzy pertama sebelumnya.

Go->Next fuzzy (Ctrl-PgDown)
Melompat ke isian fuzzy pertama berikutnya.



Referensi Perintah 72

Go->Previous untranslated (Alt-PgUp)
Melompat ke isian sebelumnya yang belum diterjemahkan.

Go->Next untranslated (Alt-PgDown)
Melompat ke isian berikutnya yang belum diterjemahkan.

Go->Previuos error (Shift-PgUp)
Melompat ke isian sebelumnya yang mengandung error. Hal ini sering terjadi saat anda lupa mem-
berikan tanda “\” di depan tanda kutip ganda, atau string aslinya berahir dengan \n, sementara
string yang diterjemahkan tidak demikian (atau sebaliknya).

Go->Next error (Shift-PgDown)
Melompat ke isian berikutnya yang mengandung error. Hal ini sering terjadi saat anda lupa mem-
berikan tanda “\” di depan tanda kutip ganda, atau string aslinya berahir dengan \n, sementara
string yang diterjemahkan tidak demikian (atau sebaliknya).

Go->Back (Alt-Left)
Melompat ke isian yang terakhir dikunjungi pada PO file.

Go->Forward (Alt-Right)
Melompat ke isian sebelumnya pada PO file.

14.1.4 Menu Dictionaries

Perlu diketahui bahwa menu ini bersifat dinamis. Keberadaannya sangat tergantung dari plug-in kamus
yang telah diinstall kedalamnya. Secara default ada 3 menu:

Dictionaries->Search Text -> KDE Database Search Engine
Awali pencarian terjemahan untuk pesan asli yang berbahasa Inggris dengan menggunakan mesin
pencari database KDE.

Dictionaries->Search Text-> PO Auxiliary
Awali pencarian terjemahan untuk pesan asli yang berbahasa Inggris di dalam PO-file yang telah
didefinisakan oleh user.

Dictionaries->Search Text -> PO Compendium
Awali pencarian terjemahan untuk pesan asli yang berbahasa Inggris pada file kompendium (dibuat
dengan menggabungkan semua pesan yang telah diterjemahkan untuk satu bahasa tertentu)

Dictionaries->Search Selected Text->KDE Database Search Engine
Awali pencarian teks yang telah dipilih dengan menggunakan mesin pencari pada database KDE.

Dictionaries->Search Selected Text->PO Auxiliary
Awali pencarian teks yang telah dipilih dengan menggunakan file yang telah didefinisikan oleh user.

Dictionaries->Search Selected Text-> PO Compendium
Awali pencarian teks yang telah dipilih dengan menggunakan file kompendium dengan semua pesan
yang telah diterjemahkan.

Dictionaries->Edit Dictionary
Memungkinkan anda untuk mengedit muatan isi dari kamus yang ada. Hal ini bermanfaat bila anda
menemukan kesalahan atau error pada kamus dan tidak ingin disibukkan dengan kesalahan saat
proses pencarian dan penggantian string (namun hal ini masih belum selesai diimplementasikan).

14.1.5 Menu Tools

Tools->Spelling->Spell Check
Aktifkan dialog konfigurasi untuk memeriksa ejaan dalam KBabel. Setelah opsi yang diinginkan
dipilih, pilihlah OK dan setelah itu akan muncul dialog untuk memeriksa ejaan yang normal.
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Tools->Spelling->Check All...
Awali memeriksa ejaan untuk semua kata untuk PO-file yang sudah dibuka.

Tools->Spelling->Check From Cursor Position
Awali memeriksa ejaan dari posisi kursor saat ini.

Tools->Spelling->Check Current
Periksa ejaan hanya pada isian yang ada dari PO file

Tools->Spelling->Check Marked Text...
Periksa ejaan hanya untuk teks yang telah dipilih pada kotak edit MsgStr.

Tools->Validation->Check Syntax (Ctrl-T)
Periksa sintaks untuk PO-file yang sedang aktif. Error mungkin terjadi dari proses penggabungan
CVS atau dari kesalahan user saat proses penerjemahan dilakukan secara manual dengan tangan.

Tools->Validation->Check Argument (Ctrl-D)
Periksa apakah jumlah argumen, tipe dan urutannya sama dengan yang ada pada format C.

Tools->Validation->Check Accelerators (Ctrl-H)
Periksa apakah nomer dari akselarator sama antara teks yang asli dengan yang terjemahan.

Tools->Validation->Look for Translated Context Info (Ctrl-K)
Periksa apakah PO file berisi informasi kontekstual yang diterjemahkan secara tidak sengaja. KBa-
bel akan membuka kotak pesan kesalahan dan melompat ke kesalahan informasi kontekstual per-
tama.

Tools->Validation->Check Equation (Ctrl-J)
Periksa apakah sisi kiri dari string yang diterjemahkan sama dengan sisi kiri dari string aslinya.
Sisi ini dibatasi dengan tanda samadengan.

Tools->Catalog Manager...
Buka window Catalog Manager. Baca bagian Catalog Manager untuk mendapatkan keterangan
lebih detail.

14.1.6 Menu Settings

Settings->Show Toolbar
Bila ditandai, toolbar standard ditampilkan.

Settings->Show Statusbar
Bila ditandai, bagian bawah dari statusbar ditampilkan.

Settings->Show Navigationbar
Bila ditandai, bagian navigasi akan ditampilkan

Settings->Show Comments
Bila ditandai, bagian kanan atas dari window utama yang berisi komentar isian yang ada akan
ditampilkan.

Settings->Show Tools
Bila ditandai, bagian kanan bawah dari window utama yang berisi hasil pencarian pada dictionary
akan ditampilkan.

Settings->Configure Key Binding
Buka dialog konfigurasi untuk memulai aktivitas key binding. Hal ini akan memungkinkan kita
untuk mengkustomisasi default dari key binding KBabel agar sesuai dengan kebutuhan kita.

Setting->Configure Toolbars...
Dialog konfigurasi toolbar standard akan terbuka. Anda dapat memilih aksi mana yang akan
dilakukan pada toolbar dan toolbar yang mana yang akan dikustomisasi.
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Settings->Configure KBabel
Semua pengaturen khusus KBabel dilakukan di bagian ini. Bacalah terlebih dahulu bagian “Pref-
erence” untuk topik yang spesifik.

Settings->Configure Standard Dictionary-> KDE Database Search Engine
Buka dialog untuk konfigurasi mesin pencari KDE database.

Settings->Configure

Buka dialog untuk konfigurasi file PO kompendium

14.1.7 Menu Help

Help->Contents (F1)
Buka KBabel Handbook. Seperti yang anda baca saat ini.

Help->What’s This? (Shift-F1)
Kursor akan berubah menjadi tanda tanya dan anda dapat meng-klik nya pada elemen yang ter-
dapat pada window utama. Kemudian window keterangan bantu singkat akan ditampilkan.

Help->Gettext Info
Membuka lembar manual gettext pada KDE Help Center. Paket tool ini menolong proses dari
penanganan POT dan PO file

Help->Report Bug...
Ini akan membuka dialog pelaporan kesalahan standard dari KDE. Hal ini bermanfaat bila anda
menemukan kesalahan pada KBabel. KBabel developer akan sangat berterima kasih apabila ada
komentar ataupun harapan atau laporan kesalahan yang terjadi dari penggunanya.

Help->About KBabel
Buka kotak pesan yang menginformasikan tentang versi KBabel, nama developer dan alamat email.

Help->About KDE
Akan menampilkan pesan dengan informasi kontak, dan bagaimana cara untuk melaporkan kesala-
han ataupun harapan ke pihak KDE.

Help->About Dictionary->KDE Database Search Engine
Menampilkan pesan dengan informasi siapa saja yang telah membuat KDE Database Search Engine.

Help->About Dictionary-> PO Auxiliary
Menampilkan pesan dengan informasi siapa saja yang telah membuat fungsi pencarian dalam file
Auxiliary.

Help->About Dictionary->PO Compendium
Menampilkan pesan dengan informasi siapa saja yang telah membuat fungsi pencarian pada file
Compendium.

14.2 Toolbar pada KBabel

14.2.1 Toolbar standard

Open
Memuat PO file dalam KBabel untuk diedit.

Save
Simpan PO file bila telah dimodifikasi.

Undo
Batalkan operasi yang terakhir dilakukan.
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Redo
Mengulang operasi yang terakhir dilakukan.

Cut
Potong teks yang telah dipilih dan pindahkan ke dalam clipboard.

Copy
Salin teks yang telah dipilih kedalam clipboard.

Paste
Tempelkan teks dari clipboard pada posisi kursor saat ini

Find
Temukan string khusus dalam PO file.

Previous
Lewati isian sebelumnya dalam PO file.

Next
Lewati isian berikutknya dalam PO file.

Copy msgid to msgstr
Salin string asli untuk diterjemahkan dalam kotak edit.

Search Translations
Toolbar yang digunakan untuk mencari teks yang telah dipilih dengan menggunakan: KDE
Database Search Engine, file PO Auxiliary, file PO Kompendium, dan plug in kamus bila
dimungkinkan.

Stop
Hentikan proses pencarian yang sedang berlangsung.

Catalog Manager
Buka window Catalog Manager

14.2.2 Toolbar Navigasi

Previous
Lewati ke isian PO file sebelumnya.

Next
Lewati ke isian PO file berikutnya.

First Entry
Jump to last entry in PO-file.

Previous fuzzy or untranslated
Lompat ke fuzzy sebelumnya atau ke isian yang belum diterjemahkan pada PO file.

Next fuzzy or untranslated
Lompat ke fuzzy berikutnya atau ke isian yang belum diterjemahkan pada PO file.

Previous fuzzy
Lompat ke isian fuzzy sebelumnya pada PO file.

Next fuzzy
Lompat ke isian fuzzy berikutnya pada PO file.

Previous untranslated
Lompat ke isian yang belum diterjemahkan sebelumnya pada PO file.

Next untranslated
Lompat ke isian berikutnya yang belum diterjemahkan pada PO file.
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Previous Error
Lompat ke error sebelumnya pada PO file.

Next Error
Lompat ke error berikutnya pada PO file.

Back
Lompat ke isian yang terakhir dikunjungi dalam PO file.

Forward
Lompat ke isian yang berikutnya dikunjungi dalam PO file.

14.2.3 Status Bar

Current
Pesan yang sedang aktif dalam modus edit di PO file.

Total
Total jumlah dari pesan yang ada dalam PO file.

Fuzzy
Jumlah pesan yang ditandai sebagai fuzzy. Pesan itu hendaknya diperbaiki dan diterjemahkan bila
memang diperlukan.

Untranslated
Jumlah pesan yang belum diterjemahkan.

Editor status
INS-insert, dan OVR-overwrite. Memiliki arti yang sama seperti yang terdapat pada editor teks
lainnya.

PO-file status
RO-read only file (File yang hanya dapat dibaca), RW - read-write access on file (file yang da-
pat dibaca dan diakses). Saat file berstatus RO (hanya dapat dibaca) maka anda tidak dapat
memodifikasi isian yang tampak pada editor.

Progress bar
Umumnya bar ini tersembunya. Ini hanya akan ditampilkan saat proses penyimpanan selesai atau
saat anda mencari pesan tertentu dalam PO file, kompendium atau lainnya.
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15.1 Tanya Jawab

Mengapa Kbabel menampilkan tanda tanya saat spesifik karakter dari bahasa
tertentu diisikan?

Ini merupakan masalah pengaturan lokal. Keterangan berikut ini mungkin dapat menolong:

• Keluarlah dari KBabel, lalu dalam satu shell lain, tentukan varibel environmen “LANG” untuk
local, hal ini juga berlaku untuk bahasa anda.

• Bila anda menggunakan bash, lakukan export LANG=<change this>. Sebagai contoh, saat
anda menggunakan karakter dalam bahasa Jerman, maka gunakan export LANG=de DE.88591
.

• Lalu awali KBabel dari shell ini. Bila masalah ini selesai, sisipkan perintah ini pada standard anda.

Mengapa KBabel menampilkan tanda tanya dan bukan karakter lainnya saat
memuatkan PO file?

Teks berisikan karakter, yang mana karakter ini tidak dapat ditampilkan oleh sistem font anda. Bila anda
merasa yakin, bahwa teks tidak berisi karakter sejenis, maka file mungkin saja telah terkorupsi. Dalam
kasus ini, tanda seperti tanda tanya dan dengan menekan Ctrl-F untuk menemukan semua karakter
yang terkorupsi dan menggantinya.

Catatan: Jangan mencari tanda tanya yang sebenarnya, karena karakter ini hanya tampil sebagai
tanda tanya saja, tapi sebenarnya karakter ini merupakan karakter khusus. Jika tidak, maka anda perlu
menginstall font unicode, yang berisi semua karakter yang diperlukan.

15.2 Lisensi

KBabel :Program copyright 1999-2000 Matthias Kiefer <matthias.kiefer@gmx.de>

Kontributor:

• Thomas Diehl <thd@kde.org>

• Stephan Kulow <coolo@kde.org>
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Copyright dokumentasi 2000 Claudiu Costin <claudiuc@geocities.com> dan Matthias Kiefer
<matthias.kiefer@gmx.de>

Program ini berada di bawah lisensi term dari GNU GPL.



Lampiran A. Glossari KBabel
A

Auxiliary File
Ini merupakan issue spesifik dari KBabel. Ini merupakan opsi untuk user agar mengatur satu PO
file dimana pencarian dilakukan untuk pesan aslinya. Dan bila anda termasuk anggota dari team
Perancis dan memiliki sedikit pengetahuan dalam bahasa Spanyol dan Italia, maka anda dapat
meng-“grab” dan mengatur auxiliary dari PO file Spanyol yang berhubungan dengan file yang
sedang diterjemahkan. Sehingga anda akan dapat menemukan sinonim yang sebelumnya tidak
pernah terpikirkan dalam bahasa anda.

C

CompendiumFile
Merupakan koleksi dari berbagai terjemahan untuk satu bahasa tertentu. PIO file besar ini dibu-
at sebagai pesan yang unik dari semua apliaksi PO file. Ini dapat digunakan untuk mengisi se-
mua string yang sudah diterjemahkan kedalam string dari PO file yang belum diterjemahkan atau
belum seluruhnya diterjemahkan. KBabel menggunakan semacam file dalam mesin pencari “PO
Compendium”.

F

Fuzzy
Ini merupakan tanda yang dihasilkan secara umum dengan msgmerge. Ini menunjukan bahwa
string msgstr mungkin saja bukan merupakan terjemahan yang tepat. Penerjemah harus melihat
dan memodifikasi bila string dibutuhkan. Setelah itu, tanda fuzzy tersebut harus dihilangkan dari
komentar pesan.

I

Internationalization (i18n)
Merupakan kegiatan dimana aplikasi dibuat agar dapat mendukung adanya banyak bahasa. Kata
“Internationalization” memiliki 20 karakter dan kata ini cukup panjang, sehingga untuk meny-
ingkatnya banyak orang menuliskannya hanya karakter pertama dan terakhir dan diantaranya di-
tuliskan jumlah karakter yang seharusnya ada diantara 2 karakter tersebut (i18n). Sama seperti
halnya lokalisasi (Localization) yang menjadi L10n.

Lihat: Localization.

L

Localization (i10n)
Merupakan kegiatan dimana aplikasi yang sudah di-internasionalisasi dibuat untuk memproses input
dan output dalam gaya yang diinginkan oleh budaya dan bahasa tertentu. Kata “localization”
terdiri dari 12 karakter dan ini merupakan kata yang cukup panjang. Untuk menyingkatnya kata
ini hanya dituliskan karakter awal dan akhirnya saja. Dan diantaranya dituliskan jumlah karakter
yang seharusnya ada diantara kedua karakter tersebut yaitu : l10n.

Lihat: Internationalization.
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M

MO file
MO berarti Machine Object dan file ini berisi data biner yang sesuai untuk dibaca oleh komputer.
isi dari file MO diorganisir sebagai database untuk meminimalkan waktu lookup untuk menter-
jemahkan string yang ada. File MO didapatkan dengan mengkompilasi PO file dengan msgfmt.

Lihat: PO file, POT file.

Message ID (msgid)
msgstr merupakan kata kunci yang mengawali string asli dalam PO file. Diikuti dengan string
seperti dalam C sehingga dapat dikembangkan pada satu atau banyak baris.

Lihat: Message String.

Message String (msgstr)
msgstr merupakan kata kunci yang mengawali string yang diterjamhkan dalam PO file Ini diikuti
dengan string seperti dalam C sehingga dapat dikembangkan pada satu atau banyak baris.

Lihat: Message ID.

P

PO file (PO)
PO berarti Portable Object dan PO file berisi serangkaian string yang dapat dihubungkan dengan
setiap string yang dapat diterjemahkan dengan terjemahan dalam bahasa tertentu. Satu PO file
single hanya terhubung dengan satu bahasa. PO file diturunkan dari sebuah POT file dan dimak-
sudkan untuk diedit kembali oleh penggunanya.

Lihat: POT file, MO file.

POT file (POT)
POT berarti Portable Object Template. File ini dibentuk dengan mengekstrak string yang dapat
diterjemahkan dari file sumber aplikasinya. POT file tidak berisikan hasil terjemahan dan digunakan
sebagai template oleh tiap penterjemah.

Lihat: PO file, MO file.



Lampiran B. Instalasi
B.1. Bagaimana mendapatkan KBabel

KBabel adalah bagian dari proyek KDE http://www.kde.org. KBabel dapat ditemukan dalam paket
kdesdk di ftp://ftp.kde.org/pub/kde/, yang merupakan site ftp utama dari proyek KDE .

B.2. Kebutuhan

Agar sukses dalam menggunakan KBabel, anda akan membutuhkan screen shot dari KDE
2.x . Semua library yang dibutuhkan sebagaimana KBabel nya sendiri dapat ditemukan di
ftp://ftp.kde.org/pub/kde/.

B.3. Kompilasi dan instalasi

Untuk mengkompilasi dan menginstal KBabel pada sistem anda, ketikan perintah dibawah pada direktori
basis dari distribusi kdesdk:

% ./configure
% make
% make install

Sejak KBabel menggunakan autoconf dan automake, maka anda tidak perlu repot untuk mengkompilasi
lagi. Bersamaan dengan KBabel anda dapat pula menginstall sisa dari tools yang ada di paket kdesdk.
Bila anda menemukan kesalahan dan masalah, laporkan hal tersebut kepada pencipta KBabel yaitu;
Matthias Kiefer <matthias.kiefer@gmx.de>.
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